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PREFACE

et Station from Electrical Geodesics, Inc. (EGI) is a complete software package 
for working with electroencephalography (EEG) data. With Net Station, 

you can:

• acquire EEG, in conjunction with EGI’s Net Amps and Neurotravel amplifiers, 
and dense-array Geodesic Sensor Nets (GSNs)

• perform various operations on your data, primarily for basic event-related 
potential (ERP) derivation 

• view and navigate EEG and ERP data

Note: Net Station does not support Unicode string.

The following publications, and other technical documentation, are available as 
PDF files at www.egi.com/documentation.html:

• The Net Station Acquisition is the component of Net Station for acquiring EEG, 
in conjunction with EGI’s Net Amps and Neurotravel amplifiers, and Geodesic 
Sensor Nets. This document, the Net Station Acquisition Technical Manual, 
describes all Acquisition features and functions.

• The Net Station Viewer is the component of Net Station for viewing and 
navigating EEG and ERP data. The Net Station Viewer Technical Manual 
describes all Viewer features and functions. 

• The Net Station Waveform Tools is the component of Net Station for performing 
various operations on EEG data, primarily for basic ERP derivation. The 
Net Station Waveform Tools Technical Manual describes all Waveform Tools 
features and functions. 

N

The Net Station icon
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• The Net Station Viewer and Waveform Tools Tutorial instructs you in the use 
of Net Station Viewer and Waveform Tools by guiding you through the analysis 
of a sample data set. It is not intended to be a comprehensive guide to these 
components, but it is a good place to start when learning about the software. 

• The Net Station File Formats Technical Manual documents the objects 
contained in a native Net Station file, the formats of the export files, and other 
files associated with Net Station.

• The Geodesic Sensor Net is EGI’s patented device for acquiring electrical 
signals from the human scalp. The Geodesic Sensor Net Technical Manual 
describes all GSN features and functions.

• GES hardware is all the system hardware except for the GSN. GES hardware 
supports the acquisition and processing of EEG data and includes an amplifier, 
a data-acquisition computer, a monitor, and, in most cases, a cart or travel case. 
The GES Hardware Technical Manual provides comprehensive descriptions of 
all GES hardware components and features. 

These publications contain a good deal of background information on the EEG field. 
However, they are not intended to represent a complete primer. To get the most out of 
these books, you should have some background in EEG methods. 

These manuals assume you are familiar with the Macintosh computer, the platform 
for Net Station software. 

About This Manual

The Net Station Acquisition Technical Manual describes the acquisition of EEG 
data using EGI’s Net Station software, Geodesic Sensor Net, and Net Amps 200, 
Net Amps 300, or Neurotravel amplifiers. At the present time, Net Station works only 
with these products.

Features
This manual is supplied as a PDF file and in printed form. The hard-copy version has 
been printed from the PDF so the content of both will match. The printed manual 
contains mostly grayscale images; the PDF contains color and grayscale images. 
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Manual Organization
This manual features a table of contents, list of figures, list of tables, and index, which 
in the PDF are all hyperlinked to the topics they reference in the publication.

The chapters fall into four main categories:

• Introduction

° Chapter 1, "Acquisition Overview”
° Chapter 2, "Introducing Net Station” 

• User-Defined Features (using the Workbench)

° Chapter 3, "Workbench: The Basics”
° Chapter 4, "Workbench: Controls/Displays”
° Chapter 5, "Workbench: Acquisition Setups”

• Standard Features

° Chapter 6, "Dense Waveform Display”
° Chapter 7, "Sessions and Session Templates” 

• Clinical Options

° Chapter 8, "Clinical Interface”
° Chapter 9, "Digital Video”
° Chapter 10, "Photic Stimulator Interface”

A number of appendixes are also include:

• Appendix A, "Software Technical Support”
• Appendix B, "Updating EGI Licenses”
• Appendix C, "Montages”
• Appendix D, "Acquisition How-To”

Conventions and Typography
In this manual:

• The terms Net Amps may be used in reference to features shared by both the 
Net Amps 200 and 300.

• The terms Geodesic Sensor Net, GSN, HydroCel GSN, and sensor array are used 
interchangeably.
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• In general, a minimal amount of special fonts are used in this manual—italics 
for definitions or newly introduced terms, boldface italics for important 
concepts, and boldface for command paths (such as, File > Save).

Additional Information
Two different methods are used to convey additional information: notes and cautions.

Note: This indicates information that is helpful in understanding Net Station operations.

Caution!: This denotes important information that, if unheeded, could hinder use 
of Net Station.

Troubleshooting, Support, and Repair
• For online updates to this book, check EGI’s 

Documentation page at www.egi.com/
documentation.html.

• For Net Station EEG software support, see 
Appendix A, "Software Technical Support.”

• To update your Net Station license, see 
Appendix B, "Updating EGI Licenses.”

The EGI Documentation page at 
www.egi.com/documentation.html
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CHAPTER 1ACQUISITION 
OVERVIEW

GI’s Net Station Acquisition software is designed for the acquisition of dense-
array EEG data. This publication, the Net Station Acquisition Technical Manual, 

describes the components of Net Station Acquisition and its use. 

This chapter provides an introduction to the acquisition process using Net Station, 
highlighting both general and specific issues. 

General topics include intended use, system requirements, and Net Station 
acquisition, including the roles played by the sensor array, amplifier, data-acquisition 
computer, and Net Station. 

Specific details are provided about how Net Station displays and records the EEG; the 
chapter closes with a reference to an acquisition how-to appendix.

Intended Use

Net Station is intended to measure and record the electrical activity of the brain. It is 
designed for use with adults, children, and infants.

Net Station is targeted for research and clinical applications, and for operation by 
trained medical and research personnel. Net Station includes functions to support the 
Neurotravel amplifier, European Data Format (EDF) import, FireWire digital video, 
and the Neurotravel PH80 photic stimulator.

E
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System Requirements

Net Station is designed for Mac OS X 10.3 or later (10.4 is recommended), and to run 
on Mac G4 or later (G5 is recommended) PowerPC units, either portable or desktop. 
The application’s minimum hardware requirements are a 1.25 GHz processor and 
1 GB of RAM.

Net Station Acquisition Overview

Your system equipment can be set up in various ways. However, all configurations 
share a common set of core components (Figure 1-1), including at least one Geodesic 
Sensor Net (GSN) sensor array; one Net Amps 300, Net Amps 200, or Neurotravel 
amplifier; and a data-acquisition computer (DAC) running EGI’s Net Station 
software.

Figure 1-1. Core components

Geodesic Sensor Net

Net Amps 200

Data-acquisition computer 
(Net Station runs on this computer)

Neurotravel amplifier

— or —

Net Amps 300

— or —
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Sensor Array
During EEG recordings, subjects wear a Geodesic Sensor 
Net. A subject wearing a 128-channel adult-sized HydroCel 
GSN (HCGSN) is shown as an example in Figure 1-2. 

Amplifier
A sensor array is connected to a Net Amps 300, Net Amps 
200, or Neurotravel amplifier unit. The amplifier filters and 
measures the EEG signals that are picked up by the sensor 
array and samples them at millisecond intervals.

(In addition to native formats, Net Station supports the European Data Format, a 
standard clinical format for the exchange and storage of simultaneously recorded 
physical signals. Developed in 1991, EDF is well documented and a full specification 
of the format can be found on the web.)

The digitized samples are transferred to the DAC in real time.

DAC and Net Station
Packets of data containing digitized EEG samples are sent from the amplifier to the 
DAC so that the Net Station software can collect them for display and storage to disk. 
In Net Station, you can display EEG data in a variety of ways and record them to 
permanent computer files.

Net Station resides on the DAC, where it is capable of continuously collecting dense-
array EEG data from the amplifier.

Caution!: Verify that the sleep mode for the hard drive is “off.” Otherwise, 
Net Station will freeze when the hard drive “falls asleep.” Also, if your DAC is 
connected to a network, verify that Appletalk is “on.” Otherwise, Net Station may 
freeze.

Figure 1-2. Subject 
wearing an HCGSN
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A functional diagram is shown in Figure 1-3. 

Basic Operation
Physically, the sensor array connects to the amplifier via the Hypertronics connector 
on the front of the amplifier. An interface cable that allows the subject to be positioned 
farther away from the amplifier may be used to connect the array and the amplifier. 
This is shown in Figure 1-4. 

The array’s sensors pick up changes in voltage originating at the surface of the 
subject’s head (the EEG), along with a certain amount of electrical noise originating in 
the room environment. Electrical signals from all the sensors of the array are received 
simultaneously by the amplifier where they are amplified, filtered, sampled, and 
digitized. As quickly as the samples are acquired, they are packaged and sent to the 

Figure 1-3. Net Station Acquisition functional block diagram

Figure 1-4. Sensor array, interface cable, amplifier

Mouse

Keyboard
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Amplifier

Sensor array

Data acquisition 
computer running 

Net Station
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DAC along the Universal Serial Bus (USB) or FireWire cable that connects the 
amplifier and the DAC (Figure 1-5). 

Note: During acquisition, Net Station presents a warning that the disk is getting full, 
when only 200 MB of space remains. Later, when only 100 MB of space remains, 
recording automatically stops. 

Display and Recording of EEG
The data of each sensor are segregated into their own channels. As the samples stream 
into the DAC over the USB or FireWire cable, Net Station gathers, organizes, and 
displays each channel’s EEG data in the manner of a traditional chart recorder 
(Figure 1-6).

Figure 1-5. Amplifier–to-DAC connection diagram

Figure 1-6. Net Station displays and records EEG waveforms
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When you instruct Net Station to record the data to a file, the chart recorder display 
continues without interruption while the data are being written to disk.

Note: If you receive a message indicating that the USB driver is not installed, try 
reinstalling Net Station and restarting the computer.

Display Method
In contrast to a physical chart recorder that uses electromechanical pens to draw 
waveforms on a piece of moving paper, Net Station “draws” tiny dots on the 
computer screen called pixels (for picture elements; Figure 1-7). 

You can achieve fine control of the display of EEG waveforms using the time and 
amplitude controls of Net Station’s scrollable Dense Waveform Display (DWD), 
shown in miniature in Figure 1-6. See Chapter 6, "Dense Waveform Display,” for 
details.

Figure 1-7. Onscreen waveforms are composed of pixels

Greatly magnified view of 
an onscreen waveform 
showing it is made of 
rectangular dots (pixels). 
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Recording Method
The voltage samples pass as data packets from the amplifier to Net Station via the 
bidirectional USB or FireWire cable that connects the amplifier to the DAC. Net 
Station records the data to disk in the form of either Recording or Session files 
(Figure 1-8).

Note: Because the USB or FireWire cable is bidirectional, Net Station can send queries 
and commands to the amplifier as well as receive data from it. 

The default size limit for a Net Station EEG file is 1.8 GB. Once that limit is reached, 
Net Station immediately starts recording another file, with no loss of data. For more 
information about Net Station’s continuous or multi-file recording, see “Recording 
Modes and File Sizes” on page 79.

High Density and Resolution
Net Station handles heavy workloads easily. Net Station’s buffers can handle as many 
as 1,000 samples per second from your sensor array. You can observe the waveforms 
of each channel in groups limited only by the size of the computer monitor, even as 
the data are written to disk.

Figure 1-8. Net Station data files

Amplifier Net Station

Session file

Recording file
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Data Protection
Net Station writes EEG and events to the DAC hard drive. To maximize the protection 
of these data after they are collected, the DAC must feature an optical drive (for 
example, DVD-R) that accepts high-capacity removable media. You can, and should, 
copy your data files from the acquisition hard drive to removable optical disks. An 
optical recording has a life span of decades and is immune to magnetic fields. This 
procedure ensures that the data cannot be lost because of hard-drive problems, and it 
greatly expands the data storage capacity of the system, as well. 

Acquisition How-To

This manual focuses on the features and functions of Net Station Acquisition. For a 
step-by-step guide to acquiring EEG data and events using Net Station, see 
Appendix D, "Acquisition How-To.”



chapter 2

33Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006

CHAPTER 2INTRODUCING 
NET STATION

sers of Net Station Acquisition perform EEG data acquisition, monitor and 
control the amplifier, and store subject information and technician markup 

events in data files (Session or Recording) using Net Station software. This software 
resides on the hard drive of the data-acquisition computer and communicates with the 
amplifier via the USB or FireWire cable that connects the amplifier and the DAC (see 
Figure 1-5 on page 29).

Optionally, via Net Station, the Acquisition system can register and record external 
digital input (DIN) events and experimental control interface (ECI) events 
simultaneously with the EEG (see “Digital Input Controls” on page 91 and 
“Impedance Display Panel” on page 117 for details). 

This chapter provides introductory material that is essential and/or helpful for 
understanding and realizing the full capabilities of the software and lays the 
foundation for the detailed material in the rest of the manual. Topics include the 
Mac OS X environment, how to launch Net Station, and the Net Station Distribution 
(that is, the files and folders that are installed on the DAC). 

You should study the Distribution to become familiar with the names and locations of 
the example files that are part of the Net Station Distribution, and the default files and 
folders that form a vital part of the Acquisition system’s functionality. The chapter 
finishes by introducing the Workbench, Acquisition Setups, and Workbench devices.

This chapter, with few exceptions, assumes that you are familiar with the Mac OS and 
its basic operation. If you need help using the mouse, choosing from menus, or 
working in the Finder or with Mac OS control panels, please consult the User’s Guide 
that came with your Macintosh computer, or the online Apple guide that is accessible 
by choosing Help > Mac Help. 

U
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Before using Net Station Acquisition to acquire subject EEG, read the following, in 
sequence:

• Chapter 2, "Introducing Net Station”
• Chapter 3, "Workbench: The Basics”
• Chapter 4, "Workbench: Controls/Displays”
• Chapter 5, "Workbench: Acquisition Setups”
• Chapter 6, "Dense Waveform Display”
• Chapter 7, "Sessions and Session Templates”
• Appendix D, "Acquisition How-To”

If you are using Net Station for clinical applications, then also read:

• Chapter 8, "Clinical Interface”
• Chapter 9, "Digital Video”
• Chapter 10, "Photic Stimulator Interface”

Net Station Under OS X

Net Station operates slightly differently under Macintosh OS X than it did under the 
previous operating system. Notable differences include the Documents folder, font 
smoothing, and highlight colors.

Documents Folder
It is important to understand that OS X has a distinct Documents folder for each user.

This folder is located in the user's home directory under OS X. This documents folder 
(~/Documents [the tilde denotes the current user's home directory]) is entirely 
separate from the OS 9 documents folder (/Documents) located at the root level of the 
hard drive.

Net Station 3.0 used the OS 9 documents folder to store the Net Station User Data 
folder. Net Station 4.0 and later use the OS X documents folder to store the Net Station 
User Data folders. These are not the same location, and so Net Station 3.0 and 
Net Station 4.0 do not share tool specifications or settings. In addition, separate user 
accounts under OS X also do not share specifications or settings.
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This has the potential for creating confusion for someone who is new to OS X, or who 
has been running Net Station 3.0 and is now running Net Station 4.0 or later on the 
same machine. If you are missing specifications, tools, or recordings, check which 
documents folder you are accessing.

Font Smoothing
For Net Station controls and text labels to be clearly readable under OS X, choose 
Apple > System Preferences, click on the Appearance icon in the Personal section, 
and in the Appearance window make sure that “Turn off text smoothing” is set to “for 
font sizes 8 and smaller.” If this is set to 9, 10, or 12, Net Station labels may be difficult 
to read.

Highlight Colors
The default OS X highlight color may be too light for easily readable displays in 
Net Station. If this is true, choose Apple > System Preferences, click the Appearance 
icon in the Personal section, and choose a darker color from the Highlight Color pop-
up menu in the Appearance window. The pop-up menu’s “other” option enables you 
to create your own highlight color using a color wheel. 

Net Station Distribution

As a part of the Net Station installation process, a number of files are placed on the 
hard drive of the system DAC. Collectively, these files are called the Net Station 
Distribution. 

Note: This chapter uses the terms directory and folder interchangeably and assumes 
basic familiarity with Mac OS configured as a single user.
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Mac Desktop Items

The hard drive where Net Station is installed 
is named “Data Acquisition.” Its icon 
(Figure 2-1) is situated in the top-right corner 
of the desktop. The Net Station icon is located 
on the Dock in Macintosh OS X. Clicking on 
the icon launches Net Station.

Caution!: Files and folders that are part of the Distribution should not be moved, 
renamed, or deleted. Doing so could adversely affect the operation of Net Station. 
For the same reason, the directory structure of the Distribution should not be 
altered except where indicated in the text of this chapter. 

Root Directory

Double-clicking on the data-acquisition hard drive opens a window that shows its 
root directory structure (Figure 2-2). 

Figure 2-2. Root directory structure of data-acquisition hard drive

Figure 2-1. Desktop and Dock icons 
of the Distribution

Net Station icon
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The exact contents of the root may include more files and folders than those shown in 
the figure, but the essential ones are shown. The important folders to notice are 
Applications and Documents. These two folders contain parts of the Distribution and 
are also essential components of the Mac OS installation. You can add or delete your 
own folders and files at any time.

Net Station Folder

Inside the Applications folder is the Net Station folder. As shown in Figure 2-3, the 
Net Station folder encloses the Net Station Application Program Package.

Also in the Net Station folder is the Extras folder.

Caution!: Do not move, rename, or delete the Net Station folder or its contents. 
Changing any of the folders, except the Extras folder (described later in this 
section), may result in data loss or corruption.

Net Station Application Program Package 

The Net Station icon is actually a package (that is, a folder disguised as an application 
icon). Remember not to move, rename, or delete any item that is enclosed in the 
Net Station Application Program Package, or Net Station may exhibit unexpected 
behavior, possibly including data corruption.

Figure 2-3. Inside the Net Station folder

Net Station Application 
Program Package
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Extras Folder
Auxiliary applications are distributed with Net Station in the Extras folder. You can 
move such applications out of the Extras folder without adversely affecting 
Net Station. The Net Station File Exporter, described in the next paragraph, is one 
such auxiliary application. 

Net Station File Exporter
The Net Station File Exporter is a droplet application. You can launch the Net Station 
File Exporter only by dragging files onto its icon. If a Net Station Recording or Session 
file is dragged onto it, the data of the file will be exported as a simple-binary data file. 
See the Read Me documentation file supplied with the File Exporter in the Extras 
folder to learn about the simple-binary format. (The Net Station File Formats 
Technical Manual also describes the File Exporter.)

Another function of the File Exporter is to extract diagnostic and calibration 
information from an EEG data file. Dragging a Net Station Recording or Session file 
onto the Exporter while holding down the Command key causes the gains, zeros, 
impedances, and history stored in the file to be written to separate text files. These 
output files have the extensions.GAIN, ZERO, .IMP, and .HIST.

For information on how channel gains and zeros are measured, and the formula for 
converting channel A/D values to microvolts, see “Calibration” in Chapter 5,
“Amplifiers,” in the GES Hardware Technical Manual. 

Documents Folder

The Documents folder is a default component of Mac OS. 

During Net Station installation, a Net Station User Data folder is installed in the 
Documents folder. The Net Station User Data folder and its contents—the Acquisition 
Setups, Session, Support, and Template folders (Figure 2-4)—are part of the Net 
Station Distribution and are described in this section. 

Command key
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Caution!: As with the Net Station folder, do not move, rename, or delete the Net 
Station User Data folder, its subfolders, or any of its contents. The one exception is 
the Resource Database, which you must move out of the Net Station folder if you 
reinstall the application, but wish to keep your montages, event sets, and so forth 
(“Support Folder” on page 40 describes the database further).

(See “Net Station Under OS X” on page 34 for the different document folders used in 
OS 9 and OS X.)

Acquisition Setups Folder
The Acquisition Setups folder stores Acquisition Setups. When you save new, editable 
Acquisition Setups, Net Station routes them to this folder by default. Directly after 
installation of Net Station, the Acquisition Setups folder is empty. 

Note: Session Templates require an embedded Acquisition Setup (see “The Embedded 
Acquisition Setup” on page 159). When you create a new Session Template, Net Station 
looks for available Acquisition Setups in the Acquisition Setups folder. 

Figure 2-4. Net Station User Data folder
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Sessions Folder
The Sessions folder is the destination for saved Net Station Session files. Such files are 
native Net Station EEG data files that are initiated when you pick a Session Template 
and use it to acquire new EEG data (see Chapter 7, "Sessions and Session Templates”).

Support Folder
The Support folder holds the Resource Database, an automatically generated file that 
stores user information needed by Net Station. The Resource Database contains:

• topographic map compositions
• montages
• filters 
• event sets and user events
• keyboard mapping
• people (global unique identifiers)
• fields

Over time, Net Station adds and removes information from the Resource Database. If 
the Resource Database is moved, renamed, or deleted, Net Station creates a new one 
and places it in the Support folder, but as a consequence the information in the old 
Resource Database is no longer be available to Net Station.

You should regularly back up your Resource Database, saving the Resource Database 
backup files as a protection against the database being deleted inadvertently.

Templates Folder
Like the Acquisition Setups folder, the Templates folder is for your convenience. 
When you create custom Session Templates, Net Station puts them in this folder 
automatically as soon as they are saved.
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Net Station looks for Session Templates in this folder when you initiate a new session. 
It lists the names of any templates it finds, along with the names of its default, 
preconfigured Session Templates. You choose from the list (see Figure 7-1 on 
page 158). The names of Net Station’s default Session Templates are: Clinical 
Neurotravel Session, NA 200 Clinical Session, NA 200 Exp. Control Template, NA 200 
Simple Session Template, NA 200 Typical Session Template, NA 300 Clinical Session, 
NA 300 Exp. Control Template, NA 300 Simple Session Template, and NA 300 Typical 
Session Template. 

When creating a new Session Template, choose a name that does not match one of the 
names of the default templates, to prevent duplicate names appearing in the list of 
Session Templates.

Remember not to move, rename, or delete this directory, otherwise Net Station will 
not be able to find user-created templates.

Workbench and Devices

Net Station’s Workbench is a facility for designing and saving data-acquisition 
configurations. You preserve Workbench configurations by saving them to computer 
files called Acquisition Setups. You can initiate EEG data collection directly from the 
Workbench or from a saved Acquisition Setup. Nine default Acquisition Setups are 
provided for embedding into Session Templates; you cannot directly acquire EEG 
using these default setups.

Typically, Net Station users will choose a Session Template for performing data 
acquisition. An Acquisition Setup is embedded in each Session Template (Chapter 7, 
“Sessions and Session Templates”).

For your convenience, the Distribution includes nine preconfigured Session 
Templates for data acquisition (these contain the nine default Acquisition Setups 
mentioned earlier). If these preconfigured templates match your needs, it may be 
unnecessary to use the Workbench at all. Still, the following sections should be 
studied and understood as background for the remainder of the manual, which 
covers a number of topics related to data acquisition using Net Station.
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Workbench Fundamentals
In an electronics laboratory, hardware often consists of modular devices on a 
workbench, interconnected with cables. Such devices have their own controls, 
displays, and functionality. When a new device becomes available, it is added to the 
workbench collection with minimal consequence to the other devices.

Net Station’s Workbench (Figure 2-5) emulates a real-world, physical workbench 
where devices can be placed and connected together. On the computer screen, the 
workbench surface is represented by a grid of rectangles called cells. You can place a 
single device into each cell and connect the devices using virtual cables. 

Devices
Chapter 4, "Workbench: Controls/Displays,”covers each device in detail. In general, 
however, the following rules apply to Workbench configurations:

• Each device has a particular function (Figure 2-6).

• Each device—except the Net Amps USB, Net Amps 300, Neurotravel USB, and 
Digital Video devices—has both input (left side of the device) and output jacks.

Figure 2-5. The Workbench
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• You cable together devices by creating connections (cables) from the output jack 
of one device to the input jacks of other devices.

• EEG and digital input data from the amplifier are made available to the 
Workbench via the Net Amps USB, Net Amps 300, or the Neurotravel USB 
device. 

Figure 2-6. Workbench devices

Data source:
Net Amps (includes 
amplifier control, 
calibration, filtering, 
and digital inputs) or 
Neurotravel Montage visualization

Signal filtering (digital)

Data recorder

Data display: 
Dense Waveform 
Display, Spectral 
Display, or Digital 
Video (paid option)

Stimulator:
Multi-Port ECI or 
Photic Stimulator
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Net Station’s Workbench interface extends 
the metaphor of a real-world workbench by 
providing access to display and control 
panels that are linked to the functions of the 
devices.

For example, after connecting the Digital 
Filter device in an appropriate way 
(Figure 5-15 on page 142), click the control 
panel button (the “finger” icon) on the 
Digital Filter device to deploy its control 
panel (Figure 2-7). Then use the control 
panel to set filter parameters and turn the 
filter on and off.

You can start with simple configurations 
and add more devices to create more 
complicated setups. 

Acquisition Setups

An Acquisition Setup stores a Workbench configuration including device placements 
and connectivities, display and control panel settings, and window positions and 
sizes. There are two types of Acquisition Setups: default, and saved. 

Net Station provides nine default Acquisition Setups that are already embedded in 
the nine default Session Templates provided. 

The default Acquisition Templates and their corresponding default Session Templates 
are:

• Simple Net Amps 200 Acq Setup and NA 200 Simple Session Template
• Simple Net Amps 300 Acq Setup and NA 300 Simple Session Template
• Typical Net Amps 200 Acq Setup and NA 200 Typical Session Template
• Typical Net Amps 300 Acq Setup and NA 300 Typical Session Template
• Exp. Control Net Amps 200 Setup and NA 200 Exp. Control Template
• Exp. Control Net Amps 300 Setup and NA 300 Exp. Control Template
• Clinical Net Amps 200 Acq Setup and NA 200 Clinical Session
• Clinical Net Amps 300 Acq Setup and NA 300 Clinical Session
• Clinical Neurotravel Acq Setup and Clinical Neurotravel Session

Figure 2-7. Example of 
deploying a control panel
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Because the default Acquisition Setups are designed to be embedded into a Session 
Template, you cannot acquire data directly with them or edit their Workbench 
configurations.

Saved Acquisition Setup files, however, are editable documents that you create with 
their own particular device layout and configuration. Adding and removing devices 
is one aspect of editing an Acquisition Setup. Another is modifying the positions and 
settings of display and control panels. 

If you modify the Workbench configuration of a saved Acquisition Setup, Net Station 
asks you if you want to save the changes when the Setup file is closed. However, if 
you modify only window positions or panel settings, then Net Station autosaves them 
without asking, when the Setup file is closed.

Acquiring Data
Of the two types of Acquisition Setups, you can acquire data directly only with a 
saved Acquisition Setup. To acquire data based on a default Acquisition Setup, you 
must use a Session Template that contains the chosen default setup (see Chapter 7, 
“Sessions and Session Templates”). 

Opening a saved Acquisition Setup automatically launches Net Station and loads the 
Workbench configuration the setup contains. If the setup is valid, turning the 
Workbench “on” initiates EEG data acquisition. 

For example Acquisition Setups, see “Default Acquisition Setups” on page 95, which 
describes the nine default Acquisition Setups included with the Distribution.

Caution!: When creating a Net Station file—(1) Assign a subject. An empty 
subject field can cause problems later during the Combine Files or Statistic 
Extraction processes. (2) Create file names that vary within the first 22 characters. 
When exporting data to text files, Net Station truncates file names longer than 22 
characters; if truncated file names are identical, they may overwrite each other. 
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Workbench Off and On

Once the Workbench contains a source device, you can switch on the Workbench and 
data will stream from the source device into connected downstream devices. When 
the Workbench is “off,” it is in a dormant state in terms of its ability to bring a data 
stream into Net Station, but devices can be added or removed. You cannot add or 
remove devices or modify connections when the Workbench is “on.” 

Recording On and Off

With a Waveform Recorder connected downstream of a source device, as in
Figure 2-7, and the Workbench on, clicking the Record button on the control panel of 
the Waveform Recorder device initiates recording to disk.

Note: When the Workbench is off, the Record button is dimmed (disabled). 

Look for the Workbench 
Off and On buttons in 
the upper-right corner of 
the Workbench window.

Stop and Record buttons 
are located on the 
Waveform Recorder 
device control panel.
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CHAPTER 3WORKBENCH: 
THE BASICS

he Workbench allows you to design your own data-acquisition routines, which are 
saved Acquisition Setups. If the supplied Session Templates meet your needs, the 

Workbench and Acquisition Setups may be unnecessary. However, familiarity with 
their features and capabilities is useful, and custom-designed setups may ultimately 
prove helpful to achieving your lab’s particular goals. 

The Workbench is a powerful tool, with many features, and is discussed in three 
separate chapters. 

This chapter, Chapter 3, introduces you to the Workbench and describes: 

• Acquisition status panel
• Workbench menus
• devices, in general
• device buttons
• device panels
• Devices palette
• placing and connecting devices

Chapter 4, "Workbench: Controls/Displays,” describes the specific controls of the 
Workbench; and Chapter 5, "Workbench: Acquisition Setups,” describes the default 
Acquisition Setups and how to create your own.

T
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Acquisition Status Panel

To open the Workbench, launch Net Station, and in the Customize section of the start-
up window, click the Acquisition Setup button. 

Above the Workbench is the Net Station menu bar associated with the Workbench, 
and attached to the lower margin of the menu bar is the yellow Acquisition status 
panel (Figure 3-1). 

Figure 3-1. Menus and Acquisition status panel

Acquisition 
status panel

When the Workbench is empty, as it is below, the 
Off and On buttons are dimmed.

Placing one or more devices on the Workbench activates its Off and On buttons. 
As soon as the On button is clicked, the Acquisition status panel begins to display 
elapsing time.

The Workbench is 
a grid of cells.

Workbench is off; no 
elapsed time displayed

Workbench is on; 
elapsed time is shown
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Note: Deploying the Dense Waveform Display (Chapter 6) causes additional menus to 
appear on the menu bar (see “Dense Waveform Display Menu Bar” on page 51).

Notice that the right side of the Acquisition status panel contains two buttons for 
turning the Workbench on and off. You can also turn the Workbench on or off by using 
the Acq menu (see “Acq” on page 54).

The behavior of the Workbench depends on its on or off status, as shown in Table 3-1.

The Record menu is not available when the Workbench is off (see Figure 3-1).

On the left side of the Acquisition status panel is the elapsed time display, 
showing the time that has passed since the Workbench was last turned on, in 
hours:minutes:seconds (Figure 3-2).

Note: When you use a Session Template to conduct EEG and event data acquisition, the 
Off and On buttons that accompany the Workbench are replaced by the Session Info and 
Close Session buttons. The elapsed time display is the same. See Chapter 7, "Sessions and 
Session Templates,” for details.

Table 3-1. Workbench rules

Workbench devices function only when the Workbench is on. 

Data recordings can be made only with the Workbench on.

Devices can be added, removed, or configured only when the Workbench is off.

Figure 3-2. Acquisition status panel with Workbench on
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Menus

The menus presented in the Net Station menu bar are subject to change, depending 
on what part of the application is being used.

Workbench Menu Bar
The menus connected with Workbench operations (Figure 3-3) are displayed only 
when the Workbench is being used. The Record menu is available only when the 
Workbench is on and disappears when the Workbench is off. 

The Acq menu is available only when the Workbench is being used but is displayed 
whether the Workbench is on or off.

Session Menu Bar
The Session menu bar is shown in Figure 3-4. The Record menu is always available 
during a Session because initiating a Session automatically turns the Workbench on. 

Figure 3-3. Menu bar, when the Workbench is on

Figure 3-4. Session menu bar

Available when the Workbench is on
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Dense Waveform Display Menu Bar
When the Dense Waveform Display is the frontmost window onscreen, the menu bar 
includes associated menus (Figure 3-5).  

File 

The commands available in the File menu depend on what part of Net Station is being 
used, as shown in Figure 3-6. 

• New: opens the Select Session Template window with a list of choices for 
creating a new document (Figure 3-7). Each choice opens the Enter Session 
Information window, for inputting information about the subject/patient, 
experiment/exam, and so forth. 

Figure 3-5. Dense Waveform Display menu bar

Figure 3-6. File menu

Workbench menu bar when the Dense Waveform Display is frontmost

Session menu bar when the Dense Waveform Display is frontmost

Sidebar Ongoing sessionWorkbench
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• Open: opens an “open file” dialog. Note that if an Acquisition Setup is already 
open, the “open file” dialog will not display Acquisition Setup files.

• Close/Close Window: closes either the current Acquisition Setup, with 
autosaving, or the frontmost Dense Waveform Display window if one or more 
Dense Waveform Displays are deployed.

This command and its corresponding default keyboard shortcut, z-W, have no 
effect on palettes, which must be closed by clicking their close buttons.

• Save Acquisition Setup: saves the current Acquisition Setup. If the current 
Acquisition Setup has not been saved previously, a dialog prompts for a name 
and location. This command is not available when a session is under way.

• Save Acquisition Setup As: saves a copy of the current Acquisition Setup 
document.

• Page Setup: not available in this version of Net Station.

• Print: not available in this version of Net Station.

Figure 3-7. File > New opens the Select Session Template window
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Edit
The Edit menu (Figure 3-8) operates on selected 
(highlighted) text or alphanumeric fields. Some commands 
also operate on a Workbench cell. When a field has not been 
selected, the command operates on the field where the 
cursor has been placed.

• Undo: not available.

• Cut: removes the selection and puts a copy of it on the 
Clipboard.

• Copy: copies to the Clipboard the contents of a 
selection.

• Paste: pastes the contents of the Clipboard to a selected field.

• Clear: irreversibly deletes the contents of a selected field or Workbench cell.

• Select All: selects (highlights) all the text in any field where the cursor is placed 
or where a partial or full selection of text is active.

• Unselect All: not available.

Docs
The Docs menu (Figure 3-9) allows you to organize your 
screen space. 

• Iconize: reduces the current Net Station window to an 
icon and places it in the Dock to save screen space. 
(You can also click the yellow Minimize button in the 
top-left corner of the Net Station file window.)

• <Filename>. returns the Net Station file to its previous size onscreen. (You can 
also click the file icon in the Dock).

Figure 3-8. 
Edit menu

Figure 3-9. Docs menu
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Acq
This menu (Figure 3-10) is called Acq for data 
acquisition. It is available only when the 
Workbench is being used. The devices it presents 
match those of the Devices palette (see “Devices 
Palette” on page 65).

• Turn On/Off Workbench: activates/
deactivates the Workbench devices. You 
can also turn the Workbench on or off by 
using the buttons on the right side of the 
Acquisition Status panel just below the 
menu bar (Figure 3-1).

You can change a Workbench configuration 
only when the Workbench is off. 

• Hide Device Palette/Show Device Palette: 
toggles visibility of the Devices palette.

• Devices: selecting a device places it in the 
currently selected Workbench cell.

Panels
The Panels menu (Figure 3-11) provides access 
to the control and display panels associated 
with devices that belong to the current 
Workbench configuration (when using the 
Workbench) or that are part of an active Session 
Template. 

The menu displays the devices alphabetically. 
Beneath each device name are its associated 
control and display panels.

Opening and Closing Panels
Open a panel by selecting it from the list. Close it by clicking its close button. Panels 
are also available through the buttons on the device itself.

Figure 3-10. Acq menu

Figure 3-11. Panels menu

This part of the menu presents 
info, display, and control 
panels that belong to the 

current Workbench 
configuration or Session 

Template.

Clicking a panel name on the 
extended menu deploys the 
corresponding info, display, 

or control panel.

Device buttons
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• Iconize: any panel can be reversibly minimized to icon form and placed on the 
Dock by choosing Panels > Iconize. Clicking a minimized panel restores it to 
the screen in its full size. Iconizing control panels makes them readily available 
while reducing the amount of screen space that they occupy. 

You can also minimize the panel by: (1) clicking the yellow button in the top-left 
corner of the panel window; (2) double-clicking anywhere on the panel’s title 
bar; or (3) pressing Command-/.

Record
The Record menu (Figure 3-12) does not appear in the menu bar unless a Waveform 
Recorder Device is a part of the Workbench configuration and the Workbench is on. 

When you use a Session Template to initiate a new session, the Record menu is always 
present but does not contain the New Recording and Close Recording commands. 
This is because the Session Template automatically handles the naming and closing of 
the file.

Each Record menu command is described in the following paragraphs.

• New Recording: deploys the New Recording window (Figure 3-13) to create and 
name a new Recording file. 

New Recording does not initiate recording; it only creates and names the file. 
Use Record (Figure 3-14) to start recording. 

Figure 3-12. Record menu, Workbench, and Session variants

The New and Close buttons are functionally 
equivalent to the New Recording and Close 
Recording commands in the Workbench 
Record menu.

(Workbench)

(Session)
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• Close Recording: terminates recording and closes the Recording file.

• Record: starts recording. Functionally equivalent to the Record button (see 
Figure 3-15).

• Stop: stops recording. Functionally equivalent to the Stop button (see
Figure 3-15).

Figure 3-13. New Recording window

Figure 3-14. Clicking Record initiates Workbench recording

Click Record
to initiate recording.
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• Show Big/Small Controls: toggles between normal-sized and small Waveform 
Recorder Controls panel. Functionally equivalent to the anchor button (see 
Figure 3-15).  

Display
The Display menu is used to manage 
multiple Dense Waveform Display panels 
(Figure 3-16). It becomes available when at 
least one Dense Waveform Display (see 
Chapter 6) is deployed on the Workbench or 
in a session.

Multiple Dense Waveform Display Devices
The Workbench allows multiple DWD devices, each of which can have up to four 
Dense Waveform Display windows.

• New Window: opens a new window for the frontmost Dense Waveform Display, 
up to four windows per Workbench device.

• Tile, Arrange, Stack: rearranges the windows of the frontmost Dense Waveform 
Display in the indicated arrangement.

• Reset All: causes the sweep lines of the frontmost Dense Waveform Display to 
reset to the leftmost position.

Figure 3-15. Big controls and small controls

Big controls Small controls

Figure 3-16. Display menu
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Time
The Dense Waveform Display’s Time menu duplicates the functionality of the Time 
pop-up menu (see “Scale Control Strip” on page 149) and controls the rate at which 
Net Station displays EEG waveforms. 

Time menu settings persist in Acquisition Setups. Opening an Acquisition Setup 
restores the last setting used in that setup. Opening a Session Template restores the 
settings of its embedded Acquisition Setup (see “The Embedded Acquisition Setup” 
on page 159).

 You can modify Time menu settings at any time, even during recording. The settings 
apply only to the way the data are displayed; changes to the Time menu do not affect 
the data recorded to disk.

Figure 3-17 displays the Time menu.

Following are brief descriptions of the menu items:

• Display Options: deploys the Time Display Options window.

• Actual Size (1/1): sets the waveform display to 1 sample/pixel.

• mm/sec and in/sec: sets units based upon screen distance.

• ms/pixel and samples/pixel: sets units based upon screen pixels (see “Display 
Method” on page 30).

Figure 3-17. Time menu (default settings)
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• (preset values): configures time scale to common presets.

• Other: allows entry of custom values for time scale.

Amplitude
The Dense Waveform Display’s Amplitude menu 
(Figure 3-18) commands duplicate those of the 
Amplitude pop-up menu (see “Scale Control 
Strip” on page 149).

Amplitude settings control the amount of vertical 
displacement each waveform occupies in the 
waveform display area of the Dense Waveform 
Display. 

Like the Time menu, the Amplitude menu 
settings persist in Acquisition Setups. Opening an 
Acquisition Setup restores the last setting used in 
that setup. Opening a Session Template restores 
the settings of its embedded Acquisition Setup 
(see “The Embedded Acquisition Setup” on 
page 159). 

You can modify Amplitude menu settings at any time, even during recording. The 
settings apply only to the way the data are displayed; settings made with the 
Amplitude menu do not affect the data recorded to disk. 

The Amplitude menu commands are:

• Actual Size (1:1): sets display to 1 µV/pixel.
• µV/mm and µV/cm and µV/inch: sets units based upon screen distance.
• µV/pixel: sets units based upon screen pixels (“Display Method” on page 30).
• (preset values): configures amplitude scale to common presets.
• Other: entry of custom values for amplitude scale.

Figure 3-18. Amplitude menu

This is a 
shortened 
version of 
the menu. 
The values 
continue, 
in varying 
increments, 
to 200.
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Events
Using Net Station’s Dense Waveform Display (see 
Chapter 6), EEG technicians and experimenters can 
enter “mark-up” events into an EEG recording. The 
events are called “mark-up” events after the 
practice of manually marking the paper chart 
recording to indicate the locations of significant 
occurrences in the EEG.

The Events menu (Figure 3-19) is one way to enter 
mark-up events into a recording. It displays preset 
events and their corresponding keyboard shortcuts. 
While a recording is in process, choosing one of the 
presets from the menu causes the preset event to be 
entered into the marks event track of the recording.

The buttons on the Events control strip of the Dense Waveform Display perform the 
same function.

The display of mark-up events in the Dense Waveform Display and the use of the 
Events control strip are covered on page 150.

Devices in General

Net Station provides six classes of Workbench devices for configuring acquisition 
(Table 3-2).

Table 3-2. Device class descriptions 

Device class Provides...

Display Windows and controls for viewing waveform and event data and for 
entering events.

Filter Controls for choosing and setting parameters for digital waveform filters.

Mixer Windows and controls for mixing multiple channels into a single channel.

Recorder Controls for starting, stopping, and pausing recording.

Source Controls for choosing the manner in which EEG and digital input event 
data are acquired.

Stimulus/Response Controls for configuring how stimulus presentation and subject responses 
are handled.

Figure 3-19. Events menu
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On the face of the device icon, the device’s class is 
shown along with the device’s name and version 
number. Using the Dense Waveform Display device as 
an example, Figure 3-20 demonstrates that: 

• A device has an input and output side, except for 
a couple of exceptions (Source devices have only 
outputs, and the Digital Video device in the 
Display class has no input or outputs; this is 
discussed in Chapter 9).

• A device’s class is indicated by a class icon unique to the class, and the device 
itself carries an icon that is unique to the device.

• A device has buttons on its face for deploying various info, display, and control 
panels. (Not all devices have all three; notice that the Dense Waveform Display 
has only info and display buttons.)

Core Devices
Workbench configurations need a Source, a Display, and a Recorder device, hence the 
following Net Station devices are termed, respectively, core devices:

• Net Amps USB, Net Amps 300, or Neurotravel USB
• Dense Waveform Display
• Waveform Recorder

A basic Workbench configuration consisting of only the three core devices is shown in 
Figure 3-21. This is actually the configuration used in the default Primitive 
Acquisition Setup (for details, see page 132).

Figure 3-21. Three core devices in a Workbench configuration

Figure 3-20. Example device

Source Display Recorder
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Cables and Jacks
Devices have from zero to four input and output jacks. Inputs are located on the left, 
outputs on the right (Figure 3-22). When you configure devices on the Workbench, 
you drag from the output jack of one device to the input of another and thus create a 
connecting cable (see “Placing and Connecting Devices” on page 66). 

Jacks are labeled and color-coded to match the four types of cables. The four jack 
types are:

• EEG: Waveform I/O; colored yellow. The yellow cable carries waveform data 
and all the necessary information to display such data, including sampling rate, 
montage, filter, gain, scale, and source device calibration information.

• MARK: Event marking I/O; colored green. The green cable carries information 
about user-generated events (for example, technician markups that are made in 
the Dense Waveform Display; see Chapter 6).

• PAT: Auto Pattern I/O; colored red. The red cable carries computer-generated 
events (for example, pattern recognition results). 

• STIM: Stimuli I/O; colored blue. The blue cable carries events that originate at 
the Net Amps DIN port and those sent to Net Station by an experiment control 
computer (for example, with E-Prime).

Figure 3-22. Dense Waveform Display device with parts labeled

Input side Output side

Info panel button
Device icon Display panel button

Class icon Class name Device name and version
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Device Buttons

Info panel button: All devices have an information panel button identified by a 
question mark. Clicking this button opens a panel that contains basic information 
about the device. See “Info Panels for All Devices” on page 72.

Control panel button: Labeled with a pointing hand or “finger,” the control panel 
button deploys floating, device-specific windows that feature a variety of control 
elements.

Display panel button: The “eye” indicates a button that deploys device-specific 
windows containing a variety of data display elements. Some display panels have 
buttons for initiating measurements, such as the Net Amps USB Device Display 
Panels (page 102).

Device Panels

Table 3-3 describes the Net Station devices, in the order that they appear in the 
Devices palette (Figure 3-23). 

Table 3-3. Panel references 

Device Panels

Dense Waveform Display Dense Waveform Display Info

Dense Waveform Display

Digital Video Digital Filter Info

Digital Filter Controls

EEG waveform viewer with controls for altering 
the rate, scale, and appearance of dense array 
EEG. Input device for technician markup events.

FireWire digital video synchronized with the 
EEG waveforms
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Spectral Display Spectral Display Info

Spectral Display Controls Panel:

Settings for controlling the amount of spectral data 
shown in the Spectral Display

Spectral Display Display Panels:

Spectral Display of data in Grid, Topo Plot, or 
Topo Map views 

Digital Filter Digital Filter Info

Digital Filter Controls

Bipolar Montage Editor Bipolar Montage Editor Info

Montage Controls

Waveform Recorder Waveform Recorder Info

Waveform Recorder Controls

Net Amps 300 Net Amps 300 Info

Net Amps 300 Control Panels:

Net Amps 300, Advanced Net Amps Controls, Digital 
Input Controls, Amp Diagnostics

Net Amps 300 Display Panels:

Gains, Zeros, Noise, Impedance

Net Amps USB Net Amps USB Info

Net Amps USB Control Panels:

Net Amps Controls, Advanced Net Amps Controls, 
Digital Input Controls, Amp Diagnostics

Net Amps USB Display Panels:

Gains, Zeros, Noise, Impedance

Table 3-3. Panel references (Continued)

Device Panels

Near-real-time display of spectral data. Takes 
same data shown in the Dense Waveform 
Display (montage and reference information) 
as the data input.

IIR filter with user-customizable settings. Use 
only for visualization of data, not recording.

Channel-grouping, mixing, and rereferencing 
tool. Rearranges how channels are displayed. 

Writes EEG and event data to a Session or 
Recording file.

The control and data interface to the Net Amps 
300 amplifier. When the Workbench is “on,” it 
conveys live data and events to devices 
connected to it.

The control and data interface to the Net Amps 
200 amplifier. When the Workbench is “on,” it 
conveys live data and events to devices 
connected to it.
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Devices Palette

Devices can be placed on the Workbench 
via the Devices palette (Figure 3-23) or 
from the Acq menu (“Acq” on page 54). 
"Placing and Connecting Devices" on 
page 66 describes how to access the 
Devices palette and drag devices from the 
palette to the Workbench. 

For now, note that on the palette, the icon 
on the left is the class icon. The device icon 
is next to it, followed by the device name. 
Beneath the name is the device class name. 
The devices on the palette are always 
sorted by class name, the same sort order 
used for Table 3-3.

Neurotravel USB Neurotravel USB Info

Neurotravel USB Control Panels:

Sampling Rate

Neurotravel USB Display Panels:

Impedance

Multi-Port Experimental Control Interface Multi-Port ECI Info

Multi-Port ECI Display

Photic Stimulator Photic Stimulator Info

Photic Stimulator Display

Table 3-3. Panel references (Continued)

Device Panels

The control and data interface to the 
Neurotravel amplifier. When the Workbench is 
“on,” it conveys live data and events to devices 
connected to it. 

Transports stimulus and user response events 
from the ECC to other Workbench devices.

Transports photic-stimulator events from the 
photic stimulator to other Workbench devices.

Figure 3-23. Devices palette
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Placing and Connecting Devices

You place devices on the Workbench and link them together with cables to create a 
Workbench configuration. Devices can be moved onto the Workbench only when the 
Workbench is off. Cables convey data from one device to another.

Create cables by using the mouse to drag from one jack (either input or output) to 
another (Figure 3-24). Inputs connect to outputs, and vice versa. The Workbench 
interface automatically rejects connections that are disallowed. If a connection is 
allowed, it is valid.

Note: Not every possible Workbench configuration will produce your expected result; if 
you experience difficulties with a Workbench configuration, contact Technical Support 
(Appendix A).

More than one output cable can be attached to a device so that the device’s data can 
stream into more than one device simultaneously. Also, some devices accept multiple 
input cables.

How to Place Devices on the Workbench
Launch Net Station to open the start-up window. In the Customize section, click the 
Acquisition Setup button. The Workbench, Acquisition status panel, Workbench 
menu bar, and Devices palette appear.

The Workbench is a grid of rectangles. Each rectangle is called a cell. You can place a 
single device into each cell. 

Drag a Net Amps USB, Net Amps 300, or a Neurotravel USB device from the Devices 
palette to a Workbench cell. The result should resemble frame 1 in Figure 3-24.

Use the Acq menu to place a Dense Waveform Display device into the cell that adjoins 
the Net Amps USB, Net Amps 300, or Neurotravel USB cell on the right. Do this by 
first single-clicking the cell to the right of the one that holds the amplifier device, 
which causes the cell to be highlighted. Choose Dense Waveform Display from the 
Acq menu (see frame 2 of Figure 3-24).
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How to Cable Together Two Devices
Connect the EEG output jack of the amplifier device to the EEG input jack of 
the Dense Waveform Display by placing the cursor over the output jack of the 
Net Amps USB, Net Amps 300, or Neurotravel USB device (frame 3 of Figure 3-24), 
then dragging to the right until the cursor is over the input jack of the Dense 
Waveform Display device. Release the mouse button to complete the connection 
(frame 4 of Figure 3-24). 

When two or more devices must be cabled to the same output jack, you must drag 
from the downstream device to the upstream device, or you will not be able to make 
the one-to-many connection.

Spectral Display Device
The Spectral Display device contains only EEG inputs and outputs because it shows 
frequency information for EEG data and does not display user or experimental events 
as the Dense Waveform Display does. However, similar to the Dense Waveform 
Device, you can have more than one Spectral Display device on your Workbench.

To add the Spectral Display device to an Acquisition Setup, you can place it anywhere 
on the Workbench. If you wish to view spectral data with filters, montages, and other 
devices applied, then place the Spectral Display device downstream of those devices. 
During review, you have the option of viewing spectral data with or without viewer 
transformations applied. For more information, see the Net Station Viewer Technical 
Manual.

Figure 3-24. Cabling two devices together

21

3 4
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Figure 3-25 shows a sample Workbench configuration. During acquisition using this 
setup, one Spectral Display presents the unprocessed data, another Spectral Display 
shows filtered and rereferenced data, the Dense Waveform Display also shows the 
processed data, and the Waveform Recorder device records the unprocessed data and 
the user and experiment events.

Optional Digital Video Device
The Digital Video device has no inputs or outputs because it is an auxiliary device 
that is automatically linked to the Waveform Recorder. Add it to the Workbench 
without connecting cables to or from it, and save the Acquisition Setup. During 
recording, it automatically receives the start and stop recording commands from the 
Waveform Recorder device. See Chapter 9 for more information.

Figure 3-25. Sample Workbench configuration with multiple Spectral Display devices
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CHAPTER 4WORKBENCH: 
CONTROLS/DISPLAYS

he Workbench offers a number of devices and panels to help you create the 
Acquisition Setup you need. The core devices are Source, Display, and Recorder; 

once you have these connected, add other devices and configure them as desired. 

This chapter starts with an overview of the five core devices: Net Amps USB and 300, 
Neurotravel USB, Dense Waveform Display, and Waveform Recorder. 

The chapter then describes in detail the panels for all the devices. These panels 
include: 

• info panels
• control panels (for example, file size, Net Amps calibration, digital inputs)
• display panels (amplifier and GSN noise tests, electrolyte bridge detection, and 

so on)

Overview of the Core Devices

This section briefly describes the five core devices: Net Amps USB and 300, 
Neurotravel USB, Dense Waveform Display, and Waveform Recorder. 

Net Amps USB and 300 Devices
The Net Amps USB and 300 devices provides software control of the Net Amps 200 
and 300 amplifiers. Data being collected by the real-world amplifier are brought into 
Net Station via the output jacks of the Net Amps USB or 300 device.

T
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If the system is collecting EEG, other Workbench devices can access the EEG when 
their input EEG jacks are hooked up to the output jack of the Net Amps USB or 300 
device.

Net Amps 200 and 300 support the following features:

• digital inputs (DINs)
• automatic amplifier calibration
• automatic impedance measurement
• automatic noise measurement
• electrolyte bridge detection
• analog signal filtering

These features are accessible through the Net Amps USB or 300 device control and 
display panels. The panels for the two devices are nearly identical and are described 
in the same sections. Descriptions of the Net Amps USB and 300 device control panels 
begin on page 85. Descriptions of the Net Amps USB and 300 device display panels 
begin on page 109.

Neurotravel USB Device
The Neurotravel amplifier works the same way as the Net Amps 200. It collects real-
time data and sends them to Net Station by way of a USB cable connected to the DAC. 

As with the Net Amps USB device, other Workbench devices can access the EEG 
collected by the Neurotravel amplifier. When creating the Acquisition Setup, just 
connect the output jack of the Neurotravel USB device to the input EEG jack of the 
desired devices. 

However, the Neurotravel amplifier is a 32-channel clinical unit and, consequently, 
has fewer features than either the Net Amps 200 or 300 amplifier. 

The Neurotravel amplifier contains no digital inputs connector, no hardware support 
for electrolyte bridge detection, and no user controls for setting the analog signal filter 
(hardware filter). The filter is set to 0.016–141.0 Hz, bandpass, and cannot be changed. 
The amplifier requires no calibration or noise tests, but does run a calibration test 
signal. Impedances can be measured but not stored. 
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The Neurotravel filter, calibration signal, and impedance features are viewable in the 
Neurotravel USB device control and display panels. Descriptions of the Neurotravel 
USB device control panels begin on page 101. Descriptions of the Neurotravel USB 
device display panels begin on page 126.

Dense Waveform Display Device
The Dense Waveform Display device (Figure 4-1) is used for viewing EEG waveforms 
and event tracks. In addition, it is an input interface for technician markup events that 
can be entered and recorded along with the EEG in the Dense Waveform Display 
MARK event track. 

EEG and DINs are correctly set up for display by the Workbench configuration shown 
in Figure 3-21 on page 61. The EEG and STIM cables are both connected from the 
source device to the Dense Waveform Display. 

The Dense Waveform Display display panel is briefly described, beginning on 
page 109. Because the Dense Waveform Display is such a major part of Net Station, an 
entire chapter is also devoted to it; see Chapter 6.

Figure 4-1. Example Dense Waveform Display

Event 
tracks
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Waveform Recorder Device
Recording EEG to disk is accomplished by cabling EEG data on the Workbench to the 
Waveform Recorder device. The Workbench configuration in Figure 3-21 shows that 
the EEG data cable coming out of the Net Amps USB device does not need to connect 
directly to the input of the Waveform Recorder. The data can “pass through” another 
device on their way to the recorder. In this case, they pass through the Dense 
Waveform Display.

In the Workbench configuration shown in Figure 3-21, DIN events are conveyed to 
the recorder by connecting the STIM output of the source device to the Dense 
Waveform Display and hooking the STIM output of the Dense Waveform Display to 
the recorder’s STIM input. DIN events will be recorded along with the EEG. No time 
delay is introduced by the Dense Waveform Display device being connected between 
the source and recorder devices.

The Dense Waveform Display device provides an interface for entering technician 
mark events into a recording. For these events to be registered in a recording, the 
MARK input of the Waveform Recorder device is connected to the MARK output of 
the Dense Waveform Display (as in Figure 3-21). 

A description of the Waveform Recorder device control panel begins on page 78. 

Device Panels for All Devices

In most cases, device panels are deployable via device buttons (see “Device Buttons” 
on page 63) and optionally by menu commands that Net Station installs in the Panels 
menu (see “Panels” on page 54), depending on which devices are part of the active 
Acquisition Setup. An exception are the Net Amps USB and 300 devices. Some of the 
control and display panels for this device are available only from the Panels menu. 

Info Control Display



4: Workbench: Controls/Displays

73Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006

Info Panels for All Devices

Each device has an info panel, which you can 
view by clicking the info panel button on the 
device (Figure 4-2). 

The info panel contains general information 
about the device, including version number. 
Figure 4-3 shows the info panels for all the 
devices.

Figure 4-3. Info panels for all the devices

Figure 4-2. A device info panel

Montage Editor

Dense Waveform Display

Digital Filter

Digital Video

Multi-Port ECI

Neurotravel USB

Photic Stimulator

Spectral Display

Waveform Recorder

Net Amps USB

Class icon
Device icon

The Net 
Amps 300 
panel is 
similar.
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Control Panels for All Relevant Devices

Not all devices have control panel buttons. 

Those devices that do contain control panel buttons are:

• Digital Filter
• Montage Editor
• Waveform Recorder
• Net Amps USB
• Net Amps 300
• Neurotravel USB
• Multi-Port ECI
• Photic Stimulator
• Spectral Display 

This section describes each control panel in detail. 

Digital Filter Control Panel
To open the Digital Filter controls panel (Figure 4-4):

• click on the control panel button on the Digital Filter device or
• choose Panels > Digital Filter Controls. 

Caution!: See page 77 for a caution against placing this Filter device in a 
configuration that would result in digitally filtered data being recorded. 

Control Panel Description and Usage 
You customize a Digital Filter device’s effect by choosing to activate one, two, or all 
three of the available filter effects:

• lowpass
• highpass
• notch
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Activate lowpass digital filtering by toggling the 
Lowpass button to its “on” position (Figure 4-5) and 
clicking one of the available presets below the button. 
The selected preset is highlighted. The Highpass and 
Notch toggle buttons work exactly the same way. 

The presets of a given list are mutually exclusive choices, 
but the Lowpass, Highpass, and Notch buttons can be set 
in any combination. 

When a Digital Filter device’s input is connected to an 
EEG cable carrying EEG, the output jack of the Digital 
Filter device produces filtered EEG according to the 
activated preset effects—but only if the Digital Filter 
device has been turned on. In the top-left portion of the 
control panel are two buttons you use to turn the Digital 
Filter device off and on. These buttons indicate by their appearance (Figure 4-6) the 
current state of the device. When it is on, the filter produces an effect that is a 

Figure 4-4. Digital Filter Controls

Lowpass effect off

Lowpass effect on

Figure 4-5. Effect of 
toggling the Lowpass button

Figure 4-6. Appearance of 
buttons when filter is on
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combination of your selections (see example in the following "Filter Types" section). 
When the Digital Filter device is off, data pass through it unchanged. 

Filter Types
Some filtering terminology:

• Lowpass filters: pass low frequencies and attenuate high frequencies.

• Highpass filters: pass high frequencies and attenuate low frequencies.

• Notch filters: are set to attenuate a single frequency, for example, 50 Hz or 
60 Hz, with sharply limited attenuation of frequencies above and below the 
target frequency.

• Bandpass and bandstop filters: are shorthand ways to describe a combination of 
lowpass and highpass filters. Bandpass filters attenuate frequencies on either 
side of a band, allowing the band to pass unattenuated. Bandstop filters 
attenuate frequencies above a certain frequency and below a higher frequency, 
so that only frequencies not in the band are allowed to pass unattenuated. A 
notch filter is a kind of bandstop filter, one with a particularly sharp profile.

For example, you can choose a 1–100 Hz bandpass filter by picking a 100-Hz 
lowpass filter and a 1-Hz highpass filter. Next to the On button a label will 
appear, describing the filter that has been built. 

Clicking the close button of the control panel or choosing File > Close Window 
causes the control panel to disappear, but the filter is still active as long as the 
Workbench is on and the panel was closed with its On button selected.

Multiple Digital Filter devices can be used in a Workbench setup, each with its own 
parameters.

IIR Filtering

Net Station offers IIR filtering using the Digital Filter device. IIR filtering is rapid, but 
an IIR filter lacks linear phase response (the amount a filter shifts each frequency 
component in time).
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Linear phase response is necessary to obtain a filtered signal with no distortion. The 
inherent distortion of IIR filtering disqualifies it for use in transforming data, but it is 
adequate for data visualization. IIR filtering is very useful, for example, for observing 
real-time waveforms with 60-Hz environmental noise (common in the United States) 
filtered out.

Net Station presents a Caution 
message whenever you cable 
together a Workbench 
configuration that has a recorder 
device downstream of the Digital 
Filter device (Figure 4-7). You are 
free to click the OK button in the 
Caution dialog and accept the 
configuration, but see the Caution 
message below.

Caution!: Connecting an active Digital Filter ahead of and in series with the 
Waveform Recorder device results in filtration of the data being recorded. IIR 
filters are not appropriate for this purpose. Do not connect a Digital Filter device 
in such a way that the data are acted upon by the filter before they are recorded.

Montage Editor Control Panel
The term montage refers to a specific 
way of defining sensor data 
visualization.

To open the Montage controls panel 
(Figure 4-8):

• click on the control panel 
button of the Bipolar Montage 
Editor device or

• choose Panels > Montage 
Controls. 

When the Workbench is off, the montage list is not displayed in the panel. When the 
Workbench is on, single or multiple montages will be listed.

Figure 4-7. Recording of IIR-filtered data is inadvisable

Figure 4-8. Montage controls panel (Workbench on)
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Net Station includes preconfigured montages for Geodesic EEG Systems. The ones 
that match the channel count of the Geodesic Sensor Net being used will appear in the 
list if a Net is connected to the system. If a Net is not connected, only default channel-
count montages are listed.

Rereferencing the signals of all the sensors of a Net to a reference consisting of the 
mean signal of all the sensors is called average referencing. An average reference 
montage appropriate to the connected Net’s sensor density is included in the 
montage list. 

You can choose other available default montages from the list. Clicking the “eye” icon 
to the left of any montage label in the Montage controls panel moves the “eye” icon to 
the selected montage, and the EEG channels being displayed in the Dense Waveform 
Display (Chapter 6) will immediately reflect the newly selected montage.

Note: Applying a montage does not alter the data being recorded; it only modifies the way 
the data are displayed onscreen.

Sensor maps showing the architecture of the default listed montages for EGI’s 32-,
64-, 128-, and 256-channel Nets are given in Appendix C, "Montages,” which includes 
a table indicating the referencing scheme for each montage. 

Waveform Recorder Control Panel
The job of the Waveform Recorder device is to take the data coming in to its inputs 
and write them to Net Station Recording and Session files (see “Recording Modes and 
File Sizes” on page 79).

With the Workbench, you take control of recording via the Waveform Recorder 
controls panel (Figure 4-9), which you can open by:

• clicking the control panels button on the Waveform Recorder device or
• choosing Panels > Waveform Recorder Controls.

The Waveform Recorder Controls panel features tape-recorder–style Stop and Record 
buttons. You toggle between two sizes of the control panel using its “anchor” button. 
The minimized or “small controls” version of the control panel is not movable and 
anchors to the bottom of the screen. The “large controls” version can be repositioned 
anywhere on the screen by dragging. 
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When recording a Session file using a Session Template, the Waveform Recorder 
Controls panel is identical to its Workbench version except for the New and Close 
buttons being replaced by a Session Info button (Figure 4-10). The anchor and other 
buttons work the same way. 

Recording Modes and File Sizes
Net Station writes two EEG data file types during acquisition:

• Net Station Recording (created using an Acquisition Setup)

• Net Station Session (created using a Session Template, clinical or research)

Figure 4-9. Waveform Recorder Controls (Workbench off)

Figure 4-10. Waveform Recorder Controls detail (Session)

Button for toggling 
between minimized 
and full-sized 
versions of the 
Waveform Recorder 
Controls panel.

New and 
Close buttons

Session Info button

Recording 
icon

Session 
icon
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Both file types have a default file-size limit of 1.8 GB. You can change the file size by 
choosing Net Station > Preferences and typing in a value from 100 to 1,800 MB in the 
Recording File Segments section at the bottom of the window (Figure 4-11). 

During acquisition, Net Station stops recording if the file-size limit is reached, and 
immediately starts recording a new file, providing continuous recording with no loss 
of data. The automatic file-naming convention is 00_<filename>, 01_<filename>, and 
so on. 

Note: For long acquisition sessions resulting in multiple files, we recommend creating a 
file folder for storing each session’s files. This prevents the overwriting of identically 
named files from different sessions.

To review the recorded data in the Viewer, open any of the Session files for that 
recording. A message automatically displays, indicating that other files are associated 
with that file (Figure 4-12).

Figure 4-11. File-size limit

Change file-size 
limit here
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Click Open All Segments, which will automatically open the first file of the recording. 
When you navigate to the end of that file, a thick yellow vertical bar indicates that the 
data are continued in another file. Click the Go To End navigation button (Figure 4-13) 
to open the next file in the data session automatically. When you navigate to the end 
of the last file in the recording, the Go To End button is dimmed, indicating the end of 
the recorded data.

Figure 4-12. Additional-file message

Figure 4-13. The first file in a multifile recording

The Go To End button is active, indicating 
that the recording contains more data. 
Click this button to open the next file in the 
recording automatically.

The thick yellow bar 
indicates that the data 
continue to another file. 
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Net Station Recording File
You create Net Station Recording files by using the 
Workbench environment. As soon as you click the Record 
button of the Waveform Recorder Controls panel, Net Station 
starts writing a file. The elapsed time area of the panel 
changes from yellow to pink and the elapsed time counter 
begins (Figure 4-14).

Clicking the Stop button suspends recording but does not 
close the Recording file. Clicking the Record button after 
Stop reinitiates recording to the same file, appending 
additional data to it.

When you click the Close button in the control panel, the 
Recording file closes and cannot be overwritten or appended 
to. You can initiate a new Recording file by clicking Record.

Toggling Record and Close creates successive recording files 
that are autonamed in the series, “Recording 1,” “Recording 
2,” and so forth. The default destination of these files is the 
Sessions folder (see page 40 for details).

Clicking the New button invokes the appearance of a file-naming and destination 
window. Typing a file name overrides the default autonaming scheme.

Recording files can contain multiple epochs of EEG. As noted earlier, the Stop button 
halts recording without closing the file. Clicking the Record button appends data to 
the file until you click the Stop button again. In this way, the resulting Recording file 
will contain a sequence of multiple epochs delineated by epoch boundaries.

Net Station Session File
You use a Session Template to initiate Session files. When a new session is initiated, 
the Waveform Recorder Controls panel becomes available on the Panels menu after 
you click the Begin Session button in the New Session panel.

Record and Stop buttons work the same way in a session as they do when you are 
using the Workbench (see earlier) and allow you to create multiepoch files. 

Figure 4-14. Click the 
Record button



4: Workbench: Controls/Displays

83Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006

Close the Session file by clicking the Close Session 
button (Figure 4-15), which occupies the right side of 
the Acquisition status panel when a session is under 
way.

During a session, the Close Session button performs the same function as the Close 
button on the Waveform Recorder Controls panel when you are using the Workbench.

For an example Session, see Chapter 7, “Sessions and Session Templates.”

Time Indicator and Disk Monitor
Figure 4-16 shows how the Waveform Recorder Controls panel might appear during 
Workbench recording. The two disclosure triangles independently toggle the 
deployment of the Time Indicator and Disk Monitor subpanels.

The Time Indicator subpanel works just like the Elapsed Time area. During recording 
and at pauses during recording, it reports the passage of time using a chosen time 
mode (see the next section, "Time-Mode Buttons").

The Disk Monitor shows how much space or recording time is left on the disk to 
which the recording is being made.

Note: It is safe to toggle the buttons of the Disk Monitor subpanel during recording. This 
has no effect on the data being recorded. 

Time-Mode Buttons
With its two time-mode buttons (see Figure 4-16), the Waveform Recorder Controls 
panel allows you to monitor elapsed time in more than one format simultaneously. 
Net Station’s time modes are shown in Table 4-1. You can select Absolute, Relative, or 
Epoch mode by toggling a time-mode button. Toggling the time-mode buttons is 
permitted during recording and does not affect the data being recorded. 

Figure 4-15. Session Info and 
Close Session buttons
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Recording Time mode is not one of the options; it is available only in the Dense 
Waveform Display. 

The time-mode buttons do not acquire a “pushed-in” appearance, but the symbol 
displayed on the face of such buttons always reports the time mode that is in effect 
(see Table 4-1). 

Figure 4-16. Expanded Waveform Recorder Controls panel

Table 4-1. Time modes

Symbol Time mode Time reckoning scheme

Absolute (Clock) 980105/18:39:11

date (yymmdd)/hour:minute:second

Relative (Workbench) 00:03:22

hour:minute:second

Epoch [3]00:08:23

[epoch number]hour:minute:second

Recording 00:05:59

hour:minute:second

Name of Recording file 
currently being written

Elapsed time area

Timed Record button and box

Time Indicator subpanel

Time-mode button

Disk Monitor subpanel
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Timed Record
The button and field labeled “Timed Record button and box” in Figure 4-16 provide a 
means for stopping a recording after a set period of time, with the default time equal 
to 20 seconds. This feature is useful when a series of epochs needs to be generated, 
each with exactly the same duration. 

When the Timed Record button is initially pushed in, the box displays the default set 
time of 20 seconds, and the box becomes editable (Figure 4-17). Editing is performed 
by selecting each digit individually and typing over it to create a new set time, which 
will persist until edited again. 

Whenever the Timed Record box is displaying a set time, clicking the Record button 
on the Waveform Recorder Controls panel causes timed recording to begin. As soon as 
recording begins, the Timed Record box becomes a countdown display, ticking off the 
seconds until the new epoch is finished being recorded. The box then reverts back to 
displaying the duration that was last set. 

Net Amps USB and 300 Control Panels
Unlike other Net Station devices, the Net Amps  USB and 300 devices have multiple 
control panels:

• Net Amps Controls: to open, click on the control panel button on the Net Amps 
USB or 300 device or choose Panels > Net Amps Controls.

• Digital Input Controls: to open, choose Panels > Digital Input Controls.

• Amp Diagnostics: to open, choose Panels > Amp Diagnostics.

Figure 4-17. Using the Timed Record feature

Timed Record 
mode is ready but 
not set.

Timed Record 
mode is set and 
box is editable.
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The Net Amps USB contains a fourth panel 
(Figure 4-18):

• Advanced Net Amps Controls: to open, choose 
Panels > Advanced Net Amps Controls.

Net Amps Controls
When the Net Amps USB or 300 device is a part of a Workbench configuration, the 
Panels menu displays its four or three control panels as shown in Figure 4-18. Chief 
among these panels is the Net Amps Controls panel, which gives access to and control 
over the Net Amps sampling rate, multifunctional amplifier calibration sequence, and 
impedance measurement interface.

The Net Amps USB Controls panel also contains controls for a lowpass hardware 
filter; the Net Amps 300 Controls panel does not. 

To open this panel (Figure 4-19):

• click the control panel button on the Net Amps USB or 300 device or
• choose Panels > Net Amps Controls.

The panel consists of the notification area, Sampling Rate buttons, Lowpass 
Hardware Filter slider (for Net Amps USB only), Calibrate Amplifier button, and 
Measure Net Impedance button.

Figure 4-19. Net Amps Controls (default settings)

Figure 4-18. Net Amps USB 
Control panels (Panels menu)

Notification area

Sampling Rate buttons

Lowpass Hardware 
Filter slider
(Net Amps USB only)

Amplifier calibration 
and sensor impedance 
measurement
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Notification Area

The notification area delivers information about the status of Net Station’s USB or 
FireWire connection to the Net Amps. For example, if Net Station detects that an 
amplifier is not connected, it displays the message shown in Figure 4-19: <unknown - 
no amps connected>. 

Sampling Rate Settings

Net Station defaults to collecting EEG at 250 samples per second, but you can click a 
Sampling Rate button to change this, even during recording. However, changing 
sampling rates during recording can complicate subsequent data analysis.

When recording begins, the initial sampling rate setting is stored in the Sampling Rate 
track of the Recording or Session file. Any subsequent sampling rate changes that you 
may make during recording are also registered in the Sampling Rate track with the 
time of their occurrence.

Lowpass Hardware Filtering Settings for the Net Amps

Net Amps 200 electronics perform lowpass analog filtering before digitization. 
Controls for setting the lowpass cut-off frequency are on both the Net Amps Controls 
panel and Advanced Net Amps Controls panel (see page 85).

The default cut-off frequency is close to the Nyquist frequency, subject to the setting of 
the Auto Set to Nyquist checkbox on the Advanced Net Amps Controls panel.

Note: See “Antialiasing and Lowpass Filtering” in Chapter 5, “Amplifiers,” in the GES 
Hardware Technical Manual, if you are considering setting the lowpass cutoff below the 
Nyquist frequency, which generally is not recommended. 

The Net Amps 300 also performs lowpass analog filtering, but it sets the cut-off 
frequency automatically, based on the sampling rate chosen. No filter controls are 
included in the Net Amps 300 Control panel. 
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Amplifier Calibration

Assuming the physical components of the system are connected and switched on, the 
amplifier is calibrated using the Net Amps Controls panel of the Net Amps USB or 
300 device (Figure 4-19). Such calibrations can be automated using an appropriate 
Session Template (see “Automatic Amplifier Calibration” on page 168). Likewise, 
sensor impedances (“Net Noise Display Panel” on page 117) and noise (“Noise 
Display Panel” on page 114) can be measured and stored in a retrievable way.

To initiate an amplifier zero and gain measurement manually, click the Calibrate 
Amplifier button. See “Calibration” in Chapter 5, “Amplifiers,” in the GES Hardware 
Technical Manual for complete coverage of this topic, including:

• amplifier calibration process
• gains and zeros

You will see the Measuring Zeros progress bar (Figure 4-20) after clicking the 
Calibrate Amplifier button. Zeros calibration is performed first, followed by gains 
calibration. You can cancel both gains and zeros calibration by clicking the Cancel 
button on the Measuring Zeros progress bar at any time while zeros are being 
measured. Once the Measuring Gains progress bar appears, you can cancel only the 
gains measurement.  

Net Station stores gains and zeros measurement sets in Amplifier History files that are 
sequestered in the Net Station Package file. To review past measurements of gains 
and zeros, use the Gains display panel and Zeros display panel (see coverage, 
beginning on page 113).

Net Station checks for out-of-range values for gains and zeros and issues a message if 
any channel exhibits an out-of-range value. A channel gain is in-bounds if it is 
between 50% and 150% of its nominal value. A channel zero is specified to be in-
bounds if it is between –100 µV and +100 µV. If an out-of-range condition occurs, 
follow the instructions presented by the Net Station message.

Note: The Gains display panel and Zeros display panel (page 113) also present buttons for 
initiating gains and zeros measurements, and when used in tandem they duplicate the 
functionality of the Calibrate Amplifier button. The Calibrate Amplifier button always 

Figure 4-20. Calibration progress bars
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performs zeros calibration first, then gains calibration. When using the display panels to 
initiate calibration, the order of these measurements is unimportant.

Sensor Impedance Measurements

A sensor array must be plugged into the system for impedances to be measured. 
Attempting to measure impedances without an array connected, or disconnecting an 
array during an impedance measurement, will generate an error message. 

Net Station begins to measure the contact impedance at each sensor location when 
you click the Measure Net Impedance button on the Net Amps Controls panel. You 
can also initiate sensor impedance measurement by clicking the Measure button on 
the Impedance display panel (see “Impedance Display Panel” on page 120). In both 
cases, the result is the same: the Impedance Measurement window (Figure 4-57) 
opens and a sensor impedance measurement begins (for details, see page 121). 

A progress bar at the bottom of the Impedance Measurement window is active during 
the time this window is frontmost on the screen. Net Station performs a scanning 
operation and reports on it via the progress bar. As soon as Net Station has scanned all 
the sensors of the array, it updates the window with the latest impedance values, 
showing them as a list and refreshing the color-coding of the sensor layout. EGI’s 
standard recommendation for scalp impedances is 50 KΩ. 

Net Station repeats this cycle until you click the Close or Save & Close button.

Note: Impedance values are not saved to the file unless data are recorded after measuring 
impedances. Merely clicking the Save & Close button will not save the impedance values.

Advanced Net Amps Controls (Net Amps USB)
Unlike the Net Amps 300, the Net Amps USB 
contains an Advanced Net Amps Controls 
panel. You open that panel (Figure 4-21) by 
choosing Panels > Advanced Net Amps 
Controls.

The panel consists of the Lowpass Hardware 
Filtering controls and the Highpass Hardware 
Filtering controls.

Figure 4-21. Advanced Net Amps 
Controls panel (default settings); 
available for Net Amps USB only
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Lowpass Hardware Filtering

A choice of Bessel or elliptical (the default) lowpass hardware filtering and an Auto 
Set to Nyquist checkbox are provided in the upper subpanel. See “Antialiasing and 
Lowpass Filtering” in Chapter 5, “Amplifiers,” in the GES Hardware Technical 
Manual for a discussion of filter types.

Highpass Hardware Filtering

The lower subpanel of the Advanced Net Amps Controls panel is where you can 
choose the cut-off frequency for the Net Amps highpass filter, with a 0.1 Hz cutoff 
being the default. Before changing the default, you should study and understand the 
rationale and theory behind highpass hardware filtering in “Highpass Filtering” in 
Chapter 5, “Amplifiers,” in the GES Hardware Technical Manual.

Digital Input Controls
The digital inputs connector (DIN port) on the back panel of the Net Amps 200 and 
300 brings in external digital input (DIN) events into your recording. Net Station 
converts inputs to events based on user-definable rules. 

Setting up digital inputs is accomplished through the Net Amps USB or 300 device’s 
Digital Inputs Controls panel. Its STIM output jack is a source for DIN events when 
the amplifier is configured for receiving digital inputs. 

The Digital Input Controls panel allows you to configure how external digital input 
events are captured by Net Station via the Net Amps. 

To open this panel, choose Panels > Digital Input Controls.

Background for Using Digital Input Controls

Every Net Amps 200 amplifier has a 9-pin (DB-9) connector (the DIN port) on its rear 
panel for connection of external devices such as the EGI response pad or external 
circuitry. The Net Amps 300 amplifier has two 12-pin connectors (two DIN ports), but 
the current version of Net Station is capable of supporting only 8 inputs.

Net Station monitors the DIN port for external events. The Dense Waveform Display 
shows real-time DIN events in its tracks area in synch with EEG acquisition. 
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Depending on the Net Amps 200 serial number, you can monitor as many as four or 
eight external signals simultaneously through pins 1–4 or 1–9 of the DB-9 connector. 
With the Net Amps 300, you can monitor as many as eight external signals.

When digital input events are being monitored and recorded along with EEG, they are 
synchronized with the EEG, with millisecond accuracy. 

Note: For Net Amps 200 models with serial numbers 20040135 and later, the pins are
1–9, and for Net Amps with earlier serial numbers, the pins are 1–4; for all Net Amps 200 
models, pin 5 is ground. If you are unsure about how many DIN channels your amplifier 
has (for example, if the number of DIN channels on your amp was specially upgraded), 
contact support@egi.com.

You may not need or want Net Station to monitor pins 1–4 or 1–9 of the Net Amps’ 
connector. This capability is configurable using the Digital Inputs Controls panel (see 
page 92).

Mapping Pin Numbers to Net Station Digital Input Events

Because you can toggle a total of four (or eight pins) on the connector independently, 
a maximum of 24 = 16 (or 28 = 256) event states are possible. Each event state 
corresponds to a digital input channel. 

Net Station maps the DIN port into the four (or eight) bits corresponding to a binary 
number (Figure 4-22) such that each combination of events corresponds to a number 
between 0 and 15 (or 0 and 255). Hence, the digital input channels recognized by 
Net Station can be numbered from 1 to 14 (or 1 to 254), with the remaining event state 
(no events on any pins) being undesignated as a channel because it is the absence of 
any digital input. 

Figure 4-22. DIN port pin numbers map to bits

GND
BITS = 1234

6789
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Acquisition Setup Connections

The STIM jack of the Net Amps USB or 300 device is a spigot for digital input events 
that are captured at the DIN port by the physical Net Amps 200 or 300 (Figure 4-23).

DIN events will not be recorded unless a 
STIM cable is connected in a manner that 
allows flow from the Net Amps USB or 
300 device to the Waveform Recorder. 
The events will not be visible in the 
Event track of the Dense Waveform 
Display unless the STIM cable is 
connected so that DIN events can flow 
into the Dense Waveform Display device 
STIM input jack.

Physical Connections

“DIN Port” in Chapter 5, “Amplifiers,” of the GES Hardware Technical Manual 
provides details on connecting external signals to the DIN port of the Net Amps.

Verify that the Workbench is “off” before attaching devices (for example, an AV tester) 
to the DIN port, otherwise you may receive an error message. 

Digital Input Controls Panel

After you connect an EGI response pad or similar device to the Net Amps’ DIN port, 
you must invoke the Digital Input Controls panel in Net Station and make settings 
that are appropriate to the input device and how the events are going to be displayed 
and recorded. 

The basic appearance of the panel is shown in Figure 4-24, which indicates how 
clicking the disclosure triangle either reveals or hides the tabpanel where you make 
your settings. 

Note: The controls of the Digital Input Controls panel are dimmed and unavailable when 
the Workbench is on. To use the controls, first turn the Workbench off.

Figure 4-23. Connect STIM to deliver 
digital input data to downstream device

Digital
input
events
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Source Tabpanel 

Use the Source tabpanel to choose the mechanism 
for capturing external events (Figure 4-24). The 
EGI Response Pad button is the default.

If no external devices are linked to the connector, 
Net Station ignores the settings of the Digital 
Input Controls panel, unless you have chosen to 
designate the keyboard for digital input.

Set the EGI Response Pad button when an EGI 
response pad is linked to the Digital Inputs 
connector on the back of the Net Amps. (The EGI 
response pad connects only to the Net Amps 
amplifier.)

Set the TTL button when a custom-designed circuit for generating external events has 
been linked to the Net Amps digital inputs connector. Such a circuit must be able to 
put TTL-level signals on the DIN port pins. The external circuitry should hold a DIN 
port pin at ground when not generating events. To generate an event, the circuitry 
should put a positive TTL-level voltage on the pin momentarily or for a period of 
time. Such events will be recognized by Net Station appropriately if TTL has been set 
in the Source tabpanel. 

Set the Keyboard button for demonstration purposes only. DIN events will be 
generated when keyboard buttons are pressed, but without millisecond accuracy.

Tracks Tabpanel

Net Station provides a maximum of eight tracks for registering and recording digital 
input events. The Tracks tabpanel shown in Figure 4-25 exhibits Net Station’s default 
naming scheme for the tracks (DIN 1–DIN 8). You can edit the text boxes next to the 
track numbers to rename the tracks. After an Acquisition Setup is saved, your track 
names will persist in the Net Station interface and in the recorded files. 

Figure 4-24. Digital Input Controls 
panel, with Source tabpanel selected
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Events Tabpanel

Use the Events tabpanel (Figure 4-25) to set up which digital input channels should be 
monitored by Net Station.

The controls on this panel consist of preset buttons and the Advanced Event Setup 
button.

Eight pins on the digital inputs connector can receive external events, but not all the 
pins may need to be monitored. For example, a single response pad has only four 
keys that are linked to pins 1–4 of the connector. The Events tabpanel permits you to 
configure the monitoring of digital inputs in a way that is appropriate for your work. 
With the response pad, this would most likely be the 4 Channels preset.

Notice in Figure 4-25 that the bottom of the tabpanel contains the words “1 Active 
Event.” This is a visual feedback feature for users, indicating which of the digital 
input configurations is in effect.

Advanced Event Setup

The Advanced Event Setup button opens the Advanced Event Setup panel. An 
example setup is presented in Figure 4-26. Digital inputs are configured for recording 
events occurring on any combination of four (or eight) pins. The total number of 

Figure 4-25. Tracks and Events tabpanels

Default 
naming 
scheme

Default 
naming 
scheme
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possible pin combinations is 42 = 16 (or 48 = 256). (The Advanced Event Setup shows 
255 channels, with the 256th corresponding to “no events.”) 

Each digital event channel has a label number with a graphical representation of its 
binary code next to it. The binary code corresponds to events occurring on the pins of 
the connector. 

Clicking a channel selects and highlights it. Select noncontiguous channels by clicking 
on them while pressing the Command key. Select multiple contiguous channels by 
dragging across them. 

Selecting a channel (Figure 4-27) activates the subpanels to the right of the channel 
display area.

Figure 4-26. Advanced Event Setup

Figure 4-27. Channel 1 after being selected
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The Event Identifiers subpanel contains a code and/or 
label that will then be associated with the selected 
channel(s). Figure 4-28 shows the Event Identifiers 
subpanel with the default values displayed. Note that the 
Enabled checkbox is selected by default. This means that 
Net Station will look for events on the selected channel. 
Toggling the Enabled box off causes the channel to be 
ignored by Net Station.

Figure 4-29 shows an example of how text entered in the Event Identifiers subpanel 
propagates to the selected channel in the channel list.  

But only after the OK button has been clicked do the user’s code and label become 
associated with the selected channel (Figure 4-30).

DIN Event Structure

A DIN event always has an associated Event Identifier Code and Label. The Code 
must have a value, but the Label can be blank. Net Station puts the default value, 
“DIN” in the Code area, but leaves the Label area blank.

Figure 4-29. Editing code and label of a channel

Figure 4-30. After you have clicked OK, the code and label are set

Figure 4-28. Event 
Identifiers subpanel 
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All DIN events also have a key 
list (Figure 4-31), which may be 
empty or contain from one to 
three key-value pairs:

• KeyCode : Value
• Global Key Code : Value
• Channel Key Code : Value

The key list of a DIN event has 
all three by default, shown by 
the boxes associated with the 
key-list items being checked 
(Figure 4-32). 

Event Keys

The default key code is “CHAN” (Figure 4-32), 
but you can rename it, if desired. The default 
value for the key code is the DIN channel 
number, but it too may be changed (in the Key 
Value subpanel).

Event Counters

Net Station counts DIN events as they are 
received at the DIN port. The Global Key Code 
item of the key list holds a count of all DIN 
events that have been received. The Channel 
Key Code item holds a count of all DIN events 
of the channel to which the DIN belongs.

Figure 4-31. Anatomy of DIN event 

EventDIN

Identifier Key list

Code

Label

*Key code

*Global key code

*Channel key code

* optional

Figure 4-32. Keys and counters
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Input Matching

The lower-right corner of the Advanced Event 
Setup panel contains the Input Matching and 
Track controls (Figure 4-33).

Selecting the Edge button causes Net Station to 
register a single event when it detects a switch 
has changed its state from open to closed or 
closed to open, or when the TTL state of the 
pin has changed from positive to zero or zero to positive volts. When the electrical 
condition of the pin returns to its prior state, Net Station becomes ready once again to 
register a single event when and if the pin changes state again. In other words, when 
Edge is selected, Net Station registers the occurrence but not the duration of digital 
input events.

Selecting Pulse means that Net Station registers an event when it detects a change of 
state, and keeps registering events until the pin changes state. In this way, both the 
occurrence and the duration (number of samples that are acquired while the pin was 
in its change of state) are registered by Net Station.

The Input Matching default is Edge. You can mix and match if you wish, setting some 
channels to Edge and others to Pulse.

The Match Channels Exactly checkbox determines what sequence of inputs gets 
registered as a DIN event:

• If checked: an event is registered if the sequence of inputs received at the DIN 
port exactly matches the digital event channel’s binary code (see page 95).

• If unchecked: an event is registered if the sequence of inputs received at the DIN 
port only contains the digital event channel’s binary code (see page 95).

Assigning Digital Inputs to Net Station Event Tracks

DIN events are recorded into one or more tracks. In the Dense Waveform Display, 
events can be viewed in the Tracks area and matched to the EEG waveforms that were 
occurring at the times the events were recorded (see “Tracks Area” on page 151).

Note: Net Station’s eight event tracks for recording DINs have default names, DIN 1 to 
DIN 8 (Figure 4-34). As described in “Tracks Tabpanel” on page 93, you can rename the 
event tracks Net Station uses to register digital input events. The following section 
assumes that the event tracks have not been renamed.

Figure 4-33. Edge vs. pulse
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A channel’s events are assigned by default to a particular event track (Table 4-2).

Especially in the case of the 15- and 255-
channel presets, you may find it useful to 
reassign channels to event tracks that differ 
from the defaults. After you select a channel in 
the Advanced Event Setup panel, the Track 
assignment pop-up menu (Figure 4-34) is 
deployed and an event track selected. The 
channel display area updates to show the new 
assignment, but you must click the OK button 
for the setting to be made. If you plan to make a number of reassignments, it is best to 
enter all or groups of them at one time before clicking the OK button because the 
button closes the Advanced Event Setup panel.

Simple Event Setup Subpanel

The lowermost portion of the Advanced Event Setup panel contains the Simple Event 
Setup subpanel (Figure 4-35), with selections that match the choices on the Tracks 
tabpanel.

Table 4-2. Default channels to tracks assignments 

Preset Default event track(s)

Single Channel DIN 1

4 Channels DIN 1–DIN 4

8 Channels DIN 1–DIN 8

15 Channels all DIN 1

255 Channels all DIN 1

Figure 4-35. Simple Event Setup subpanel

Figure 4-34. Track pop-up menu
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The Simple Event Setup subpanel 
provides a convenient way to set Edge vs. 
Pulse, Code, and Event Keys for a given 
preset, or to reset all channels of a preset 
to the default settings. The Setup Inputs 
panel that appears when you click the 
8 Channels Presets button is shown in 
Figure 4-36. 

Using Digital Inputs

When digital inputs are enabled and the 
Digital Input Controls panel is onscreen, 
the top part of the panel becomes a 
display device that registers events as they 
occur (see Figure 4-37). The event 
channels are indicated visually, with 
hexadecimal labels, and with 
corresponding decimal labels at the same 
time.

Even as the digital input events are 
displayed in this manner, the Dense 
Waveform Display is registering the DINs 
in its Tracks area, as explained in 
Chapter 6, "Dense Waveform Display.”

Amp Diagnostics
The Amp Diagnostics panel is for the use of EGI technicians and is not covered in this 
manual. To make changes to this panel, contact EGI Technical Support (Appendix A, 
"Software Technical Support”). 

Figure 4-36. Example Setup Inputs panel

Figure 4-37. Digital inputs display



4: Workbench: Controls/Displays

101Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006

Neurotravel USB Control Panel
Unlike the Net Amps, the Neurotravel amplifier is designed solely for clinical 
settings. Consequently, the Neurotravel USB device is simpler in functionality and 
appearance than the Net Amps USB device.

The Neurotravel USB control panel contains the same top features as the Net Amps 
USB device control panel—notification area, and sampling rate buttons—but omits 
the bottom features—filtering and calibration (Figure 4-38). The filtering and 
calibration values are fixed and cannot be modified by the user.

To open the Neurotravel USB control panel:

• click on the control panel button on the Neurotravel USB device or
• choose Panels > Neurotravel USB.

The panel consists of the notification area and Sampling Rate buttons.

Notification Area
The notification area delivers information about the status of Net Station’s USB 
connection to the Neurotravel amplifier. For example, if Net Station detects that the 
Amp Server is not connected to a local server or that a Neurotravel amplifier is 
not connected to one of the DAC’s USB ports, it displays the following message: Can’t 
connect with local server, and <unknown - no amps connected>. 

Sampling Rate Settings
As with Net Amps, Net Station defaults to collecting EEG at 250 samples per second 
with the Neurotravel amplifier. You can click a Sampling Rate button to change this, 
even during recording; however, doing so can complicate subsequent data analysis.

When recording begins, the initial sampling rate setting is stored in the Sampling Rate 
track of the Recording or Session file. Any subsequent sampling rate changes that you 

Figure 4-38. Neurotravel USB control panel

Notification area

Sampling Rate buttons
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may make during recording are also registered in the Sampling Rate track with the 
time of their occurrence.

Sensor Impedance Measurements
As with the Net Amps, the Neurotravel amplifier requires that a sensor array be 
plugged into the system for impedances to be measured. Attempting to measure 
impedances without an array connected, or disconnecting an array during an 
impedance measurement, will generate an error message. 

The Impedance Measurement feature allows you to verify that good contact exists 
between the electrodes and the scalp before you record EEG data. 

To check the impedances, choose Panels > Impedance History to open the Impedance 
History window (Figure 4-39).

The Impedance History window contains windows for graphing the impedance 
values. These windows are blank until you click the Measure Impedance button, 

Figure 4-39. Impedance Measurement window for Neurotravel USB device

Click to open the 
Impedance 
Measurement 
window
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which opens the Impedance Measurement window (Figure 4-40) and initiates 
impedance checking. 

The Impedance Measurement window contains controls for setting the measurement 
threshold, and for specifying whether to display all values or just those above or 
below the threshold. This window is described in detail in “Impedance Measurement 
Window” on page 121.

The impedance feature continuously scans the electrodes, while you adjust the 
electrodes to improve contact. As soon as Net Station has scanned all the sensors in 
the array, it updates the window with the latest impedance values, showing them as a 
list and refreshing the color-coding of the sensor layout (red electrodes exceed the 
impedance threshold; green electrodes fall below or meet the threshold). 

Net Station repeats this cycle until you click the Close or Save & Close button. The 
Close button dismisses the window without saving the values; the Save & Close 
button saves the values to the file before dismissing the window and graphs them in 
the Impedance History window. 

When you review the file later, and choose Panels > Impedance, the Impedance 
History window graphs the saved impedance values according to your preferences 
(see “Impedance Display Panel” on page 120 for more details). 

Figure 4-40. Impedance Measurement window for Neurotravel USB device
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Multi-Port ECI Control Panel
Net Station’s Multi-Port Experimental Control Interface (ECI) device allows serial 
communication or TCP/IP communication between the experiment control device 
and the DAC. The device is called “multi-port” because more than one port can be 
selected, enabling more than one stimulus-presentation tool to be used. 

The Multi-Port ECI device must be a part of a Workbench setup, Acquisition Setup, or 
Session Template for experiment control with ECI to function. The STIM output of the 
Multi-Port ECI device must be connected such that the messages it generates can be 
received by the Dense Waveform Display and Waveform Recorder devices (see 
Figure 5-5 in Chapter 5, "Workbench: Acquisition Setups,” for an example that uses 
the Net Station default Experimental Control Setup).

To open the Multi-Port ECI control panel:

• click the control button on the Multi-Port ECI device, or
• choose Panels > Multi-Port ECI

The panel consists of the IP address, TCP/IP port information, Configure button, and 
Log button (Figure 4-41).

IP Address
The IP address provides networking information required by the experiment control 
computer for experiment control using TCP/IP communication. For more 
information, see Chapter 7, “Experiment Control,” in the GES Hardware Technical 
Manual.

Figure 4-41. Multi-Port ECI control panel
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TCP/IP Port Information
The TCP/IP port information indicates which port is open for TCP/IP 
communication between the experiment control device and the DAC. The default 
is port 55513. 

Configure Button
Click the Configure button to open the Multi-Port ECI Configuration window 
(Figure 4-42). In this window, you can change the serial port or TCP/IP port settings.

The Timeout pop-up menu enables the user to specify whether to terminate the 
connection in case of failure of the computer or process interaction. If termination is 
chosen, the Timeout pop-up menu monitors the interactions, and if no activity occurs 
for the set period of time (the options are 30 seconds, 1 minute, 5 minutes, or 
30 minutes), then the connection is terminated.

Figure 4-42. Multi-Port ECI Configuration window

Control panel

Default 
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Log Button
Click the Log button to open the Session Log (Figure 4-43). The Session Log, which is 
also the display panel, allows you to monitor ECI events. For more information, see 
“Multi-Port ECI Display Panel” on page 127. 

Photic Stimulator Control Panel
A photic stimulator flashes a light at a frequency that evokes predictable brain 
activity in a patient during an exam. The device typically consists of a flash unit that 
is triggered either by an external source or by a software program that provides a 
trigger pulse for the recording apparatus. 

The Photic Stimulator control panel allows you to create photic-stimulation protocols 
to control the frequency and the duration of such flashes through the software. 

To open the Photic Stimulator control panel:

• click on the control panel button the Photic Stimulator device or
• choose Panels > Photic Stimulator Controls.

Figure 4-43. Session Log (aka display panel)

Display panel

Control panel
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The control panel (Figure 4-44) consists of controls for setting the number of flashes 
per interval, total duration of flashes, duration of rest interval following flashes, and 
number of times the sequence is run. The panel also displays a flash/rest graph, to 
indicate the ratio of flashes to rest for each interval.

Many users may not need photic stimulation as part of their EEG acquisition sessions. 
Consequently, its features are described in a separate chapter (Chapter 10, "Photic 
Stimulator Interface”).

Spectral Display Control Panel
Spectral Display shows the frequencies present in each window of EEG data and their 
relative strengths, in amplitude or power, for each channel. You can view the spectral 
information as user-definable frequency bands (delta, theta, alpha, and beta are the 
defaults) in Grid, Topo Plot, or Topo Map view. 

The Spectral Scaling window/control panel allows you to control the power and 
frequency ranges of the spectral data shown in the Spectral Display. To open the 
control panel:

• click on the control panels button on the Spectral Display device or
• choose Panels > Spectral Scaling.

Figure 4-44. Photic Stimulator control panel
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The control panel varies in appearance, depending on the view (Figure 4-45). 

The controls for Spectral Display during acquisition and review are the same, and for 
conciseness are discussed in the Net Station Viewer Technical Manual, rather than this 
manual, because Spectral Display is primarily a viewing tool.   

Display Panels for All Relevant Devices

Not every device has a display panel.

Those devices that do contain control panel buttons are:

• Dense Waveform Display
• Digital Video
• Net Amps USB
• Net Amps 300
• Neurotravel USB
• Multi-Port ECI
• Spectral Display 

This section describes each control panel in detail. 

Figure 4-45. Spectral Display control panel for Grid and Topo Plot (left) and Topo Map (right)

Grid and Topo Plot View controls Topo Map View controls
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DWD Display Panel 
To open the Dense Waveform Display display panel (Figure 4-46):

• click the display panel button on the Dense Waveform Display device or
• choose Panels > Dense Waveform Display. 

When the Dense Waveform Display is deployed, the menu bar will present additional 
menus, shown on page 51 and described in “Menus” on page 50.

Because the Dense Waveform Display is such a major part of Net Station, an entire 
chapter is also devoted to it; see Chapter 6.

Digital Video Display Panel
To open the Digital Video display panel (Figure 4-46):

• click the display panel button on the Digital Video device or
• choose Panels > Video. 

Figure 4-46. Example Dense Waveform Display panel
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The Digital Video display window contains controls for setting resolution, 
compression, adjustment, and source.

Many users may not need digital video as part of their EEG acquisition sessions. 
Consequently, its features are described in a separate chapter (see Chapter 9, "Digital 
Video”).

Net Amps USB or 300 Display Panels
Gains, zeros, noise, and impedance diagnostic measurements are made in response to 
user requests. Each type of measurement has a corresponding Net Amps USB or 300 
display panel:

• Gains
• Zeros
• Noise
• Net Noise
• Impedance
• Electrolyte Bridges

Note: The Impedance Display panel is associated with an Impedance Measurement panel 
that displays a sensor layout. The other five display panels have no such associated sensor 
layout panel.

After obtaining one of these diagnostic measurements, Net Station stores the results 
and displays the channel-by-channel values in the display panel. Each of the 
diagnostic panels has the same user-customizable architecture, as described in the 
following sections of this chapter. 

Figure 4-47. Digital Video display panel
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Opening the Display Panels
Not all the Net Amps USB or 300 display panels open up the same way:

• Gains and Zeros: to open both panels open simultaneously, click the display 
panel button on the Net Amps device.

• Gains: to open, choose Panels > Gains.

• Zeros: to open, choose Panels > Zeros.

• Noise: to open, choose Panels > Noise.

• Net Noise: to open, choose Panels > Net Noise.

• Impedance: to open, choose Panels > Impedance.

• Electrolyte Bridges: to open, choose Panels > Electrolyte Bridges.

Each display panel can be iconized to save screen space by choosing Panels > Iconize, 
or via the keyboard shortcut, z-\. Note, however, that palettes have priority to any 
window they float over with respect to the Iconize command. To iconize a display 
panel, it may be necessary to first iconize any palettes, then iconize the display panel. 
You can return the palettes to normal size by double-clicking on their icons.

Organization and Function of Display Panels
Each of the six panels has a similar layout, as shown in Figure 4-48. 

The following are brief descriptions of the numbered items from Figure 4-48. 

1.  Insets area. Presents plots of the current measurement set.

2.  Measure button. In each of the six display panels, clicking this button tells 
Net Station to initiate a new set of measurements, obtaining a new measurement for 
each channel. When you use this button to initiate an impedance measurement or 
electrolyte bridge detection, the Impedance Measurement or Electrolyte Bridges 
window is displayed. 

3.  History area. Displays a list, by date, of all measurement sets. Each element in the 
list constitutes an entry that Net Station has stored in an Amplifier History file. 
Selecting an entry from the list triggers all displays in the panel to update, showing 
the measurements for that History entry.
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4.  Channel list. In this list, the values of a selected measurement set are shown as 
channel number/value pairs, sorted by channel number. Selecting a channel or group 
of channels in the list causes the graphic plots to display that selection.

5.  Display buttons. The left button activates a graphical display of the selected 
measurement, the right button a spreadsheet-style display. When both buttons are 
pushed in, the main area splits to present both the graphical and spreadsheet-style 
displays.

6.  Statistics area. Displays the mean, median, and variance of the selected 
measurement. This area is blank when there are no measurements to select or when 
none are selected.

7.  Main area. Responds to the settings of the display buttons (5).

Figure 4-48. Generic Net Amps display panel
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Gains and Zeros Display Panels
The gains and zeros display panels provide access to measurement sets performed 
during Net Amps calibrations.

You can perform a gains or zeros measurement at any time, but are advised to do so 
without a Geodesic Sensor Net connected to the system. If the Calibrate Amplifier 
checkbox in the Create New Session Template window is selected when a Session 
Template is saved, both measurements will be made automatically whenever a new 
Session is initiated.

For the Gains display panel, the example in Figure 4-49 shows a History area that 
contains two entries, with the lower entry selected. Selecting the top entry would 
cause all the plots in the Gains display panel to update, showing the measurement set 
data for the newly selected History entry. In this example panel, the Insets area 
contains three user-selectable plots. Whichever plot is currently selected will be 
repeated at higher resolution in the main area of the panel.

The Zeros display panel works the same way. 

Figure 4-49. History area and insets of the Gains display panel

History area with 
measurement set selected
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Noise Display Panel
Noise is any component of a signal that does not contain useful information. 
Net Station gives users a view of how amplifier noise is affecting the signals that 
Net Station is acquiring, on a channel-by-channel basis, and allows storing of 
previously acquired noise profiles.

When Net Station conducts a channel-by-channel noise measurement, the Net Amps 
front-panel Hypertronics receptacle is internally disconnected from the Net Amps 
circuitry. This means that the noise being measured does not include components that 
may be picked up by the interface cable or the sensor array.

Noise that is part of an EEG signal has a number of sources. Some noise originates in 
the electronics of the amplifier. Problematic noise originates from the environment in 
which the Net Amps is operating and contaminates the EEG signals by being 
acquired along with the EEG. The Noise display panel provides a window into the 
noise levels and noise characteristics of a given environment.

Note: When the noise test is run from the Noise display panel, the lowpass hardware filter 
cut-off frequency is automatically set to 400 Hz. (The waveforms may display an increase 
in noise in the DWD during the test because of the higher throughput of noise in the 
frequencies that are typically attenuated during data acquisition.) After the test, the filter 
returns to its previous setting.

In a relatively low-noise environment, the Noise display panel would look similar to 
the one shown in Figure 4-50. The plot in the main area of the panel shows 
graphically the microvolt RMS noise values for each channel, and the table view 
shows the same information. Although the amount of noise on each channel is not 
uniform, all microvolt RMS noise values are within the green portion of the chart. As 
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the vertical scale of the chart indicates, this means that all channels have noise values 
below 1.0 µV RMS. The exact noise values are shown in the table next to the plot.  

Clicking the Noise Distribution inset (Figure 4-51) fills the chart display with an 
enlarged view of the Noise Distribution histogram and presents the same information 
in an adjoining table (Figure 4-52). 

Figure 4-50. Noise measurement in a low-noise environment

Figure 4-51. Noise panel insets

Noise Distribution inset
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As you move the cursor over the bars of the histogram, the bar under the cursor 
changes color and the precise noise value it is associated with appears at the top of the 
bar. The Noise vs. Time inset plot operates similarly.

In a noisier environment, the Noise display panel would look more like the one 
shown in Figure 4-53. Taking note of the vertical scaling of the chart, which ranges 
from 0 to 4.0 µV RMS, you see that the channel noise is mostly at levels above the 
amplifier specification of 1.0 µV RMS but still below 4.0 µV RMS. This is indicative of 
noise being picked up from the environment, combined with intrinsic amplifier noise.

Figure 4-52. Noise Distribution histogram
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As the Noise Distribution histogram in Figure 4-53 reveals, the levels of noise 
affecting the channels can display modality. This information can be useful in 
troubleshooting. 

Net Noise Display Panel
The Net Noise feature allows you to measure the amount of noise present in a 
Geodesic Sensor Net, highlighting individual electrodes that may require 
replacement. The feature works the same way as the amplifier noise measurement, 
except that the inputs to the amplifier are not grounded, which allows signals on the 
Geodesic Sensor Net to pass through to Net Station. 

It is unnecessary to perform a Net Noise test regularly. It is a diagnostic tool to use if 
the following circumstances arise:

• Your lab log indicates that specific electrodes may be “noisy.”

• During analysis, you notice an electrode that is “bad” when the Geodesic 
Sensor Net is used with different subjects.

• You suspect the ambient noise in the room is high.

Figure 4-53. Noise panel in a noisier environment
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To perform the Net Noise test:

1 Prepare a container of fresh electrolyte (see the instructions given in “Preparing 
the Electrolyte Formulation” in Chapter 6 of the Geodesic Sensor Net Technical 
Manual), but omit any shampoo. 

2 Soak the Geodesic Sensor Net, which is connected to the amplifier, in the 
electrolyte solution for five minutes to saturate the sponges thoroughly; after 
2.5 minutes, push the Net below the surface with your hand to ensure that the 
sponges are sufficiently hydrated.

Caution!: The total submersion time for the Geodesic Sensor Net—including 
soaking time and test time—should not exceed 15 minutes. Prolonged exposure to 
a saline-based solution may weaken the Net’s elastomer. 

3 With the sponges still submerged, plug the Geodesic Sensor Net’s Hypertronics 
connector into the articulated arm (which is connected to the amplifier). (If you 
are using a 128-channel system, you could alternately plug the connector 
directly into the Net Amps unit.)

4 Start Net Station, click the Session button in the New section of the start-up 
window, choose a Session Template, and click the Begin Session button to 
initiate acquisition. 

5 As the signals are displayed onscreen, choose Panels > Net Noise, and click the 
Measure Net Noise button in the Net Noise window (Figure 4-54); a progress 
bar appears during the measurement.

Figure 4-54. Net Noise window

Click to measure the 
noise in a Geodesic 
Sensor Net.
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6 When the measurement is complete, the results are graphed in the Net Noise 
window (Figure 4-55).

View the results, and adjust as needed:

° All values within the green area: no bad electrodes.

° Some values outside the green area: check that the corresponding electrodes are 
submerged and hydrated; if they are not, return to Step 2.

° Spikes: bad electrodes; if using a GSN 200, replace the electrodes following the 
instructions given in Chapter 9 in the Geodesic Sensor Net Technical Manual. If 
using a HCGSN, contact support@egi.com.

° Many or all values outside the green area, but no major spikes: check the 
equipment around the amplifier and the Geodesic Sensor Net; they may be 
producing environmental noise. (Also check equipment on neighboring 
floors.)

7 After conducting the test, rinse the Geodesic Sensor Net, following the 
instructions given in “Rinsing” in Chapter 7 of the Geodesic Sensor Net 
Technical Manual. 

Figure 4-55. Net Noise results

The green areas 
indicate regions 
with acceptable 
noise levels.
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Impedance Display Panel
Under Net Station supervision, the Net Amps 200 and 300 drive certain sensors with a 
precision 20 Hz, 400 µV peak-to-peak sine wave signal. This level of voltage is above 
the level of EEG but still results in extremely small current flows across the scalp.

Net Station measures the voltage at an undriven, passive sensor and calculates the 
contact impedance. 

Sensor impedance measurement sets are displayed and graphed in the Impedance 
display panel. You can initiate a new impedance measurement by:

• clicking the Measure Impedances button in the Impedance display panel (see 
example panel shown in Figure 4-56) or

• clicking the Measure Net Impedances button in the Net Amps controls panel 
(see Figure 4-19 on page 86).

Initiating a new impedance measurement opens the Impedance Measurement 
window, described in detail in the next section. 

Figure 4-56. Example Impedance display panel
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Impedance Measurement Window

When the Impedance Measurement window (Figure 4-57) opens, Net Station initiates 
a measurement of the contact impedance of each sensor. After performing a complete 
set of measurements, Net Station updates the impedance values displayed in a list on 
the right side of the window. The process repeats until the window is closed.

The Impedance Measurement window’s layout matches the sensor array being used. 
In the display, sensors that have measured impedance values exceeding the Threshold 
setting are colored red, and sensors at or below the Threshold setting are colored green 
(see the next paragraph, “Impedance Measurement Window Controls”). 

Impedance Measurement Window Controls

The All, Over, and Under buttons (Figure 4-58) and the user-editable Threshold text 
box work in the following way:

• All: the list of impedance values displayed includes all the sensors of the Net.

• Over: the only sensor impedances displayed are those that exceed the 
Threshold.

• Under: only those values under the Threshold are listed.  

Figure 4-57. Example Impedance Measurement window

Progress bar
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EGI’s standard recommendation for scalp impedances is 50 KΩ. 

Next to the Threshold box is a checkbox that controls the speed and method of the 
impedance measurement. With the checkbox unselected, Net Station measures 
impedances one at a time. This method is most precise, but very slow. With the 
checkbox selected, Net Station measures impedances for several channels at once, 
speeding up the measurement process but sacrificing accuracy by reporting 
impedances slightly (10–15%) too high.

The pair of orientation buttons (Figure 4-58) changes the orientation of the sensor 
layout. 

The Show Labels checkbox hides or displays channel names.

To halt the impedance measurement process, use either the Close or Save & Close 
buttons (Figure 4-58). Save & Close appends the most recent complete scan to the 
impedance measurement sets in the History area of the Impedance Display panel (see 
page 117).

Note: Impedance values are not saved to the file unless data are recorded after measuring 
impedances. Merely clicking the Save & Close button will not save the impedance values.

Electrolyte Bridge Display Panel
The electrolyte bridge detection feature is specific to the Net Amps USB and 300 
devices. It detects salt bridges between neighboring electrodes, and indicates their 
positions with thick red lines in a sensor layout display. 

Figure 4-58. All, Over, and Under buttons

Figure 4-59. Orientation buttons

Orientation buttons
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Background

Bridges can be caused by one of two factors: (1) electrodes physically touching each 
other or (2) electrodes not making contact with the scalp but sitting on a mat of hair, 
thus allowing a continuous bridge to exist between them. 

Net Station’s electrolyte bridge detection algorithm knows all the pairs of neighboring 
electrodes for all the Net models. The detection feature scans the sensor array for 
10 seconds, measures the A/D value for each electrode, and subtracts the A/D values 
of each electrode pair to yield a difference wave for that 10-second interval.

To compute the variance of the difference wave and produce a single value, the 
detection feature then applies the following formula:

S2 = Σ (X1 – X)2 / n – 1

where S2 is the sample variance squared, X1 is the score for the first point in the 
sample, X is the sample mean, and n –1 is the sample size. 

If a bridge exists between two neighboring electrodes, the signal will be very similar 
and the difference of the signal will exhibit little variance. You define the threshold 
level in the interface, and the software indicates pairs exceeding that level with red 
lines (Figure 4-60).

Figure 4-60. Four bridged electrode pairs
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Interface

The electrolyte bridge detection and the impedance measurement features are similar 
in that both scan the electrodes in the sensor array continuously, allowing you to 
adjust the electrodes by hand and view the effect in Net Station.

For consistency, the window for detecting electrolyte bridges resembles that for 
impedance measurement, even though not all the features are used. The main feature 
is the Detect Bridge button. 

Unlike the Impedance Measurement window, however, electrolyte bridge detection 
does not save graphs or values to the Session file.

Instructions

To detect bridges:

1 Before recording EEG data, choose Panels > Electrolyte Bridges to open a 
window that allows initiation of the bridge-detection algorithm. 

Note: The window resembles the impedance measurement window for consistency; 
however, the panes remain empty because the sample values from the bridge-detection 
algorithm cannot be graphed in this manner.

2 In the Electrolyte Bridges window (Figure 4-61), click the Detect Bridges 
button.
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3 A sensor layout window opens, similar to the window used to measure 
impedances (see “Impedance Measurement Window” on page 121 for a 
detailed description).

4 Set the threshold and other values as desired, and allow the software to scan 
the electrodes; bridges will be indicated by thick red lines connecting the 
bridged sensors (Figure 4-62).

Note: We recommend a threshold of 4 µV2 for adults. However, it is a good idea to 
experiment with this number yourself.

Figure 4-61. Electrolyte Bridges window

Click to begin 
detecting bridges.
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5 Adjust the sensors, and allow the software to scan and update the layout.

6 Continue adjusting the sensors, as needed; when satisfied, close the window.

Neurotravel USB Display Panel
The Neurotravel USB display panel is similar to the Net Amps USB display panel in 
that it makes impedance diagnostic measurements in response to user requests (it 
does not, however measure gains, zeros, or noise). 

To open the Neurotravel USB display panel:

• click the display panel button on the Neurotravel USB device or
• choose Panels > Impedance History.

After obtaining this diagnostic measurement, Net Station stores the results and 
displays the channel-by-channel values in the display panel. 

Figure 4-62. Electrolyte bridge results, with a bridge indicated between electrodes 94 and 87
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Impedance Display Panel
The Impedance display panel shows and graphs impedance measurement sets 
(Figure 4-63). This window is nearly identical to the Impedance window for the 
Net Amps USB device; for more details, see page 120. 

You can initiate a new impedance measurement from this display panel by clicking 
the Measure Impedance button (see example panel shown in Figure 4-63). 

Initiating a new impedance measurement opens the Impedance Measurement 
window. This window is nearly identical to the Impedance Measurement window for 
the Net Amps USB device; for more details, page 121.

Multi-Port ECI Display Panel
When the Multi-Port ECI device is part of a Workbench configuration, saved 
Acquisition Setup, or Session Template, the Multi-Port ECI display panel (also known 
as the Session Log) is available for viewing ECI events. 

Figure 4-63. Example Impedance display panel
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To open the Multi-Port ECI display panel (Figure 4-64):

• click the display panel button on the Multi-Port ECI device,
• choose Panels > Log: TCP/IP Port <number> (55513 is the default), or
• click the Log button in the control panel.

For an example Acquisition Setup containing a Multi-Port ECI device, see "Default 
Experimental Control Setups" on page 137.

You can monitor ECI events using both the ECI track in the Dense Waveform Display 
and the Session Log at the same time, but the Session Log offers more detail, as the 
example in Figure 4-64 indicates. However, when many events are occurring during 
short durations of time, the Session Log may not display all the information with 
enough time for you to completely read it. The Session Log attempts to keep up with 
the events in real time. 

For configuration details, see Chapter 7, “Experiment Control,” in the GES Hardware 
Technical Manual. 

Figure 4-64. Opening the display panel (aka Session Log)

Display panelYou can display the Session Log by:
• clicking the display button on the device
• clicking the Log button in the control panel
• choosing Panels > Log: TCP/IP Port 55513
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Spectral Display Panel
To display near-real-time spectral information during acquisition, Net Station 
performs an FFT on successive data windows of an EEG file, with the length of the 
data window specified by the user. This section briefly covers the display panel and 
the controls for specifying the data-window size. 

To open the Spectral Display display panel:

• click the display panel button on the Spectral Display device or
• choose Panels > Spectral Display.

The Spectral Display display panel presents the spectral data in Grid, Topo Plot, or 
Topo Map views (Figure 4-65). During acquisition or review, the display updates as 
FFTs are performed on different data windows. 

Figure 4-65. Spectral Display of 128-channel data in Grid, Topo Plot, and Topo Map views

Grid view Topo Plot view

Topo Map view

Delta
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Theta
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The display controls for Spectral Display during acquisition and review are nearly 
identical, and for conciseness are discussed in the Net Station Viewer Technical 
Manual, rather than this manual, because Spectral Display is primarily a viewing tool. 

The only difference in controls is in the “FFT” section of the Spectral Viewer Options 
window. During acquisition, the FFT process is automatic: an FFT is performed on 
successive data windows as EEG data are being acquired. During review, the FFT 
process requires user intervention: an FFT is performed on user-selected windows of 
the recorded data. 

To open the Spectral Viewer Options window, choose View > Options when a 
spectral display window is foremost.

Figure 4-66 shows the Spectral Viewer Options window for acquisition. 

The following is a brief description of the numbered item from Figure 4-66. The other 
items are described in the Net Station Viewer Technical Manual.

1.  Window Size text box. Enables you to type in a value for the length of the data 
window on which to perform an FFT. The size range is from 10 to 60,000 milliseconds 
(1 minute). 

Figure 4-66. Spectral Viewer Options window for acquisition

1
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CHAPTER 5WORKBENCH: 
ACQUISITION SETUPS

n Acquisition Setup is a means for saving a particular Workbench configuration 
along with its device control and display panel settings (see “Acquisition 

Setups” on page 44). 

You can use any of the nine default Acquisition Setups provided by Net Station, or 
you can create your own Acquisition Setups (see page 138) for data acquisition using 
the Workbench and for embedding Session Templates.

The default setups are called: 

• Simple Net Amps 200 Acq Setup 
• Simple Net Amps 300 Acq Setup 
• Typical Net Amps 200 Acq Setup 
• Typical Net Amps 300 Acq Setup 
• Exp. Control Net Amps 200 Setup 
• Exp. Control Net Amps 300 Setup 
• Clinical Net Amps 200 Acq Setup 
• Clinical Net Amps 300 Acq Setup 
• Clinical Neurotravel Acq Setup 

Their purpose is to ensure consistent Workbench configurations in Session Templates. 
To that end, they differ from user-created Acquisition Setups in several ways:

• You cannot use the default setups to acquire data themselves via the 
Workbench; you use them to create Session Templates (page 144), which then 
acquire the data. The names of the default setups are displayed in the Select 
Session Template window (see Figure 7-8 on page 165) and in the Create New 
Session Template window (see Figure 7-4 on page 161). 

• You cannot double-click on the default setups to open them; they are not 
editable.

• You cannot view the default setups’ Workbench configurations.

A
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To facilitate your understanding of Net Station, this chapter describes the default 
Acquisition Setups, their Workbench configurations, and panel deployment schemes. 
It also discusses how to create and save your own Acquisition Setups using the 
Workbench. 

Default Acquisition Setups

Default Simple Acquisition Setups

Simple Workbench Configuration
The Simple Net Amps 200 Acq Setup uses a Workbench configuration consisting of 
the Net Amps USB, Dense Waveform Display, and Waveform Recorder connected in 
series as shown in Figure 5-1. 

The Workbench configuration of the Simple Net Amps 300 Acq Setup is identical, 
except the Net Amps 300 device is used in place of the Net Amps USB. 

For details about these devices, see “Core Devices” on page 61. 

In this setup, the EEG cables pass through the Display and are connected to the 
Recorder. Recorder and Display could be transposed with no change in the way the 
EEG data are recorded; however, this transposition would mean that user markups 
made in the Display device would not propagate to the recording because the Display 
would be downstream of the Recorder device. 

Note: If user mark-up events are going to be part of a recording, always be sure that in the 
Workbench configuration there is a MARK cable connecting the output of the Display 
device to the input of the Recorder device.   

Figure 5-1. Workbench configuration of the Simple Net Amps 200 Acq Setup
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Simple Panel Deployment
Whenever you create an Acquisition Setup, which panels are open and their positions 
in the Net Station window are preserved with the file. 

For example, during the design of Net Station when the Simple Net Amps 200 Acq 
Setup was saved, the Net Amps and Waveform Recorder panels were open but the 
Dense Waveform Display was not deployed. Consequently, when the setup is opened, 
the position of the panels is preserved, but the Display does not appear automatically 
(Figure 5-2). You can select it from the Panels menu or via the display button on its 
corresponding Workbench device. 

When the Simple Net Amps 300 Acq Setup was saved, the Net Amps panel (note: the 
Net Amps 300 contains no Advanced Net Amps panel), Waveform Recorder panel, 
and Dense Waveform Display were deployed. The Net Amps and Waveform Recorder 
control panels were moved to the right, to allow the waveforms in the Dense 
Waveform Display to be observed (Figure 5-3). 

Figure 5-2. Panel deployment of the Simple Net Amps 200 Acq Setup
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Default Typical Acquisition Setups

Typical Workbench Configuration
In the Typical Net Amps 200 Acq Setup and Typical Net Amps 300 Acq Setup, a 
Digital Filter and a Montage Editor have been included in the Workbench 
configuration. EEG data are connected both directly to the Waveform Recorder and to 
the Digital Filter.

Figure 5-4 shows the Workbench configuration of the Typical Net Amps 200 Acq 
Setup. The Workbench configuration of the Typical Net Amps 300 Acq Setup is 
identical, except the Net Amps 300 device is used in place of the Net Amps USB. 

Figure 5-3. Panel deployment of the Simple Net Amps 300 Acq Setup

Waveform display area 
of Dense Waveform 
Display (see Chapter 6 
for details)
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This arrangement ensures that the data that enter the Recorder will not be modified 
by digital filtering, yet filtered data can be visualized using the Dense Waveform 
Display. 

Typical Panel Deployment
During the design of Net Station when the Typical Net Amps 200 Acq Setup
(Figure 5-5) was saved, its control panels were moved to the right side of the window, 
to allow the waveforms in the Dense Waveform Display to be observed. The Montage 
Editor control panel was minimized and moved to the Dock; it can be accessed by 
clicking its icon or by choosing it from the Panels menu. 

Figure 5-4. Workbench configuration of the Typical Net Amps 200 Acq Setup

Data flowing into the 
Recorder have not 
been digitally filtered. 

Digitally filtered data
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When the Typical Net Amps 300 Acq Setup was saved, none of its panels was 
minimized or moved to the right of the Dense Waveform Display (Figure 5-6).

Figure 5-5. Panel deployment of the Typical Net Amps 200 Acq Setup

Figure 5-6. Panel deployment of the Typical Net Amps 300 Acq Setup

Waveform display area 
of Dense Waveform 
Display (see Chapter 6 
for details)

Minimized Montage Editor
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Default Experimental Control Setups

Experimental Workbench Configuration
The default Exp. Control Net Amps 200 Setup (Figure 5-7) is identical to the Typical 
Net Amps 200 Setup, save for the addition of the Multi-Port ECI device and its 
connection via the STIM cable. The Workbench configuration of the Exp. Control Net 
Amps 300 Setup is identical, except the Net Amps 300 device is used in place of the 
Net Amps USB. 

Experimental Panel Deployment
The panel deployment scheme for the Exp. Control Net Amps 200 Setup is the same as 
that of the Typical Net Amps 200 Setup, except for the inclusion of Experimental 
Control Status and Montage Editor windows (Figure 5-8).

Figure 5-7. Workbench configuration of the Exp. Control Net Amps 200 Setup
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The panel deployment scheme for the Exp. Control Net Amps 300 Setup is identical 
to that of the Exp. Control Net Amps 200 Setup, except it contains no Advanced 
Net Amps panel.

Default Clinical Net Amps Setups

Clinical Net Amps Workbench Configuration
The default Clinical Net Amps 200 Setup uses the same components as those in the 
Typical Net Amps 200 Acq Setup, but connects them slightly differently. In this setup, 
the Montage Editor comes before the Digital Filter, and the PAT and STIM cables 
connect directly from the Net Amps USB to both the Waveform Recorder and the 
Dense Waveform Display (Figure 5-9). The Workbench configuration of the Clinical 
Net Amps 300 Setup is identical, except the Net Amps 300 device is used in place of 
the Net Amps USB. 

Figure 5-8. Panel deployment of the Exp. Control Net Amps 200 Setup
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Clinical Net Amps Panel Deployment
When the Clinical Net Amps 200 Setup (Figure 5-10) was saved, its control panels 
were moved to the right side of the window, for unobstructed viewing of the 
waveforms in the Dense Waveform Display. The panel deployment scheme for the 
Clinical Net Amps 300 Setup is identical.  

Figure 5-9. Workbench configuration of the Clinical Net Amps 200Setup

Figure 5-10. Panel deployment of the Clinical Net Amps 200 Setup

Waveform display area 
of Dense Waveform 
Display (see Chapter 6 
for details)
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Default Clinical Neurotravel Setup

Clinical Neurotravel Workbench Configuration
The default Clinical Neurotravel Acq Setup is identical to the default Clinical Net 
Amps 200 Setup, except it replaces the Net Amps USB device with the Neurotravel 
USB device and contains no STIM connections (Figure 5-11). 

Clinical Neurotravel Panel Deployment
When the Clinical Neurotravel Acq Setup (Figure 5-5) is deployed, its control panels 
are to the right side of the window, for a clear view of the Dense Waveform Display. 

Figure 5-11. Workbench configuration of the Clinical Neurotravel Acq Setup

Figure 5-12. Panel deployment of the Typical Clinical Neurotravel Setup

Waveform display area 
of Dense Waveform 
Display (see Chapter 6 
for details)
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Creating New Acquisition Setups

You can create your own Acquisition Setup files by opening the Workbench, 
configuring devices, making panel settings, and then saving their creation to disk. 
The editable files that result from this process are saved by Net Station to the 
Acquisition Setups folder by default (see “Acquisition Setups Folder” on page 39). 
The destination folder can be overridden in the Save dialog—clicking the Navigate 
button (Figure 5-13) provides a file navigation window. 

Constructing an Acquisition Setup involves placing and connecting devices on the 
Workbench (see “Placing and Connecting Devices” on page 66), deciding which 
panels to deploy, then saving the setup as an Acquisition Setup file (see “File” on 
page 51).

Configuration Examples
The examples in this section demonstrate features of Workbench configurations that 
you should be aware of if you choose to design your own Acquisition Setups. 

Bypassing the Display
Figure 5-14 shows a Workbench configuration that is identical to the default Simple 
Net Amps 200 Acq Setup, but in which the STIM cable has been reconfigured to 
bypass the Display device. There is no particular reason to do this except to illustrate a 
point: In this setup, any digital input events captured by the Net Amps USB device 
will be recorded by the Waveform Recorder, but will not be displayed in the Dense 
Waveform Display. In this situation, the digital input tracks in the Display would 
remain blank even though the events would be written to the data file. 

Figure 5-13. Default Save dialog for saving Acquisition Setups

Navigate 
button
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Note: PAT and STIM connections have been omitted from the following dual Display 
configurations for the purpose of illustration. 

Correctly Connecting the Filter
The next example configuration demonstrates one way to properly connect the 
Digital Filter device. As discussed in “Digital Filter Controls” on page 74, the IIR filter 
of the real-time Digital Filter device is not appropriate for transforming data, only for 
visualizing it. It follows that it is not correct to connect a Digital Filter ahead of the 
Recorder device. In the configuration of Figure 5-15, the Filter device is not connected 
in series with the Recorder.

Also demonstrated in Figure 5-15 is the way that more than one Display device can 
occupy the same configuration. Clicking the display buttons on both devices results 
in two Dense Waveform Displays opening, one for each device. Users can resize and 
position the two display windows next to each other onscreen, then manipulate the 
Digital Filter controls. In so doing, the effect of the IIR filter will be immediately 
observed in DWD[1] and can be compared with the unfiltered data viewable in 
DWD[2].

Figure 5-14. Recording but not displaying digital inputs

Figure 5-15. Correct connection of filter device, no events
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Incorrectly Connecting the MARK Cable
It might be imagined that user mark events could be implemented in this 
configuration by connecting the MARK jack on the output side of DWD[2] to the 
MARK jack on the input side of the Recorder (Figure 5-16), but this is an invalid 
configuration. 

It is invalid because it contains a cable loop. The same device cannot both receive 
input from a device and send output to the same device, which is exactly what the 
DWD[2] device is doing. It is receiving input from the Recorder device and also 
attempting to send mark events to the same Recorder device.

Correctly Connecting the MARK Cable
A different way to bring user mark events into the recording is implemented with the 
configuration shown in Figure 5-17. It does not violate the looping rule and it works.  

Figure 5-16. Example of a cable loop (invalid configuration)

Figure 5-17. A correct dual-DWD configuration with mark events
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A simpler way to implement this functionality is shown in Figure 5-18, where the 
positions of DWD[2] and the Recorder have been transposed. 

Session Templates Use Acquisition Setups
As shown in Figure 7-3 on page 160, Acquisition Setups are embedded in Session 
Templates. In particular, the default setups are always available for embedding in a 
new Session Template. User-created setups will also be available, so long as they are 
saved to the appropriate location and contain the required devices.

Note: Workbench configurations that do not contain a Source device, or lack either the 
Dense Waveform Display device or Waveform Recorder device can be saved in 
Acquisition Setup files, just like any other configuration. However, Net Station will not 
display such files in the Create New Session Template window. Such setups cannot be 
embedded in a Session Template because Net Station regards them as fundamentally 
incomplete.

Because creating a Session Template does not involve the Workbench, it is not covered 
in this chapter. Instead, Chapter 7 describes Session Templates and how Acquisition 
Setups are a part of every Session Template (see page 159 for an example of how to 
embed an Acquisition Setup in a Session Template, and page 161 for how to create a 
Session Template and how to use it to acquire data).

Final Note
Remember that with an Acquisition Setup, screen locations of the control and display 
panels and their minimized states in the Dock are remembered by Net Station. A 
reopened Acquisition Setup file will contain devices and device panels in the state 
they were in when the file was closed.

Figure 5-18. Reconfiguring for a simpler configuration
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CHAPTER 6DENSE WAVEFORM 
DISPLAY

he Dense Waveform Display (Figure 6-1) provides a way to view real-time EEG 
waveforms and events. In addition, the Dense Waveform Display is an input 

interface for technician mark-up events that can be entered and recorded along with 
the EEG. 

Main Components

See Figure 6-2 for the structure of the Dense Waveform Display. See the sections 
following the figure and its numbered list for a part-by-part treatment of Dense 
Waveform Display functionality.

Figure 6-1. Invoking the Dense Waveform Display

T

When using the Workbench, click the Display button on 
the Dense Waveform Display device to make the Dense 
Waveform Display appear.

When conducting a session, choose the Dense Waveform 
Display from the Panels menu.
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The following are labels for the numbered items in Figure 6-2.

1.  Upper control strip
2.  Scale control strip
3.  Time control strip
4.  Events control strip
5.  Tracks area
6.  Waveform Options control strip
7.  Sweep line
8.  Channel tiles
9.  Pause button
10.  Reset button
11.  Scroll bar 
12.  Size box (resize the Dense Waveform Display by dragging)

Menus and Acquisition Status Panel 
When the Dense Waveform Display is frontmost, menus that are specific to its 
functions are available in Net Station’s menu bar. For coverage of these Dense 
Waveform Display–specific menus, see “Dense Waveform Display Menu Bar” on 
page 85.

Figure 6-2. Example Dense Waveform Display
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The Dense Waveform Display also includes pop-up 
menus (Figure 6-3). This type of menu occurs on the 
Scale control strip (see page 149). To open a pop-up 
menu, position the cursor over it and press the 
mouse button.

The Acquisition status panel is always present just below the main menus (see 
page 169 for coverage of the Acquisition status panel when using a Session Template; 
see page 39 for the Acquisition status panel when doing Workbench recording).

Upper Control Strip 

The upper control strip contains two groups of buttons: Scale, Time, and Events (left 
side of strip); and Pause and Reset (right side).

Scale, Time, and Events Buttons
Various functional areas of the Dense Waveform Display can be either hidden or 
displayed using the Scale, Time, and Events buttons (Figure 6-4) on the left side of the 
upper control strip. Toggling these buttons has no effect on the settings of their 
corresponding functional areas, only on visibility.

Figure 6-2 shows the Scale control strip, Time control strip, Events control strip, and 
Tracks area in their visible states. The corresponding buttons on the upper control 
strip have a “pushed-in” appearance to indicate that visibility is set for all of them.

Note: The Events button toggles the visibility of both the Events control strip and the 
Tracks area.

Figure 6-4. Scale, Time, and Events buttons

Figure 6-3. Pop-up menus
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Pause and Reset Buttons
On the right side of the upper control strip are the Pause and Reset buttons. 

Toggle the Pause button to halt the sweep line (page 153)—momentarily freezing the 
scene in the waveform area—or to restart the sweep line from a paused state. The 
Pause button works with recording on or off. Elapsing time on the Acquisition status 
panel continues to update during a pause.

The Pause button does not halt recording or prevent the 
entry of technician mark events; it only freezes the real-time 
display of waveforms.

After you resume the display of waveforms, a pause line 
(Figure 6-6) will be visible in the Dense Waveform Display in 
the position where the pause took place. It indicates a 
discontinuity in the displayed data.

Technician mark-up events can be entered during the paused state and will become a 
part of the data file if recording is on. Such events will not be placed in the recording 
at the point of the pause, but rather at the time in the recording when you clicked the 
mark event button. 

Note: Mark-up events entered during a pause do not show up in the marks track during 
real-time display. However, they are entered in the recording. Also, the size box and scroll 
bar cannot be used during a pause without erasing the waveform area. Data and events 
being recorded are not affected, and normal sweeping is restored when the Pause button is 
toggled off.

Click the Reset button to cause the sweep line to relocate to the leftmost part of the 
waveform display area and recommence sweeping from that position.

Buttons affect only the display window to which they belong. To reset all multiple 
Dense Waveform Display sweep lines in a single operation, choose Display > 
Reset All (see page 92).

Figure 6-5. Pause and Reset buttons

Figure 6-6. Pause line
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Scale Control Strip 

The Scale control strip (Figure 6-7) contains controls for customizing the way 
that waveforms appear in the Dense Waveform Display waveform area. (The
controls provided by the Scale control strip are also available via menus [see “Time” 
on page 92 and “Amplitude” on page 93].)

To display the Scale control strip, click the Scale button on the upper control strip. 

The following are brief descriptions of the numbered items from Figure 6-7.

1.  Time Scale 1:1 button. Sets the waveform display to 1 sample per pixel on the 
horizontal (X) axis of the screen. 

2.  Time Scale Decrease/Increase buttons. Change the time scale (left button decreases, 
right button increases) incrementally.

3.  Time Scale pop-up menus. Set the value and units for the horizontal axis.

4.  Amplitude Scale 1:1 button. Sets the waveform display to 1 µV/pixel on the 
vertical (Y) axis of the screen.

5.  Amplitude Scale Decrease/Increase buttons. Resize the waveform amplitudes (left 
button decreases, right button increases) incrementally. 

6.  Amplitude Scale pop-up menus. Set the value and units for the vertical axis.

7.   Polarity buttons. Toggle between displaying the waveforms with positive up or 
positive down. Data being recorded are unaffected.

Whatever settings are in effect apply to all waveforms of the Dense Waveform 
Display.

Figure 6-7. Scale control strip

2 4 5 73 61
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Time Control Strip 

The Time control strip (Figure 6-8) features a time-mode button that opens the 
Time Display Options panel. Setting the time display options is covered in “Time” on 
page 92, which includes a picture (Figure 3-65) of the Time Display Options panel.

The Time Menu Display Options command from the Time menu duplicates the 
functionality of the time-mode button.

Elapsed time (in one of four time modes; see Table 3-4 on page 58) is displayed in the 
box to the right of the time-mode button. 

Time Ruler
The sweep line (Figure 6-2, label 7) passes through the time ruler portion of the Time 
control strip in synch with its passage through the waveform area, indicating the time 
of the current sample.

Events Control Strip 

The left side of the Events control strip (Figure 6-9) features three toggle buttons for 
hiding or displaying their corresponding tracks: Marks, Calibration, and DIN/ECI 
(see “Tracks Area” on page 151). 

Figure 6-8. Time control strip

Figure 6-9. Events control strip

Time rulerElapsed timeThe time-mode button 
opens the Time Display 
Options panel

Marks
Calibration

DIN/ECI
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The rest of this control strip contains a series of buttons for adding user mark-up 
events to a recording. Clicking a button causes a corresponding user mark-up event to 
be added to the file at that point in the recording. The mark-up event is displayed in 
the Tracks area in the form of a flag bearing the name of the mark-up event. 

Note: The default Acquisition Setups use Workbench configurations that are designed to 
capture user mark-up events to the recording and to the Dense Waveform Display, but it 
is possible to construct Workbench configurations where mark-up events will not be 
recorded or not displayed, or both. Refer to the examples in “Default Acquisition Setups” 
on page 95.

Tracks Area 

The sweep line passes through the Tracks area (Figure 6-10) in synch with its passage 
through the waveform area and time ruler. Each track is labeled according to the type 
of event it can store and display. For example, if you are using a Session Template that 
automatically performs calibration, you will see calibration events registering in the 
Calibration track when the session begins. 

By using the Digital Inputs Controls panel (see page 63), you can specify up to eight 
DIN tracks and customize the DIN track labels. The Net Station default is to have all 
DIN events record to the track labeled DIN1 (Figure 6-10). A DIN event registering in 
the track has the form of a miniature flag( ).

ECI events display in the ECI track when experimental control is being used. When 
you click a button in the Events control strip, a new mark event appears in the form of 
a flag in the Marks track, and a corresponding event appears in the recording. For an 
example, see the rightmost portion of the Tracks area in Figure 6-2, where a 
“Comment” flag is visible in the Marks track. In this instance, the user clicked the 
“comm” button to produce the Comment event.

Figure 6-10. Tracks area with Events control strip
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The button labels are abbreviations for various phenomena that you will encounter 
while recording EEG. The abbreviations are decoded in Table 6-1. 

The Events menu duplicates the functionality of the buttons and adds a special Insert 
Comment command that deploys a Comment text window. You can type a comment 
into this window; when you click the Insert button in the window, a Comment event 
will be registered into the Marks track at the then-current position of the sweep line.

Note: Net Station registers and records events in real time with millisecond accuracy, and 
their placement in the tracks vis-a-vis the time ruler is precise. But the moment the event 
flag appears in a track of the Dense Waveform Display may not always precisely match 
the moment the event was generated in real time. This imprecision applies only to the 
real-time display of the event flags, not to the recording of the events and their position 
with respect to the time ruler in the Dense Waveform Display.

Waveform Options Control Strip 

The Waveform Options control strip is always deployed (Figure 6-11).

Table 6-1. Mark-up events 

Button label Mark-up event type

eyeb eye-blink artifact

eyem eye-movement artifact

badc bad channel

bads bad segment

comm comment

moto motion artifact

emg electromuscular artifact

noise noise artifact

Figure 6-11. Waveform Options control strip

Channel Resize 
buttons

Channel Visibility label

Grid toggle button
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This control strip carries buttons for changing channel spacing and toggling the 
waveform area grid on and off. You can also change the channel spacing by dragging 
the boundary of a channel tile (see page 154).

Note: The rightmost of the three Channel Resize buttons will not be available if the 
channels in the current montage are so numerous that all of them cannot fit in the 
window. 

The “eye” icon is the Channel Visibility label indicating the column of visibility 
buttons on the channel tiles (see page 154).

Also displayed in the Waveform Options control strip are:

• the current hardware filters in effect, with their cut-off frequencies
• the name of the current montage

Note: If an ellipsis (...) appears in the filter or montage notifications, it means that there is 
not enough room to display a complete notification. Moving the cursor over the 
notification causes the complete text to be momentarily displayed. 

Sweep Line 

The red line moving from left to right in the waveform area of the Dense Waveform 
Display window is the sweep line. It traverses the time ruler (page 150) and Tracks 
area (page 151) in synch with its traversal of the waveform area, and it indicates the 
current time, event, and sample.

Sweep Line Interruption
Under some circumstances, the sweep line pauses momentarily while data are being 
written to disk, then resumes sweeping. This interruption in sweeping is not a cause 
for concern.
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Channel Tiles 

The channel tiles are always visible on the left side of the Dense Waveform Display. 
Each channel tile is labeled with a channel name and carries a signal originating from 
one of the sensors of the Geodesic Sensor Net. Different sensor layouts have different 
numbering/naming schemes and Nets are available with differing densities, so the 
tile labels may differ from the example (Figure 6-12). 

Clicking the Visibility button on a channel tile toggles between hiding and displaying 
the waveform of that channel.

Clicking a channel tile outside the Channel Visibility button causes the waveform of 
that channel to be displayed in red. Use this to differentiate overlapping waveforms. 
Toggle a selected channel tile to return the waveform to its default color. Multiple 
channel tiles can be toggled to display their waveforms in red.

Resizing Channel Tiles
You can resize channel tiles to their minimum and maximum heights by using the 
Channel Resize buttons (see “Waveform Options Control Strip” on page 152). You can 
set channel tiles to heights intermediate between maximum and minimum by 
dragging. Bring the cursor over the boundary of any of the channel tiles and the 
cursor changes into the resize cursor. Dragging the resized cursor causes all the 
channel tiles to resize. 

Figure 6-12. Numbered channel tile label example

Visibility button
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Size Box

Use the window size box to change, by dragging, the size of the entire Dense 
Waveform Display window.

Waveform Area

EEG waveforms are displayed in the waveform area. Use the controls on the Scale 
control strip (page 149) to customize how the waveforms are displayed. Use the scroll 
bar on the right side of the Dense Waveform Display to browse the waveform area 
when the window is so small, or the channel spacing so large, that not all the channels 
will fit in the window. 
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CHAPTER 7SESSIONS AND 
SESSION TEMPLATES

his chapter describes sessions and Session Templates, and explains their connection 
to one another.

Net Station Session 

A Net Station session is an EEG data-acquisition procedure that requires the use of a 
Session Template. The result of such a session is a Session file containing a recording 
of dense-array EEG along with (optionally) user mark-up events and external digital 
input events that occurred simultaneously with the EEG. In addition, the Session file 
can store along with the EEG and events a wide range of metadata such as subject 
name and subject traits.

Session Templates contain embedded Acquisition Setups and may also contain 
editable metadata fields. Depending on how the Session Template was configured, a 
session can include automatic amplifier calibration and impedance measurements, 
and automated naming of the output Session file. The idea is to make the EEG data 
acquisition process as streamlined, repeatable, and automatic as possible. 

Net Station comes with a number of default Session Templates based on the default 
Acquisition Setups described in “Default Acquisition Setups” on page 95.

Once created, a Session Template cannot be edited. You can conduct repeated data-
acquisition sessions that always have the same parameters, by using a Session 
Template.

The flowchart in Figure 7-1 shows the basic process of starting a new session using a 
Session Template. For details, see “How to Use A Session Template” on page 165. 

T
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Figure 7-1. Flowchart for initiating a session

Metadata fields

The new session begins, governed by the definitions 
and protocols contained in the Session Template 
(that is, the embedded Acquisition Setup).
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Session Template Components

A Session Template has some required and some optional components (see Figure 7-2, 
“Anatomy of a Session Template”). 

Name
The Session Template name is simply the file name in the Finder and can be altered 
later.

The Embedded Acquisition Setup
When a Session Template is created (see “How to Create a Session Template” on page 
161), a particular Acquisition Setup is copied into it. This process is called embedding 
the Acquisition Setup. The original Acquisition Setup is not altered by this process 
and remains an editable document. But the copy that becomes part of the Session 
Template is no longer editable (Figure 7-3). 

Figure 7-2. Anatomy of a Session Template

Template name

Embedded Acquisition Setup

Amplifier calibration protocol

Sensor impedance measurement protocol

Session database definition (metadata fields)

Output file naming and destination definition

Session Template components

Required

Optional
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Output File Naming and Destination Definition
Session files generated during a session must be named and placed in a destination 
folder. When the Session Template is created, automatic naming and destination 
conventions are specified. The file name and destination are governed by the 
specification of the template, although you can override the specification later during 
the initiation of the session. 

Metadata Fields
A Session Template may optionally include metadata fields. The default Session 
Templates include a built-in set of metadata fields. You can create your own templates 
with preexisting metadata fields or create and incorporate new fields. The fields and 
the metadata they contain become part of the Session file when it is saved.

Information can be entered into fields during a session, but the presence or absence of 
fields cannot be changed.

Figure 7-3. Embedding an Acquisition Setup in a Session Template

Embedding the Acquisition Setup in a 
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Other Session Template Options
Two additional options are available when defining a Session Template. When either 
of these options is chosen, Net Station automatically performs the specified 
operations during startup of the session:

• amplifier calibration (gains and zeros measurement)—if the Source device is the 
Net Amps USB or Net Amps 300

• sensor impedance measurement

After Net Station completes the operations, if any were specified, the session is then 
governed by the embedded Acquisition Setup and your interaction with it.

Note: Sensor impedance measurements can be collected only with a Geodesic Sensor Net 
attached to the system.

How to Create a Session Template

To begin, launch Net Station and click the Session Template button in the Customize 
section of the start-up window. This opens the Create New Session Template window 
(Figure 7-4). 

Figure 7-4. Create New Session Template window
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The Create New Session Template window is divided into five areas. Refer to the 
figure as you read the next sections, to go over a step-by-step description of how to 
create a template. 

1 Choose a template name. The Save Session Template button will not activate if 
the field is empty. 

2 Click the name of the Acquisition Setup to be embedded (copied) into the 
Session Template.

3 Choose which operations to perform at the start of the session:

° Calibrate Amplifier (for Net Amps USB or 300 device only): measures the 
gains and zeros for each of the individual amplifier channels. For the most 
accurate measure of amplifier characteristics, you should not connect the 
Geodesic Sensor Net during these measurements, because it can interfere 
with calibration.

° Check Impedance: initiates measurement of impedance at each sensor. To 
check for sensors that might be in poor contact with the subject’s scalp, apply 
the Net to the subject before initiating the impedance check.

4 Select the metadata fields to include with each session. This area is initially 
blank and can remain so if you do not want to include metadata fields in a 
session. Whatever fields are added here will appear at the start of the session, 
prompting you to input metadata.

Click the Insert button to deploy the Insert Fields window (Figure 7-5). 
Choosing fields in the Insert Fields window and clicking Insert will add them 
to the Session Template. 

5 Select session-naming and destination options. The text box beneath the 
Destination pop-up menu shows the resulting name and destination.

After completing these steps, click the Save Session Template button. See Figure 7-7 
on page 164 for an example of a completed Session Template.
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Insert Fields Window
Add metadata fields to a Session Template by selecting a field in the Insert Fields 
window (Figure 7-5) and clicking the Insert button at the bottom of the window. The 
standard fields are not editable, but you can create custom fields that can be edited. 

To add a custom field, click the New Field button. This produces the Create New Field 
window (Figure 7-6), with a text box for entering the field name. Specify the field type 
using the Field Type pop-up menu (Figure 7-6), which defaults to Alphanumeric.

Figure 7-5. Insert Fields window



7: Sessions and Session Templates

164 Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006

Figure 7-6. Create New Field window with Field Type pop-up menu

Figure 7-7. Example of a completed Session Template
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How to Use A Session Template

To begin a session, click the Session button in the Open section of the Net Station start-
up window. The Select Session Template window opens, offering a choice of Session 
Templates (Figure 7-8). Any user-created templates located in the Templates folder 
(see page 40 for information about this folder) will be listed, in addition to the default 
templates.

The default templates will always appear first in the list, sorted alphabetically. User 
templates in the Templates folder will be listed next. User templates can have the 
same names as the default templates, but this is not a wise way to name your custom 
templates.  

There are three ways to choose one of the available Session Templates from the Select 
Session Template window:

• Double-click a Session Template list item
• Single-click a Session Template list item, then click the Select button
• Single-click a Session Template list item, then press the Return key on the 

keyboard

All three ways have the same result—opening the Enter Session Information window 
(see “Session Information,” the next section).

Figure 7-8. Select Session Template window with Clinical Neurotravel Session selected
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Note: You can double-click user-created templates directly in the Finder to begin a 
session, whether Net Station has already been launched or not. If Net Station is inactive 
when you double-click a Session Template, Net Station will automatically launch and the 
Session Information window will open. Using this method of initiating a session bypasses 
the Select Session Template window.

Session Information
After you pick a Session Template, the Enter Session Information window appears, 
displaying in its Session Information subpanel the metadata fields and buttons that 
were specified when the template was originally created. You can enter session 
information at this point, or do so later in the session. Whatever metadata are entered 
will automatically become a permanent part of the Session file after it has been saved. 
Figure 7-9 shows the Enter Session Information window defined in the default 
NA 300 Exp. Control Template.  

Figure 7-9. Enter Session Information window included with the default templates
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Identify Subject Subpanel
Subject identifiers do not store metadata; they are simply labels. If subject identifiers 
have been created in previous sessions, they will appear in the Identify Subject 
subpanel of the Enter Session Information window. Net Station stores previously 
created subject identifiers in its Resource Database (see “Support Folder” on page 40).

New subject identifiers are created by typing into the box to the left of the list.

Session File Naming and Destination Scheme
When you create a new Session Template, you can choose from two autonaming 
schemes (for details, see page 162). In the case of the default Typical Session Template, 
the option was set to automatically name the Session file using the subject name and 
current date and time. 

The middle of the Enter Session Information window (Figure 7-9) displays the name 
that will be applied automatically to the Session file when you close the session and 
save the file. This particular scheme constructs the session name by appending a date 
and time code to the user-chosen subject identifier (or the default, if there are no 
others). The date-time code is of the form: yyyymmdd hour.minute.

Note that you can click the Begin Session button at any time during this part of the 
setup for a session, but once you click the Begin Session button, you cannot change 
the file name and destination folder. The Session file can always be renamed and 
moved using the Finder after the session.

You can override the template’s built-in 
naming scheme, destination setting, or 
both using the Rename Session window, 
described in the following paragraphs.

If you click the Rename Session button in 
the Enter Session Information window, a 
window is displayed for overriding the 
default session name (Figure 7-10). You 
can navigate to a destination folder as 
well as enter a new name for the session. 
With the navigation feature, you can 
override the Session Template’s 
destination scheme, which is also defined 
when the template is saved.

Figure 7-10. Rename Session window
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Click the New button in the Rename Session window to save the new name and 
destination and return to the Enter Session Information window, or click the Cancel 
button to accept the built-in naming scheme. Once you click the New button, the 
destination that was displayed in the window becomes the new destination, 
overriding the Session Template’s built-in specification.

If you have renamed the session, the new name will appear in the middle of the Enter 
Session Information window.

Automatic Amplifier Calibration
With the default NA 200 Typical Session 
Template and the default NA 300 Typical 
Session Template (which use the Net Amps 
USB and Net Amps 300, respectively, as their 
Source device), automatic amplifier 
calibration is performed. The gains and
zeros progress bars come up in tandem 
(Figure 7-11). 

Note: For the most accurate measurement of amplifier gains and zeros during calibration, 
do not connect a Geodesic Sensor Net. 

When the measurement of gains and zeros is finished, the progress bars disappear 
from the screen. 

Impedance Measurement 
If you create a Session Template with the 
Check Impedance checkbox selected
(see page 162), impedance measurement is 
automatically performed when you 
initiate the session. If not, you must 
manually initiate impedance measurement 
(Figure 7-12). 

Before a sensor impedance measurement 
begins, connect a Geodesic Sensor Net to 
the amplifier and apply the Net to the 
subject. 

Figure 7-11. During 
amplifier calibration

Figure 7-12. Click the Measure Net 
Impedance buttons
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If an impedance measurement is initiated without a Geodesic Sensor Net connected, 
Net Station issues an error. Otherwise, the Impedance Measurement window appears, 
displaying a sensor layout that matches the layout of the attached sensor array (see 
Figure 7-13). 

Adjust sensors so that impedances are acceptable, then click the Save & Close button 
to save the current measurement set (see “Impedance Measurement Window” on 
page 82).

Recording EEG
Click the Record button on the Waveform Recorder Controls panel and note that the 
Acquisition status panel displays an indicator that recording is in progress.

Click the Stop button to end the epoch of EEG being recorded. Click Record again to 
begin a new epoch.

Figure 7-13. Impedance Measurement window (EGI’s 256-channel GSN 200)
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Closing the Session
Clicking the Close Session button ends the recording and closes the Session file, 
naming and placing the file in a directory per the Session Template specification (or 
the user override, if any). 
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CHAPTER 8CLINICAL INTERFACE

he optional Clinical Interface is designed to provide the full functionality of 
Net Station to clinicians and physicians. In the Clinical Interface, voltage values 

are plotted negative up and positive down by default. The Clinical Interface also 
offers the following clinically oriented features:

• a simplified start-up screen
• automated Session Templates
• patient records
• the Review window, a patient-oriented interface for locating and reviewing 

exams 
• printing of patient and exam information with EEG data

This chapter describes the interface windows, buttons, and controls, and the main 
clinical features. 

Accessing the Clinical Interface

The Clinical Interface is an adjunct to the research interface; the two cannot operate 
simultaneously. 

If you purchased a complete clinical Geodesic EEG System, the computer is 
configured to operate in clinical mode automatically. 

If you are upgrading your software to enable the clinical features, contact 
support@egi.com to upgrade your license.

T
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Interface Appearance

The start-up window of the Clinical Interface contains three buttons: Acquire, Review, 
and Analyze (Figure 8-1).

• Acquire: opens the Select Session Template window or the Acquisition Session 
window, depending on the Sessions setting in the Preferences window (see 
page 178). Acquiring data using the Clinical Interface is discussed in 
“Acquiring Exams” on page 179. For full details about acquisition, see relevant 
chapters in this manual, the Net Station Acquisition Technical Manual.

• Review: opens the Review window, for locating exams for review. Reviewing 
data using the Clinical Interface is discussed in “Reviewing Exams” on page 
183. For full details about the review tools, see the Net Station Viewer Technical 
Manual.

• Analyze: opens the Waveform Tools tool specification editor. Analyzing data 
using the Clinical Interface is discussed in “Analyzing Exams” on page 185. For 
full details about the Waveform Tools, see the Net Station Waveform Tools 
Technical Manual.

Figure 8-1. Clinical Interface start-up window



8: Clinical Interface

173Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006

Menu Bar
The Clinical Interface contains a simple menu bar (Figure 8-2).

Apple
The Apple menu contains standard Mac OS items for operating the system. 

Net Station
The Net Station menu contains standard commands for 
operating Net Station. The most important is 
Preferences:

• Preferences: allows you to set up exam (file) size, 
viewer preferences, cover page content, and 
Session Template usage (see “Clinical 
Preferences” on page 175). 

File
The File menu contains standard commands for 
working with Net Station files. The most important is 
New:

• New: allows you to create a new Acquisition 
Setup to embed into a new Session Template 
(shortcut: Command-N). The start-up window 
does not offer this capability. (To make a new 
Session Template, see the “Note” on page 180.) 

Figure 8-2. Net Station clinical menu bar
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Edit
The Edit menu is available only if a window is 
open; the only command available is Clear.

• Clear: clears selected items from a list.

Docs
The Docs menu allows you to view selected exams 
during review and acquisition.

• Iconize: unavailable. The Clinical Interface does 
not allow minimization of exam windows.

• <Filename>: switches between the windows of selected exams during review 
mode, and opens the selected exam’s Session Info window during acquisition 
mode.

Tools
The Tools menu offers advanced features for processing 
data. These commands are described fully in the Menus 
chapter of the Net Station Viewer Technical Manual.
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Clinical Preferences

Before running any EEG exams, set up the Net Station Preferences. To open the 
Preferences window, choose Net Station > Preferences. 

The window contains four panes: Acquisition, Review, Printing and Sessions
(Figure 8-3).

Acquisition Pane
The Acquisition pane allows you to set up the connection permissions and the 
maximum size of the exams. 

The Amp Server section contains controls for permitting local-area network access to 
your amplifier. More information about this feature is provided in the Amp Server 
Getting Started Guide (draft).

For information about exam (file) sizes, see “Recording Modes and File Sizes” on page 
79 of this manual.

Figure 8-3. Net Station Preferences window, with the Acquisition pane frontmost
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Review Pane
The Review pane allows you to customize your review display in terms of color, 
screen aliasing, topographic map precision, calibration, and events (Figure 8-4). 
More information about these controls are provided in the Net Station Viewer 
Technical Manual. 

Figure 8-4. Review pane of the Net Station Preferences
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Printing Pane
The Printing pane allows you to set up as many as two cover pages to print with a 
patient’s EEG exam. The cover pages contain information related to the exam and the 
patient (Figure 8-5).

Figure 8-5. Printing pane with “Configuration” and “Add” pop-up menus

“Add” pop-up menu items



8: Clinical Interface

178 Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006

The “Configuration” pop-up menu allows you to choose or duplicate default cover 
pages, or to create new cover pages populated with information selected from the 
“Add” pop-up menu items. 

The “Add” pop-up menus are active only when their corresponding “print cover 
page” checkboxes are selected (see Figure 8-5 on page 177). 

The first cover page contains information identifying the subject and exam (such as 
patient name, filter settings, Geodesic Sensor Net used). The second page contains 
information provided by the referring physician (patient ID, medical history, 
diagnosis, medication, and so forth).

For additional information, see “Printing Patient or Exam Information” on page 185.

Sessions Pane
The Sessions pane (Figure 8-6) allows you to set up the EEG exam format that appears 
when EEG acquisition is initiated.    

• “Select a Session Template” button: If this button is selected, the Select Session 
Template window appears when you click the Acquire button in the start-up 
window, allowing you to use different setups for individual exams.

Figure 8-6. Sessions pane of the Net Station Preferences
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• “Automatically Begin” button: If this button is selected, the Acquisition Session 
window appears when you click the Acquire button in the start-up window. 
The chosen Session Template is automatically set up to acquire EEG data, 
ensuring that the same setup is used for each exam.

For more information about Session Templates, see Chapter 7, "Sessions and Session 
Templates.”

For more information about acquiring EEG in Net Station’s clinical mode, see 
“Acquiring Exams,” in the next section.

Acquiring Exams

The EEG exams recorded using the Clinical Interface are based on Net Station’s 
Session Templates. Before acquiring EEG data, make sure that the default Session 
Templates meet your needs. Otherwise, create and save new Session Templates. For 
more information, see Chapter 7, "Sessions and Session Templates.”

Acquiring exams consists of initiating acquisition, supplying patient information, and 
acquiring EEG data using the Dense Waveform Display. When you create a patient 
record, you must at least enter the patient’s name and assign a unique identifier to the 
patient—the Patient ID—which allows Net Station to correctly link the EEG files to 
the corresponding patient. 

This section provides step-by-step instructions and an illustration of the acquisition 
process.

Note: For long acquisition sessions resulting in multiple files, we recommend creating a 
file folder for storing each session’s files. This prevents the overwriting of identically 
named files from different sessions.
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Acquisition Instructions
To acquire EEG data:

1 Click the Acquire button in the start-up window. 

° If the “Select a Session Template” button is selected in the Sessions pane of 
the Preferences window (see page 178), the Select Session Template window 
will appear (Figure 8-7, left). After you click the Select button in the Select 
Session Template window, the Acquisition Session window will appear.

Note: If the Select Session Template window does not contain the template required, click 
the New Template button to create a template based on the Acquisition Setups available. If 
the list of Acquisition Setups does not include the correct setup, click Cancel, choose File 
> New to create and save a new setup; and click the New Template button in the Select 
Session Template window to create the desired template.

° If the “Automatically Begin” button is selected in the Sessions pane of the 
Preferences window (see page 178), the Acquisition Session window will 
appear (Figure 8-7, right). 

Figure 8-7. Acquisition windows: Select Session Template and Acquisition Session

If the “Select a Session Template” button is selected in 
your Preferences, this window appears after you click 
the Acquire button.

If the “Automatically Begin” button is selected in your 
Preferences, this window appears after you click the 
Acquire button.
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2 Select a patient from the patient list at the top of the Acquisition Session 
window. If you must create a new-patient record:

° Click the New Patient button to open the New Patient window (Figure 8-8).
° Fill in the information in the New Patient window and click OK to return to 

the Acquisition Session window.

Note: The Patient ID box requires a unique patient identifier up to 15 characters in length 
(no colons). 

° Complete the Patient Information section of the Acquisition Session window.

3 When ready, click the Begin Session button in the Acquisition Session window 
to display the Dense Waveform Display and begin acquiring data. 

4 Click the Record button in the Waveform Recorder controls panel to begin 
recording, and click the Stop button to stop. 

5 Click the Close Session button in the top-right corner of the Dense Waveform 
Display to save the exam and to return to the start-up window.

Recording without Complete Patient Information
If you must run the EEG exam immediately, at the very least fill in the following 
information:

• patient’s first name
• patient’s last name
• patient ID

Later, locate the exam and complete the rest of the patient information. 

Figure 8-8. New Patient window

The minimum 
requirements for a 
new-patient record 
are the patient ID 
and patient name.
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Acquisition Ilustration

Figure 8-9. An illustration of the clinical acquisition process

Click the Acquire button in the 
start-up window to open the 
Acquisition Session window.

Optional: Select a Session 
Template and proceed to the 
Acquisition Session window.

Select a patient from the 
Acquisition Session window.

Optional: Create a new-patient 
record and return to the 
Acquisition Session window to 
complete the patient 
information.

Click the Begin Session 
button.

Acquire and record 
data, which are 
displayed in the 
Dense Waveform 
Display.
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Reviewing Exams

Reviewing exams consists of locating the exams using the patient-oriented interface 
and opening them in the Viewer. For more information about Net Station’s review 
capabilities, see the Net Station Viewer Technical Manual. 

Note: The Clinical Interface plots voltage values with negative up and positive down by 
default.

Note: Files recorded in Research mode and viewed using the Clinical Interface will 
contain references to “subjects,” rather than “patients.”

Review Instructions
To review exams:

1 Click the Review button in the start-up window to open the Review window, 
which allows you to view Session exams sorted by patient or date. 

2 In the Review window (Figure 8-10, left), click on an item (or Command-click to 
select more than one item) in the Patient pane on the left, in the Date pane on 
the right, or in both panes; the File pane at the bottom will display only the 
exams for the selected patient(s) or date(s).

Figure 8-10. Review windows: main window and exam-selection window 

The window displays exams for selected patients and/or dates.

Clicking Other opens a window to 
select an exam from a different 
folder.
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The default destination for Net Station Session exams is the Documents folder 
in the user’s home directory (see “Net Station Under OS X” on page 34 of this 
manual for more information). To view an exam saved elsewhere, click the
Other button in the Review window, which opens an exam-selection window 
(Figure 8-10 on page 183, right).

3 To open an exam, double-click on its name in the Files pane or select its name in 
the pane and click the Select button.

Event Labels
If you are viewing an exam with events, all the events are displayed as labels in the 
data-display area of the Viewer when using Chart view (Figure 8-11). This allows 
quick review of the data, especially if the event track-display area near the top of the 
Viewer is not visible.

To view only certain event labels, choose Events > Filter Events to select which events 
to display. (For more information, see Chapter 15, “Viewing Events,” in the 
Net Station Viewer Technical Manual.)

Figure 8-11. Event labels in the data-display area in Chart View
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Printing Patient or Exam Information
The Clinical Interface allows you to print as many as two cover pages containing 
information about the patient, exam, or diagnosis. 

To print only the cover pages, open the exam in the Viewer and choose File > Print 
Cover Pages.

To print the cover pages with the EEG data, either choose File > Print Window to 
print the entire exam, or select a portion of data by highlighting it in the waveform 
area and choosing File > Print Selection.

For details about setting up the cover pages, see “Printing Pane” on page 177. For 
information about printing the EEG data, see the printing chapter in the Net Station 
Viewer Technical Manual.

Analyzing Exams

Analyzing exams consists of applying a Waveform Tool to a selected Session file. For 
more information about Net Station’s analysis capabilities, see the Net Station 
Waveform Tools Technical Manual. 

Analysis Instructions
To analyze exams:

1 Click the Analyze button in the start-up window to open the Waveform Tools 
window (Figure 8-12 on page 186).

2 Click the Add button in the Waveform Tools window and select the exam.

3 Click Filter List to select a defined Waveform Tool specification or click Create 
to define a new Waveform Tool specification.
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4 Click the Run button to run the tool on the exam (see the Net Station Waveform 
Tools Technical Manual for full details).

Figure 8-12. Waveform Tool window
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CHAPTER 9DIGITAL VIDEO 

et Station’s Digital Video option provides full support for any FireWire
(IEEE-1394) DV-compliant digital camera. This capability enables you to record 

and review video of a patient or subject that is synchronized with his or her recorded 
EEG data. The result is an ability to link EEG events to physical movements 
performed by the subject or patient during acquisition, which is essential for clinical 
behavioral studies in areas such as sleep.

This chapter discusses how to add video capability to EEG acquisition, acquire EEG 
with video, and review an EEG–video file.

Video Acquisition Setup

To acquire video synchronized with EEG, you must first create an Acquisition Setup 
that includes the Digital Video device in its Workbench configuration (Figure 9-1). As 
shown in the example in Figure 9-1, the Digital Video device contains no input or 
output ports; placing it on the Workbench automatically activates Net Station’s video 
capabilities. 

Figure 9-1. Primitive Acquisition Setup with video capability

N
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The Digital Video device contains no ports because it is automatically linked to the 
Waveform Recorder; whenever you click the Waveform Recorder’s Record or Stop 
button, you trigger the Digital Video device to start or stop recording.

Acquisition Setups retain the positions of open control and display panels when 
saved. When designing your video Acquisition Setup, make sure that the following, 
at least, are displayed: 

• Video display (choose Panels > Video)
• Dense Waveform Display
• Waveform Recorder controls

When finished designing your video Acquisition Setup, save it and create a Session 
Template (see Chapter 5, "Workbench: Acquisition Setups,” and Chapter 7, "Sessions 
and Session Templates,” for more information).

Video Acquisition

To acquire video–EEG data:

1 Make sure that the camera is properly connected and is on. 

Note: The camera must be on before you initiate acquisition. If you acquire EEG before 
switching on the camera, stop acquisition, switch on the camera, and restart acquisition.

2 Start Net Station, click the New button in the start-up window, and select the 
video Session Template.

3 Enter the Session information and click the Begin Session button to initiate 
acquisition and to view the draggable Digital Video display floating on top of 
the Dense Waveform Display, as shown in Figure 9-2 (if the template is not set 
up to display the video display automatically, choose Panels > Video).
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4 Net Station’s default video format is .mov, normal quality, 640 x 480 resolution. 
From the Size and Quality pop-up menus, you can set up the digital video 
according to your preferences. (The camera used as an example in Figure 9-3 is 
the Apple iSight; other cameras will have different windows for establishing 
the video settings.)

5 Click the Record button in the Waveform Recorder controls to begin saving 
EEG data and video to disk.

Figure 9-2. Digital Video display floating over the Dense Waveform Display

Figure 9-3. Video display settings
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Video Review

Net Station creates a companion video file when you create a video–EEG recording 
and saves it in the same folder as the EEG file. The video file is automatically named 
<filename>.mov (Figure 9-4).

Video is typically recorded and played back at a maximum of 30 frames per second, 
depending on the video settings established during acquisition. Because EEG is 
typically acquired at a much faster rate (for example, 1,000 samples per second), 
when you review your video–EEG file, the video will appear slow in comparison. To 
rectify this, adjust your EEG scale to a slower rate (for example 15–30 milliseconds per 
pixel). Net Station will map each sample to the nearest frame.

To view an EEG–video file:

1 Open the EEG file and choose View > Video to open the video window of the 
companion video file (the video window shows only the image and contains no 
controls).

Figure 9-4. The sample EEG file is saved with its companion video file

EEG file

video file
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2 Click the Time Synch toggle in the data-display control strip of the Viewer to 
display the Time Synch line in the EEG data display. (The Time Synch 
represents a single sample in the EEG display and is used to align views of 
multiple windows.)

3 Adjust the rate of the EEG display so it corresponds more closely to the rate of 
the video recording, by choosing items from the Time-Scale Value and Time-
Scale Unit pop-up menus in the Scale control strip of the Viewer.

Figure 9-5. Open the video window so it floats over the data display in the Viewer

Figure 9-6. The Time Synch is synchronized with the video frame 

Select the Time Synch 
toggle to display the 
Time Synch line

Time-Scale Value

Time-Scale Unit

Navigation control strip



9: Digital Video

192 Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006

4 Navigate through the linked EEG and video using the buttons in the 
Navigation control strip, inserting events into the EEG file based on the 
subject’s or patient’s action shown in the video window. The events and the 
actions are linked to the same timepoint. (The event labels, however, do not 
appear in the video window.)

5 When finished with the EEG review:

° Save the entire EEG and video files by choosing File > Save or pressing 
Command-S.

° Or save a portion of the EEG and the video corresponding to that segment by 
highlighting the EEG in the data-display area and choosing File > Save 
Selection.

Video–EEG Archive

To archive a video–EEG file, you must save both the EEG file and its companion video 
file. Saving one without the other will allow you to view only the EEG or the video of 
an acquisition session.
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CHAPTER 10PHOTIC STIMULATOR 
INTERFACE

photic stimulator flashes a light at a frequency that evokes predictable brain 
activity in a patient during an exam. The device typically consists of a flash unit 

that is triggered either by an external source or by a software program that provides a 
trigger pulse for the recording apparatus. 

Net Station’s Photic Stimulator Interface allows you to create photic-stimulation 
protocols to control the frequency and the duration of such flashes through the 
software. The Photic Stimulator Interface is a Workbench device, in the same 
Stimulus/Response class as the Multi-Port ECI.

With Net Station, automatic operation is the only option. You cannot manually trigger 
the photic stimulator during acquisition. 

Acquisition Setup

Any photic-stimulation protocol created in Net Station must be saved in an 
Acquisition Setup. In other words, the steps are:

1 Add the Photic Stimulator Interface device to an Acquisition Setup.

2 Create a photic-stimulation protocol in Net Station.

3 Name and save the setup. 

You can access the Acquisition Setup just before the exam. 

A
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To add the Photic Stimulator Interface device to your setup, you have two options:

• Devices palette (Figure 10-1, left): This palette is available whenever the 
Workbench is in use, such as during the creation of a new Acquisition Setup. 
Drag the Photic Stimulator Interface icon from the palette to the Workbench to 
add it to your experiment setup.

• Acq menu (Figure 10-1, right): This menu is available whenever the Workbench 
is in use (such as during the creation of a new Acquisition Setup), and functions 
similarly to the Devices palette. Click in a Workbench cell to select it, and 
choose Acq > Photic Stimulator Interface to add the device to your experiment 
setup.

Figure 10-1. The Photic Stimulator device icon in the Devices palette (left) and the Acq menu (right)

Devices palette

Acq menu
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The photic-stimulation setup should allow the experiment events to be both 
displayed and recorded. The STIM cable runs from the Source through the Stimulator 
and into the Recorder, while another STIM cable runs from the Stimulator into the 
Display (Figure 10-2). 

Creating a Protocol

To create an automatic photic-stimulation protocol, you must first create a flash 
interval, use that to create a step, and string together a number of steps to create the 
protocol. The following paragraphs describe these terms further.

A flash interval is defined by three factors:

• the number of flashes,
• the total duration of the flashes, and 
• the duration of the rest interval following the flashes. 

Figure 10-2. An example Acquisition Setup with a photic stimulator added
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A step defines the number of times the defined flash interval runs (Figure 10-3).

A sequence of steps make up a protocol.

The Photic Stimulator Controls window enables you to build a photic-stimulation 
protocol in an Acquisition Setup. In this window, you can create a flash interval and 
steps, and then string the steps together.

 A protocol can consist of as many steps as you desire. The Photic Stimulator Controls 
window shows only two steps at a time, oriented horizontally, but you can use the 
scroll bar at the bottom of the Photic Stimulator Controls window to view the 
remaining steps.

Choose Panels > Photic Stimulator Interface to open the Photic Stimulator Controls 
window (Figure 10-4).

Figure 10-3. Creating a step in a protocol

Figure 10-4. Photic Stimulator Controls window

Flash interval
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Run cycles
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Number of flashes for  
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The following are brief descriptions of the numbered items from Figure 10-4.

1.  Flash-interval settings. Provide a variety of ways to set up the flash interval:

• frequency in Hz: manually type in a value from 1 to 30, or use the slider
• total duration of flashes (in seconds): manually type in a value
• rest interval following flashes (in seconds): manually type in a value
• interval between individual flashes: automatically calculated by Net Station

2.  Flash/rest graph. Visually represents the flash-to–rest interval ratio, for the flash 
interval. Useful if you prefer to use the slider to set the pulse frequency. 

3.  Run cycle. Allows you to set the number of times the flash interval is run before 
proceeding to the next protocol step.

4.  Protocol-step controls. Enable you to:

• Create a new flash-interval window that will appear after the last step. The 
“new” button is always available.

• Copy the selected flash interval. The duplicated interval will appear after the 
last step. The “copy” button is available only when a step is selected.

• Delete the selected flash interval. The selected interval will be deleted and the 
steps following it will move up in order. The “delete” button is available only 
when a step is selected.

Note: You cannot drag the steps into the correct order; you must create the steps in the 
desired sequence and delete those that are incorrectly placed.

5.  Preview button. Allows you to view the photic-stimulation events inserted into the 
Dense Waveform Display. Use to review the Acquisition Setup settings.

6.  Begin button. Allows you to start the photic stimulator and view the photic-
stimulation events inserted into the Dense Waveform Display. Use after initiating 
recording of the acquisition data. 

New

Copy

Delete
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To create a protocol:

1 Define a step by setting values for:

° number of flashes (frequency), 
° total duration of flashes, 
° duration of rest interval following flashes, and 
° number of run cycles.

2 Click the “new” button to create a new step, or select the first step and click the 
“copy” button to duplicate it. 

3 Define the second step.

4 Create a new step, or select and copy an existing step.

5 Once you have defined all the steps, click the Preview button, and, when 
satisfied, close the Photic Stimulator Controls window. 

Acquiring Data

To acquire data with photic-stimulation events:

1 Click the Session button in the “Open” section of the Net Station start-up 
window.

2 Select the correct Session Template in the Select Session Template window, and 
click the Select button.

3 Fill in the subject information and click the Begin Session button in the Enter 
Session Information window. (See Figure 10-5.)
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This opens the Dense Waveform Display, which shows the acquisition signals 
and the control windows for devices such as the amplifier and the photic 
stimulator (if the Photic Stimulator Controls window is not displayed, choose 
Panels > Photic Stimulator Controls). 

4 If the displayed control windows are correct, click the Record button in the 
Waveform Recorder Device control window to begin recording data to disk.

5 Click the Begin button in the Photic Stimulator Controls window to start the 
photic stimulator and to insert these events into the event track.

Figure 10-5. Starting an acquisition session



Photic Stimulator Interface

200 Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006



201Net Station Acquisition Technical Manual   S-MAN-200-ACQR-001 • December 21, 2006

appendix A

APPENDIX ASOFTWARE 
TECHNICAL SUPPORT

Before Contacting EGI

Please check the Contents on page v and 
the Index on page 295 for coverage of 
your issue or question. You can also 
perform an electronic search using Find 
or Search in the PDF version of this 
manual posted on the Documents page 
of the EGI website (www.egi.com/
documentation.html).

In addition, the Support page of the EGI 
website (www.egi.com/support.html) 
may have the information you need.

If you need more help, EGI recommends 
the following:

• Try to isolate the problem. Is your 
problem well defined and repeatable? 

• Document the problem. Carefully 
record and organize the details gleaned 
from the above step and report the 
problem to EGI. 

Contacting EGI

EGI Support
web page

www.egi.com/
support.html

Email support support@egi.com

Sales 
information

info@egi.com

Telephone +541-687-7962

Fax +541-687-7963

Address Electrical Geodesics, Inc.

1600 Millrace Drive

Suite 307

Eugene, OR 97403

USA

http://www.egi.com/documentation.html
http://www.egi.com/documentation.html
http://www.egi.com/documentation.html
http://www.egi.com/documentation.html
http:///www.egi.com/support.html
http:///www.egi.com/support.html
http://www.egi.com/support.html
http://www.egi.com/support.html
http://www.egi.com/support.html
mailto:support@egi.com
mailto:info@egi.com
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appendix B

APPENDIX BUPDATING 
EGI LICENSES

EGI protects its software from unauthorized use by encoding licensing data in HASP 
keys. If you have purchased a complete EGI Geodesic EEG System, the HASP key is 
attached to the system cart handle. If you have purchased only the Net Station 
software, the key is included in the software installation package.

A HASP key is a small hardware device (sometimes called a dongle) that you plug into 
a computer’s USB port. The information in the HASP key tells Net Station whether 
you are allowed to use the software. 

All authorized Net Station users have a HASP key. To update your EGI license, do not 
send EGI the actual hardware key. Instead, you will need to generate a computer file 
from the HASP key and email the file to EGI, which will update the licensing 
information in the file and email it back to you. Use the edited HASP file to update 
your software. (See Figure B-1.)

Figure B-2 lists some points to keep in mind before you begin the HASP key–updating 
process. Step-by-step instructions for updating EGI licenses follow the tips. 

Figure B-1. Overview of the license-updating process

HASP key

1
Generate an 

Update file from 
your HASP key.

2
Compress the file 

and email it 
to EGI.

3
EGI will update 

the file and email 
it to you.

4
Uncompress the 
Updated file and 
use it to update 
your HASP key.

Success!
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Figure B-2. HASP-updating tips

File compression. Before emailing 
your Update file to EGI, compress the 
file (by Control-clicking on the file and 
choosing “Create Archive of 
<filename>” from the pop-up menu) 
to safeguard against file corruption 
during the email process. 

Unique HASPs. Updated HASP files 
are unique to their individual HASP 
keys. The HASP key that created the 
Update file must be plugged in when 
the Updated file from EGI is applied to 
update the license. Note: You may 
have multiple HASP keys with the 
same name, followed by a number. 
The number of the HASP key must 
match the number of the Update file 
when updating.

HASP names. To determine which 
HASP key is which, launch Net Station. 
The name of the HASP key is in the 
bottom-left of the Net Station start-up 
screen. Quit Net Station, launch the 
Updater application, and apply the 
corresponding HASP file.

File organization. Avoid duplicate 
Update files. After emailing your 
Update file to EGI, delete it from your 
computer. Likewise, after applying the 
Updated file from EGI to your HASP 
key, delete the file.

Tips on Updating EGI Licenses
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Figure B-3. Open the HASP Updater application

Opening the Updater Application
1   Quit Net Station, if necessary.

2   Insert the HASP key into the USB port at the side of your keyboard or at the back 
of your computer. A light should illuminate within the key.

3   On your hard drive, 
open the Applications 
folder.

4   Open the Net Station install 
folder in the Applications folder.

5   Open the Extras folder and 
double-click on the NS 
Remote HASP Updater icon to 
launch the application and 
open the Updater dialog.
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Figure B-4. Create the HASP Update file, compress it, and email it to EGI

Generating the Update File
1   Make sure that the 
Create Update File tab is 
frontmost in the Updater 
dialog.

2   Click the HASP 
file button.

3   The Update dialog will automatically close, and an Update 
file will appear on your Desktop with the filename “NS – 
xxxx,” where xxxx is the license holder’s name. If you have 
more than one HASP, the number of the HASP will be 
appended (e.g., NS - Ling Chan, NS - Ling Chan 1).

4   Compress the file by Control-clicking on the file 
and choosing Create Archive of “<filename>” from 
the pop-up menu. This will ensure that your file is not 
corrupted in transit. Note that this operation must 
be performed on a Macintosh computer, not a PC.

5   Email the compressed file to 
support@egi.com and include in the email 
message your name, the license holder’s 
name (if you are not 
the licensee), your 
organization, and a 
description of what 
must be updated. 
For best results, email 
the file from the Macintosh computer that 
generated it. Or, you can copy the file to a 
Mac HFS-formatted removable drive, 
transfer it to another Mac, and email it. Do 
not email it from a PC.

6  Delete the HASP 
Update file and any 
previous compressed 
copies from your 
Desktop.

7  EGI will modify the file, updating 
your license, and email it back to you, 
typically within two to three days.
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Figure B-5. Apply the Updated file from EGI to the corresponding HASP

Applying an Updated File
1   Save to the Desktop the Updated file from EGI, uncompressing it if needed.

2   Quit Net Station, if necessary.

3   Insert the corresponding HASP key into the USB port at the side of your 
keyboard or at the back of your computer. A light should illuminate within the key.

4   Open the Net Station install folder in the Applications folder on your hard drive.

5   Double-click on the NS Remote HASP Updater icon, which will open the 
Updater dialog.

6   Make sure that the 
Update HASP tab is 
frontmost in the Updater 
dialog. 

7   Drag the Updated file 
into the Update box.

8   A dialog will appear, with 
a message indicating a 
successful update.

9   Delete the Updated 
file and any compressed 
copies from your 
Desktop.
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Questions

Contact EGI at support@egi.com with any questions regarding this document and the 
issues discussed.

mailto:support@egi.com
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APPENDIX CMONTAGES

The following tables list the current adult Net Station default montages, their 
referencing schemes, and page locations for sensor map views. Net Station contains 
other default montages (earlier GSN versions, infant and toddler models, and so on); 
please contact support@egi.com for more information.

A montage affects the display of EEG waveforms, not the way they are recorded. In a 
number of cases, the sensor maps indicate which sensors’ data are displayed in the 
Dense Waveform Display, and which are not, for a given montage. 

For how to apply a montage during data acquisition, see the “Montage Controls” 
section in Chapter 4. 

Table C-1, Table C-2, and Table C-3 list the montages for the 256-, 128-, and 64-channel 
GSN 200 models, respectively. Table C-4, Table C-5, Table C-6, and Table C-7 lists the 
montages for the 256-, 128-, 64-, and 32-channel HCGSNs.        

       

Table C-1. 256-channel GSN 200 montages

Montage Referencing scheme Figure on page

GSN 256 Adult 2.1 vertex N/A

Average Reference average of all sensors Figure C-1, page 212

10-10 average of all sensors Figure C-8, page 219

10-10 All Sensors average of all sensors Figure C-15, page 226

10-20 average of all sensors Figure C-22, page 233

Double Banana bipolar Figure C-29, page 240

Eyes vertex Figure C-36, page 247

Left Mastoid Reference sensor 93 Figure C-43, page 254

Linked Mastoid Reference sensors 93 and 191 Figure C-50, page 261

Right Mastoid Reference sensor 191 Figure C-57, page 268



C: Montages

210 Net Station Acquisition Technical Manual   S-MAN-200-ACQR-001 • December 21, 2006

        

Table C-2. 128-channel GSN 200 montages

Montage Referencing scheme Figure on page

GSN 128 Adult 1.0 vertex N/A

Average Reference average of all sensors Figure C-2, page 213

10-10 average of all sensors Figure C-9, page 220

10-10 All Sensors average of all sensors Figure C-16, page 227

10-20 average of all sensors Figure C-23, page 234

Double Banana bipolar Figure C-30, page 241

Eyes vertex Figure C-37, page 248

Left Mastoid Reference sensor 57 Figure C-44, page 255

Linked Mastoid Reference sensors 57 & 101 Figure C-51, page 262

Right Mastoid Reference sensor 101 Figure C-58, page 269

Table C-3. 64-channel GSN 200 montages

Montage Referencing scheme Figure on page

GSN 64 Adult 2.0 vertex N/A

Average Reference average of all sensors Figure C-3, page 214

10-10 average of all sensors Figure C-10, page 221

10-10 All Sensors average of all sensors Figure C-17, page 228

10-20 average of all sensors Figure C-24, page 235

Double Banana bipolar Figure C-31, page 242

Eyes vertex Figure C-38, page 249

Left Mastoid Reference sensor 26 Figure C-45, page 256

Linked Mastoid Reference sensors 26 and 51 Figure C-52, page 263

Right Mastoid Reference sensor 51 Figure C-59, page 270

Table C-4. 256-channel HydroCel GSN montages

Montage Referencing scheme Figure on page

HydroCel GSN 256 1.0 vertex N/A

Average Reference average of all sensors Figure C-4, page 215

10-10 average of all sensors Figure C-11, page 222

10-10 All Sensors average of all sensors Figure C-18, page 229

10-20 average of all sensors Figure C-25, page 236

Double Banana bipolar Figure C-32, page 243

Eyes vertex Figure C-39, page 250

Left Mastoid Reference sensor 94 Figure C-46, page 257

Linked Mastoid Reference sensors 94 and 190 Figure C-53, page 264

Right Mastoid Reference sensor 190 Figure C-60, page 271
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Table C-5. 128-channel HydroCel GSN montages

Montage Referencing scheme Figure on page

HydroCel GSN 128 1.0 vertex N/A

Average Reference average of all sensors Figure C-5, page 216

10-10 average of all sensors Figure C-12, page 223

10-10 All Sensors average of all sensors Figure C-19, page 230

10-20 average of all sensors Figure C-26, page 237

Double Banana bipolar Figure C-33, page 244

Eyes vertex Figure C-40, page 251

Left Mastoid Reference sensor 57 Figure C-47, page 258

Linked Mastoid Reference sensors 57 and 100 Figure C-54, page 265

Right Mastoid Reference sensor 100 Figure C-61, page 272

Table C-6. 64-channel HydroCel GSN montages

Montage Referencing scheme Figure on page

HydroCel GSN 64 1.0 vertex N/A

Average Reference average of all sensors Figure C-6, page 217

10-10 average of all sensors Figure C-13, page 224

10-10 All Sensors average of all sensors Figure C-20, page 231

10-20 average of all sensors Figure C-27, page 238

Double Banana bipolar Figure C-34, page 245

Eyes vertex Figure C-41, page 252

Left Mastoid Reference sensor 29 Figure C-48, page 259

Linked Mastoid Reference sensors 29 and 47 Figure C-55, page 266

Right Mastoid Reference sensor 47 Figure C-62, page 273

Table C-7. 32-channel HydroCel GSN montages

Montage Referencing scheme Figure on page

HydroCel GSN 32 1.0 vertex N/A

Average Reference average of all sensors Figure C-7, page 218

10-10 average of all sensors Figure C-14, page 225

10-10 All Sensors average of all sensors Figure C-21, page 232

10-20 average of all sensors Figure C-28, page 239

Double Banana bipolar Figure C-35, page 246

Eyes vertex Figure C-42, page 253

Left Mastoid Reference sensor 23 Figure C-49, page 260

Linked Mastoid Reference sensors 23 and 24 Figure C-56, page 267

Right Mastoid Reference sensor 24 Figure C-63, page 274
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Average Reference Montage

Figure C-1. Average Reference (256-channel GSN 200 adult 2.1)
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Figure C-2. Average Reference (128-channel GSN 200 adult 2.1)
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Figure C-3. Average Reference (64-channel GSN 200 adult 2.0)
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Figure C-4. Average Reference (256-channel HCGSN adult 1.0)
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Figure C-5. Average Reference (128-channel HCGSN adult 1.0)
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Figure C-6. Average Reference (64-channel HCGSN adult 1.0)
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Figure C-7. Average Reference (32-channel HCGSN adult 1.0)
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10-10 Montage

Figure C-8. 10-10 (256-channel GSN 200 adult 2.1)
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Figure C-9. 10-10 (128-channel GSN 200 adult 2.1)



C: Montages

221Net Station Acquisition Technical Manual   S-MAN-200-ACQR-001 • December 21, 2006

Figure C-10. 10-10 (64-channel GSN 200 adult 2.0)
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Figure C-11. 10-10 (256-channel HCGSN adult 1.0)
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Figure C-12. 10-10 (128-channel HCGSN adult 1.0)
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Figure C-13. 10-10 (64-channel HCGSN adult 1.0)
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Figure C-14. 10-10 (32-channel HCGSN adult 1.0)
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10-10 All Sensors Montage

Figure C-15. 10-10 All Sensors (256-channel GSN 200 adult 2.1)
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Figure C-16. 10-10 All Sensors (128-channel GSN 200 adult 2.1)
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Figure C-17. 10-10 All Sensors (64-channel GSN 200 adult 2.0)
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Figure C-18. 10-10 All Sensors (256-channel HCGSN adult 1.0)
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Figure C-19. 10-10 All Sensors (128-channel HCGSN adult 1.0)
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Figure C-20. 10-10 All Sensors (64-channel HCGSN adult 1.0)
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Figure C-21. 10-10 All Sensors (32-channel HCGSN adult 1.0)
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10-20 Montage

Figure C-22. 10-20 (256-channel GSN 200 adult 2.1)
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Figure C-23. 10-20 (128-channel GSN 200 adult 2.1)
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Figure C-24. 10-20 (64-channel GSN 200 adult 2.0)
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Figure C-25. 10-20 (256-channel HCGSN adult 1.0)
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Figure C-26. 10-20 (128-channel HCGSN adult 1.0)
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Figure C-27. 10-20 (64-channel HCGSN adult 1.0)
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Figure C-28. 10-20 (32-channel HCGSN adult 1.0)
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Double Banana Montage

Figure C-29. Double Banana (256-channel GSN 200 adult 2.1)
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Figure C-30. Double Banana (128-channel GSN 200 adult 2.1)
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Figure C-31. Double Banana (64-channel GSN 200 adult 2.0)
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Figure C-32. Double Banana (256-channel HCGSN adult 1.0)
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Figure C-33. Double Banana (128-channel HCGSN adult 1.0)
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Figure C-34. Double Banana (64-channel HCGSN adult 1.0)
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Figure C-35. Double Banana (32-channel HCGSN adult 1.0)
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Eyes Montage

Figure C-36. Eyes (256-channel GSN 200 adult 2.1)
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Figure C-37. Eyes (128-channel GSN 200 adult 2.1)
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Figure C-38. Eyes (64-channel GSN 200 adult 2.0)
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Figure C-39. Eyes (256-channel HCGSN adult 1.0)
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Figure C-40. Eyes (128-channel HCGSN adult 1.0)
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Figure C-41. Eyes (64-channel HCGSN adult 1.0)
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Figure C-42. Eyes (32-channel HCGSN adult 1.0)
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Left-Mastoid Reference Montage

Figure C-43. Left-Mastoid Reference (256-channel GSN 200 adult 2.1)
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Figure C-44. Left-Mastoid Reference (128-channel GSN 200 adult 2.1)
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Figure C-45. Left-Mastoid Reference (64-channel GSN 200 adult 2.0)
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Figure C-46. Left-Mastoid Reference (256-channel HCGSN adult 1.0)



C: Montages

258 Net Station Acquisition Technical Manual   S-MAN-200-ACQR-001 • December 21, 2006

Figure C-47. Left-Mastoid Reference (128-channel HCGSN adult 1.0)
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Figure C-48. Left-Mastoid Reference (64-channel HCGSN adult 1.0)
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Figure C-49. Left-Mastoid Reference (32-channel HCGSN adult 1.0)
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Linked-Mastoid Reference Montage

Figure C-50. Linked-Mastoid Reference (256-channel GSN 200 adult 2.1)
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Figure C-51. Linked-Mastoid Reference (128-channel GSN 200 adult 2.1)
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Figure C-52. Linked-Mastoid Reference (64-channel GSN 200 adult 2.0)
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Figure C-53. Linked-Mastoid Reference (256-channel HCGSN adult 1.0)
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Figure C-54. Linked-Mastoid Reference (128-channel HCGSN adult 1.0)
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Figure C-55. Linked-Mastoid Reference (64-channel HCGSN adult 1.0)
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Figure C-56. Linked-Mastoid Reference (32-channel HCGSN adult 1.0)
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Right-Mastoid Reference Montage

Figure C-57. Right-Mastoid Reference (256-channel GSN 200 adult 2.1)
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Figure C-58. Right-Mastoid Reference (128-channel GSN 200 adult 2.1)
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Figure C-59. Right-Mastoid Reference (64-channel GSN 200 adult 2.0)
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Figure C-60. Right-Mastoid Reference (256-channel HCGSN adult 1.0)
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Figure C-61. Right-Mastoid Reference (128-channel HCGSN adult 1.0)
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Figure C-62. Right-Mastoid Reference (64-channel HCGSN adult 1.0)
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Figure C-63. Right-Mastoid Reference (32-channel HCGSN adult 1.0)
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APPENDIX DACQUISITION 
HOW-TO

This appendix provides a step-by-step guide for acquiring EEG data and events using 
Net Station. Use this appendix to review how to acquire data and events using EGI’s 
Geodesic EEG System 250 and an experiment control system.

Before Acquisition

Always refer to the list to the right before your 
subject arrives, giving yourself enough time to 
procure the items you will need and have 
everything ready.

The System 250 components should be 
connected properly and Net Station should be 
installed on the data-acquisition computer. The 
experiment control computer should be 
running the experiment control software you 
have chosen, and the experiment file should be 
ready. Check that any cables between the data-
acquisition computer and experiment control 
computer are securely connected.

Net application is the process of preparing 
electrolyte, measuring the subject’s head, 
choosing the correct size of Geodesic Sensor 
Net, marking the vertex, and putting the Net 
on the subject. Use the EGI Net Application 
DVD, available from EGI Support 
(support@egi.com) to refresh your technique.

Acquisition List

System 250 Components:
• HydroCel GSN
• Net Amps 200
• data-acquisition computer
• articulating arm and GSN

interface cable
• Net Station software

Experiment Control:
• experiment control computer
• experiment control software
• response pad (optional)

GSN Application, Rinsing, 
Disinfecting, and Drying:
• measuring tape
• china marker pencil
• bucket for HydroCel ES and

rinse water
• bucket for disinfectant
• potassium chloride
• Johnson’s baby shampoo
• warm distilled water
• clean, dry towels
• disposable plastic pipette(s)
• drying rack
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Rinsing, disinfecting, and drying are 
performed after the Net is removed from the 
subject.

If you are unfamiliar with the items in the list, 
or need to refresh your memory, check this 
book, the Net Station Acquisition Technical 
Manual, and the Geodesic Sensor Net Technical 
Manual (www.egi.com/documentation. 
html). The manuals provide details that this 
“refresher” appendix excludes because of 
space limitations.

Note: This appendix uses the Experimental 
Control Template, one of the five default Session 
Templates included with Net Station. You will 
use your own template when you run your own 
experiment.

Acquisition Workflow

Figure D-1 illustrates the general Net Station 
workflow. Each step is described in detail in 
this section.

Net Station users can initiate EEG data 
acquisition using a:

• Workbench configuration 
(Acquisition Setup) or

• Session Template

Preconfigured templates such as the 
Experimental Control Template simplify the 
process of data acquisition, but achieve this in 
part by hiding their embedded Workbench 
configurations. The Workbench configuration 
associated with the Experimental Control 
Template is described in “Default 

Rinse, disinfect, dry the Net

Check basic operation

Measure subject’s head

Mix electrolyte

Locate and mark vertex

Measure sensor impedances

Run the experiment

Load sensors with electrolyte

Choose correct-size Net

Initiate new session

Enter session information

Connect the Net

Remove the Net

Schedule subject

Inspect waveforms

Apply the Net

Figure D-1. Acquisition workflow
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Experimental Control Setups” on page 137 for users who wish to study it, but 
knowledge of the configuration is not necessary for understanding the material in this 
appendix.

Schedule Subject
When scheduling subjects, ask them to wash their hair the day before they come to the 
data-acquisition session, and not to use hair-styling products. Hair should be dry for 
the session.

Make sure the Geodesic Sensor Nets will be dry for the upcoming session, or the 
sponges will not absorb the full amount of electrolyte. Have appropriate Net sizes, 
and extra Nets if multiple subjects are going to be run.

Check Basic Operation
Before the subject arrives, it is good to check that:

• System 250 components and experiment control computer are working 
properly.

•  The experiment control software is sending events to Net Station.

To begin the Check of Basic Operations:

1 Open Net Station and in the Net Station 
start-up window, click the Session 
Template button in the Open section.

2 Choose Experimental Control Template 
and click the Select button (Figure D-2).

3 Make sure that the Geodesic Sensor Net 
interface cable (GSNIC) is not connected 
to the amplifier(s) during the upcoming 
gains and zeros measurements 
(calibration).

4 Click the Begin Session button and observe that the Ready Light illuminates on 
the front panel of the Net Amps. If you are setting up to collect 256-channel 
data, the Ready Lights of both amplifiers are illuminated.

Figure D-2. Select 
Experimental Control Template
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5 At this point, amplifier calibration 
begins automatically, signaled by the 
appearance of the Measuring Zeros 
progress bar, followed by the Measuring 
Gains progress bar (Figure D-3).

6 Choose Panels > Log: TCP/IP Port 55513 to view the Session Log, which 
initially will be blank.

7 Start your experiment by launching the experiment control software on the 
experiment control computer. Run the experiment long enough to verify that 
events are being logged in the Session Log window, then suspend the 
experiment and quit from the experiment control software (if using E-Prime, 
do Control-Alt-Shift on the PC keyboard).

8 This completes the Check of Basic Operation. Click the Close Session button.

Prepare Electrolyte
1 Welcome your subject, describe the 

Geodesic Sensor Net application 
protocol, and explain the experiment.

2 Make the HydroCel Saline electrolyte, 
following the instructions on the 
laminated Geodesic Sensor Net 
Application Guide placard (Figure D-4). 

Note: One (1) tablespoon is equal to three (3) 
teaspoons; be careful not to confuse them.

3 Stir briefly to promote the dissolving of 
the potassium chloride. The ideal 
temperature of the electrolyte is 37 °C 
when you apply the Net, for the comfort 
of the subject.

4 Give the subject a towel to use for 
catching drips, and place a second towel (or two towels) over the subject’s 
shoulders.

Figure D-3. Zeros and gains

Figure D-4. Net application placard
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Enter Session Information
1 Open Net Station, if necessary, and click 

the Session button. 

2 Choose Experimental Control Template 
and click the Select button.

3 Fill out the metadata fields (Figure D-5).

Initiate New Session
1 With the GSNIC still not connected to the amplifier(s), click the Begin Session 

button and allow zero and gains measurements to proceed automatically. (You 
may connect the GSNIC to the amplifiers at any time after zeros and gains have 
finished.) 

2 Begin head measurement while zeros and gains are being measured, to save 
time.

Measuring the Subject’s Head
1 Measure the circumference of the 

subject’s head in centimeters, using the 
measuring tape.

Choose Correct Size Net
1 Based on the subject’s head 

circumference, choose a HydroCel GSN 
to apply to the subject’s head using the 
laminated Geodesic Sensor Net Sizing 
Chart placard (Figure D-6).

Figure D-5. Enter session information

Figure D-6. Net size placard
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Load Sensors with Electrolyte; Mark Vertex
1 Dip the sensor end of the HydroCel GSN in the HydroCel Saline and soak 

sensors for 5 minutes. 

2 Locate and mark the vertex using china 
marker pencil.

3 Remove the Net from electrolyte bucket 
and gently pat the sensors once with a 
clean towel to remove excess electrolyte 
(Figure D-7).

Apply the Net
1 Give the connector to the subject or to 

your assistant to hold during 
application.

2 Place your hands gently inside the 
sensor array and invert the Net by 
stretching it slightly against the backs of 
your hands. Jiggle the Net so that the 
vertex electrode (VREF) is centered and 
the other electrodes are not tangled in 
the elastomer lines (Figure D-8).

Caution!: Do not overstretch the Net.

3 Position your fingertips along the band 
of the Net. With the subject’s eyes close, 
stand in front of the subject and bring 
the Net down so that the vertex 
electrode comes down in alignment with 
the vertex marked on the subject’s head 
(Figure D-9).

Figure D-7. Pat the sensors

Figure D-8. Invert the Net gently

Figure D-9. Apply the Net on 
the subject’s head
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4 Tighten the chinstrap and adjust for 
subject comfort and adjust the eye 
channels (Figure D-10).

5 Check anatomical landmark locations to 
see if the Net is positioned correctly. 
Reapply the Net, if the landmarks are off 
by more than 1 centimeter.

6 Slight adjustments may be made to the position of the Net by moving sensors 
in groups. Never adjust the position of the Net by pulling on single sensors.

Connect the Net
1 Plug the Geodesic Sensor Net into the GSNIC and turn the locking lever on the 

connector to lock it in place. The GSNIC should be connected to the 
amplifier(s). 

2 You can now measure impedances. 

Note: Gains and zeros must be measured without the Net and GSNIC connected, but you 
already measured them.

Measure Sensor Impedances
1 Click the Measure Net Impedance 

button on the Net Amps Controls panel 
(Figure D-11), or choose Panels > 
Impedance and click the Measure 
button on the Impedance panel.

2 Seat each sensor on the subject’s scalp 
by raking aside the subject’s hair using 
the sensor, or with the help of the 
disposable pipette, so that the sponge 
makes contact with the subject’s scalp. It 
is very important to push and rub the 
sensors strongly against the skin to get 
lower impedances.

Figure D-10. Adjust the 
eye channels

Figure D-11. Measure Net 
Impedance button
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3 In the Impedance Measurement window 
(Figure D-12), note any sensors that are 
not making good contact and 
manipulating the sensors to achieve 
better contact. Notice the progress bar at 
the bottom of the window, which begins a 
new scan automatically as soon as the 
current scan is done.

4 When impedances are satisfactory, click 
the Save & Close button in the Impedance 
Measurement window. Until you click 
Save & Close, impedance scanning keeps 
updating. 

Caution!: If you record EEG with the Impedance Measurement window still 
deployed, your EEG will be contaminated with calibration signals.

5 Now return to the waveform display and scroll through the waveforms to look 
for channels that are flailing or displaying high amplitude noise because of 
poor contact with the scalp. Note any such sensors in a log book, to track sensor 
performance from session to session.

6 Adjust the eye channels, if necessary, to 
improve contact of sensors. Remember 
that Net Station’s artifact detection tools 
use the eye channels to detect eyeblinks 
and eye movements.

7 If needed, add small amounts of 
electrolyte to sensors using a pipette. 
With the GSN 200, the electrolyte can be 
added through the small opening where 
the lead wire enters the pedestal (Figure 
D-13). It will be drawn into the sponge 
by capillary action. With the HCGSN, 
you can lift a corner of the pedestal and 
add electrolyte directly to the sponge.

Figure D-12. Detail of the 
Impedance Measurement window

Figure D-13. Add electrolyte 
through the pedestal opening
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Run the Experiment
1 After making sure the subject is ready, start your experiment.

Note: For long acquisition sessions resulting in multiple files, we recommend creating a 
file folder for each session. This prevents the overwriting of identically named files from 
different sessions.

2 During the experiment, observe the waveform display to determine if any 
channels are displaying increasing noise levels. This indicates that during a 
block break it might be good to rewet some of the electrodes.

Remove the Net
1 After the experiment is finished, ask the subject to close his or her eyes while 

you loosen the chin strap and remove the HydroCel GSN. Check the Geodesic 
Sensor Net Technical Manual for the proper technique.

Rinse, Disinfect, Dry the Net
1 Follow the instructions on the laminated 

Geodesic Sensor Net Rinsing 
Disinfecting Tips placard that came with 
your system (Figure D-14).

Figure D-14. Net rinsing/
disinfecting placard



D: Acquisition How-To

284 Net Station Acquisition Technical Manual   S-MAN-200-ACQR-001 • December 21, 2006



285Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006

GLOSSARY

A

Absolute Time   Standard time as 
reckoned by the local clock in the data-
acquisition computer.

Acquisition Setup file   A saved 
Workbench configuration that preserves 
the control and display settings that 
were in effect at the time the file was 
saved. A setup can be multipurpose or 
specialized for specific acquisition 
needs, depending on the devices 
included.

A/D units   The digital values reported 
by the Net Amps 200 and 300 amplifier 
after sampling and conversion of analog 
signals. 

aliasing   Distortion of the EEG signal, 
which occurs when the signal is 
digitized at a rate less than half the 
highest frequency present. See Nyquist 
frequency.

amp/amperage   A measure of the 
amount of current, or number of 
electrons, moving across a point.

antialiasing   Filtering a signal prior to 
digitization so that high-frequency 

components do not appear as false 
lower-frequency components. See 
aliasing.

artifact   An inaccurate observation, 
effect, or result, especially one resulting 
from the technology used in scientific 
investigation or from experimental 
error.

attenuate   To reduce the amplitude of 
an action or signal. The opposite of 
amplification. 

autonaming   A procedure used by 
Net Station to supply a file name 
automatically when the user has not 
specified one.

autosaving   A process by which data 
are automatically saved to disk without 
requiring any action by the user.

B

bandpass filter   A tuned circuit 
designed to pass a band of frequencies 
between a lower cut-off frequency (f1) 
and a higher cut-off frequency (f2). 
Frequencies above and below the pass 
band are heavily attenuated.



Glossary

286 Net Station Acquisition Technical Manual  S-MAN-200-ACQR-001 • December 21, 2006

bandstop filter   A tuned circuit 
designed to stop frequencies between a 
lower cut-off frequency (f1) and a higher 
cut-off frequency (f2) of the amplifier 
while passing all other frequencies.

Bessel filter    An IIR filter that produces 
the most linear phase response of all IIR 
filters, with no consideration of the 
frequency magnitude response. Bessel 
filters tend to have maximally constant 
group delay. 

C

calibration signal   A signal generated 
internally in the Net Amps 200 and 300 
for the purpose of measuring gains and 
impedances. This signal is a 20 Hz,
400 µV peak-to-peak sine wave.

channel   Each sensor of the Geodesic 
Sensor Net is cabled into the Net Amps 
200 and 300 amplifier where its signal is 
converted into a stream of digital values. 
Each of these streams is the data of a 
channel. Net Station handles channel 
data by storing them in tracks, which 
can be recorded onto a computer disk as 
a file, along with event tracks containing 
events. In a hardware context, a channel 
is one of the instrumentation amplifiers 
inside the Net Amps 200 and 300. 
Channel is also the name of one of the 
unique combinations of bits constituting 
a digital input (DIN). See DIN.

channel gains   Each amplifier channel 
of the Net Amps 200 and 300 has a 
particular gain, similar to that of the 
other channels but not identical. To 
calibrate the amplifiers for gain, the 

output of each channel is electronically 
measured while an identical calibration 
signal is applied to each. Recorded and 
stored by Net Station as A/D units, 
these measurements—the channel 
gains—provide a means for calculating 
a channel-specific scaling factor. The 
scaling factor, in turn, enables Net 
Station to accurately convert A/D units 
to microvolt data. See also channel zeros.

channel zeros   Each amplifier channel of 
the Net Amps 200 and 300 has a 
particular response to a potential of zero 
volts applied to its inputs. To calibrate 
the amplifiers for zeros, the output of 
each channel is electronically measured 
while zero volts are applied to its inputs. 
Recorded and stored by Net Station as 
A/D units, these measurements—the 
channel zeros—provide a means for 
calculating channel-specific offset 
factors. The offset factors, in turn, enable 
Net Station to acquire microvolt data 
without inaccuracies from channel-by-
channel variations in zero response. See 
also channel gains. 

CMR   See common mode rejection.

common   An electrical point that 
functions in much the same way that an 
earth ground does, but is separated from 
earth ground by an isolation barrier 
(typically thousands of volts of 
isolation) in the interest of safety.

common mode rejection   A measure of 
the attenuation of noise induced in the 
signal or reference lines relative to 
common. The ratio is typically 
expressed in decibels. 
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conductivity   A measure of the 
tendency of a material to transmit 
electrons; the reciprocal of impedance.

cutoff frequency   Frequency at which 
the power gain of an amplifier falls 
below 50% of maximum.

D

DAC   data-acquisition computer.

dB   See decibel.

decibel   A logarithmic measure of the 
ratio between two values. For electrical 
signals, the measure is –20 log10(A0/A1). 
A ratio of 1/1000, for example, 
corresponds to –60 dB.

dense (sensor) array   Any (sensor) 
system that supports sufficient number 
of sensors to spatially sample a 
phenomenon adequately. For EEG 
recording, this generally means 64 
channels or more.

deploy   A term referring to when an 
interface panel that is initially not visible 
on the screen is brought into view by 
using a button or menu command.

device   See Net Station device.

digital filter   A computational process, 
or algorithm, transforming a discrete 
sequence of numbers (the input) into 
another discrete sequence of numbers 
(the output) having a modified 
frequency domain spectrum. Digital 
filtering can be in the form of a software 
routine operating on data stored in 
computer memory or can be 

implemented with dedicated digital 
hardware. 

digital input   See DIN.

digitization   The process of putting 
data into digital form.

DIN   A Net Amps digital input, or an 
event caused by a state change on one or 
more of the eight digital inputs on the 
back panel of the Net Amps 200 and 300 
amplifier.

drift   The change in a signal’s offset 
over time, or the amount by which a 
signal’s offset changes with time.

DWD   Dense Waveform Display. 

E

ECI   See Experimental Control Interface.

EEG   electroencephalography. The 
science of graphically recording the 
electrical activity of the brain as 
recorded by an electroencephalograph.

electrostatic discharge   The transfer of 
an electrostatic charge between bodies at 
different electrostatic potentials 
(voltages), caused by direct contact or 
induced by an electrostatic field.

elliptical filter    An IIR filter that 
produces the sharpest rolloff for a given 
number of filter taps. Elliptical filters 
have the poorest phase linearity of the 
most common IIR filter design 
functions. The ripple in the passband 
and stopband are equal with elliptic 
filters.
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epoch   When the Net Station 
Workbench is turned on and records 
EEG data, then is turned off, the EEG 
that has been recorded corresponds to a 
single epoch. Each time this occurs, a 
new epoch is generated. More generally, 
an epoch is any stretch of uninterrupted 
EEG or time.

Epoch Time   One of the four time modes 
used by Net Station. Epoch Time is set to 
zero at the beginning of every recording 
epoch, and epochs are numbered 
starting with 1. See Absolute Time, 
Recording Time, and Relative Time.

ERP   See event-related potential.

ESD   See electrostatic discharge.

event   A marker indicating a point of 
interest in an EEG recording. 

event-related potential   An EEG 
waveform elicited by a stimulus such as 
an auditory or visual event.

event track   In Net Station, an event 
track is a container for events. 
Net Station displays event tracks and 
their constituent events in its waveform 
viewer in the form of “flags.”

Experimental Control Interface   Built 
into Net Station is a protocol for 
experimental control technology that 
uses the Experimental Control Interface 
device along with a messaging system.

F

filter length   Refers to the number of 
impulse response coefficients used to 

approximate the corresponding FIR 
filter.

filter order   Refers to the order of the 
highest-order term in the polynomial 
used to approximate the corresponding 
IIR filter.

Finder   On Macintosh computers, the 
Finder is the program that keeps track of 
files and folders and displays the 
desktop (the working area on the screen 
with disk icons, a Trash icon, and so on).

FIR filter   finite impulse response filter. 
An FIR filter calculates current output 
solely from the current and previous 
input values. This defines a class of 
digital filters that has only zeros on the 
z-plane. The key implications of this are 
that FIR filters are always stable and 
have linear phase responses (as long as 
the filter's coefficients are symmetrical). 
For a given filter order, FIR filters have a 
much more gradual transition region 
rolloff than digital IIR filters.

FireWire   Apple Computer's name for 
the IEEE 1394 High Speed Serial Bus. It 
was developed by the IEEE P1394 
Working Group, which consisted of 
members from Apple, Texas 
Instruments, Sony, Digital Equipment 
Corporation, IBM, and SGS Thomson, 
among others. FireWire is commonly 
used for connection of data storage 
devices and digital video cameras, and 
is also popular in industrial systems for 
machine vision and professional audio 
systems. It is often used in place of a 
USB connection because it offers faster 
speed and higher power-distribution 
capabilities, and does not require a 
computer host. 
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G

gain   The amount by which a signal is 
amplified. A gain of 100 increases signal 
amplitude by 100 times.

Geodesic Sensor Net    Electrical 
Geodesics’ dense sensor array.

H

Hertz   Cycles per second. Something 
that occurs with a frequency of 10 Hertz 
happens 10 times each second. 
Abbreviated Hz.

highpass filter   A tuned circuit designed 
to pass all frequencies above a 
designated cut-off frequency. 
Frequencies below the cut-off frequency 
are rejected or attenuated.

histogram   A bar graph of a frequency 
distribution in which the widths of the 
bars are proportional to the classes into 
which the variable has been divided and 
the heights of the bars are proportional 
to the class frequencies. 

HydroCel Geodesic Sensor Net®   EGI’s 
third-generation of Geodesic Sensor Net, 
featuring die-cut geodesic structure, 
carbon-fiber electrodes with HydroCel 
CleanLeads® technology to minimize 
noise, low-profile design, and HydroCel 
Hydrating Skin Interface Chamber®. 
Commonly called the HCGSN. See the 
Geodesic Sensor Net Technical Manual 
for more information. 

I

iconize   In graphical user interface 
terms, a way to maximize screen space 
by reversibly causing a window to 
shrink down to a token that is much 
smaller than the window.

IIR filter   infinite impulse response 
filter. A class of digital filters that may 
have both zeros and poles on the z-
plane. As such, IIR filters are not 
guaranteed to be stable and almost 
always have nonlinear phase responses. 
For a given filter order (number of IIR 
feedback taps), IIR filters have a much 
steeper transition region rolloff than FIR 
filters.

impedance   The alternating current 
equivalent of resistance, impedance is 
the measurement of the resistance to the 
flow of electricity for a particular 
substance. Electrode/scalp impedances 
affect waveform susceptibility to 
environmental noise.

IMR   See isolation mode rejection.

interface cable   The cable connecting 
the Geodesic Sensor Net to the 
Net Amps. The interface cable 
connectors are Hypertronics connectors. 
This cable is also known as the Geodesic 
Sensor Net Interface Cable.

isolated common   See common.

isolation mode rejection   A measure of 
the attenuation of ambient electrical 
noise common to all electrodes and 
common in relation to mains supply 
ground.
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J

jack   Socket or connector into which a 
plug may be inserted.

L

lowpass filter   A tuned circuit designed 
to pass all frequencies below a 
designated cut-off frequency. 

M

magnitude response   The amount a filter 
attenuates the amplitude of each 
frequency component.

metadata   Data about data. Examples 
include the name of the subject of an 
EEG data-acquisition session, the date of 
the session, the number of epochs. See 
metadata field for how Net Station keeps 
track of the metadata associated with an 
EEG Session file.

metadata field   The metadata connected 
with a Net Station file, also called the 
Session information, are stored in 
components called fields. A field has a 
label that identifies what kind of data it 
holds.

montage   One of several methods of 
combining, selecting, or arranging data 
from multiple sensor locations, or the 
result of defining one of such methods. 
On a given montage, a combined 
waveform is a derivative of the 
waveforms at the sensors chosen to be 
combined. A selection of sensors results 
in the display of a subset of all the 

sensors originally used to make a 
recording.

MRI   Magnetic Resonance Imaging uses 
computer imaging of atomic response to 
radio waves in a magnetic field to 
generate imagery of tissue.

N

Net Amps 200 and 300   Electrical 
Geodesics’ dense-array amplifiers.

Net Station   Electrical Geodesics’ data-
acquisition software. 

Net Station device   A software module 
used in a Workbench configuration that 
can be saved as an Acquisition Setup 
file. Each device can perform a task or a 
closely related set of tasks. Acquisition 
Setups are built from devices assembled 
and connected together on the 
Workbench.

Neurotravel amplifier   EGI’s 32-channel 
clinical amplifier.

noise   Unwanted electromagnetic 
radiation within an electrical or 
mechanical system.

notch filter   A filter which blocks a 
narrow band of frequencies and passes 
all frequencies above and below the 
band.

Nyquist frequency   The maximum 
frequency able to be characterized for a 
given sampling rate. The Nyquist 
frequency is typically taken to be 2/5 of 
the sampling rate, for engineering 
purposes. See also antialiasing.
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O

offset   With reference to waveforms, 
offset is a DC deviation or the amount of 
DC deviation from zero.

P

packetization   The process of bundling 
information into data structures that can 
be sent from one hardware device to 
another.

passband   For a filter, refers to the range 
of frequencies the filter will not 
attenuate.

passband gain   For a filter, refers to the 
amount of a signal that is retained in the 
passband. For example, a passband gain 
of 0.1 dB would result in approximately 
98.86% of the signal being retained. A 
passband gain of 1 dB would result in 
approximately 89.13% of the signal 
being retained.

pixel   A single picture element. A pixel 
is a point in 2D with a single color value. 
The number of pixels visible on a 
monitor is controlled by the monitor’s 
resolution setting.

plug   Movable connector that is 
normally connected into a socket or jack.

port   A site for passing data in and out 
of a computer.

R

Recording Time   One of four time 
modes used by Net Station. Time 
relative to the beginning of a Net Station 
Session. See Absolute Time, Epoch Time, 
and Relative Time.

reference  An electrical point that is 
treated as zero for purposes of 
amplifying electrical signals. The 
Geodesic Sensor Net has a reference 
electrode located at the vertex.

refresh rate   The frequency, expressed in 
Hertz, with which each pixel on a 
particular monitor is updated with new 
information.

Relative Time   One of the four 
Net Station time modes. Relative Time is 
the amount of time since the Workbench 
was turned on. With a session, the time 
since the session began. See Absolute 
Time, Epoch Time, and Recording Time.

rolloff   A term used to describe the 
steepness, or slope, of the filter response 
in the transition region from the 
passband to the stopband.

S

sample   When a continuous signal is 
measured by examining it at discrete 
moments in time, each measurement 
corresponds to a sample.

sampling rate   The number of times per 
second that data are temporally 
sampled.
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scaling factor   To convert an A/D unit 
into its corresponding µV value, a 
channel-specific scaling factor is applied 
in the following manner: sample value 
in µV = (A/D Unit – channel zero) x 
(cal signal amplitude) / channel gain.

segment   A discrete portion of EEG, 
especially as a product of segmentation.

sensor   A device that picks up a signal 
being generated by something in the real 
world.

sensor layout   Descriptive information 
for a particular quantity and 
arrangement of sensors. Includes 2D 
and/or 3D coordinates specifying the 
locations of sensors, labels (names) of 
sensors, and connectivity. Such 
information is stored in a sensor layout 
file.

session   In Net Station, an EEG 
recording requiring the use of a Session 
Template.

session information   See metadata.

signal    A detectable, measurable 
quantity that can be expected to display 
periodicity or other forms of variation in 
time.

spatial sampling   The process of 
sampling a 3D space at regular locations 
in a given instant of time. Compare with 
temporal sampling.

stopband   Refers to the frequency range 
in which a signal is to be attenuated.

stopband gain   For a filter, refers to the 
amount of the signal that is attenuated 

in the stopband. For example, a 
stopband gain of 40 dB would result in 
99% of the signal being attenuated. A 
stopband gain of 20 dB would result in 
90% of the signal being attenuated.

T

temporal sampling   The process of 
sampling a given location at regular 
intervals in time. Compare with spatial 
sampling.

time base   The fundamental unit of 
Net Station time; everything occurs in 
multiples of this unit. Net Station uses a 
millisecond time base.

toggle   Each time a button is clicked, it 
changes the state of what it is controlling 
to one of two possible states and is said 
to toggle between the states.

track   A container used to hold and 
separate data types (for example, EEG 
and events).

transition band   Refers to the frequency 
range in which a filter is transitioning 
from retaining the signal to attenuating 
it. Typically measured in Hertz. For 
example, we might refer to a transition 
band from 10–11 Hz.

U

USB   Universal Serial Bus.
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V

vertex   The point on an EEG subject’s 
scalp that is closest to the top of the 
head. In the International 10-20 system, 
Cz is the vertex electrode. In the Adult 
128 GSN, electrode #129 is the vertex. 
The point on the scalp or skull located 
midway between the nasion and inion 
and centered between the preauricular 
points. Also the name of the Geodesic 
Sensor Net sensor that corresponds to 
this location and that contains the 
reference electrode.

volt/voltage   A measure of electrical 
force, or the tendency for electrons to 
move from one location to another. 
Voltages are measured with respect to a 
reference. 

W

waveform   Any graphical 
representation of a signal.

WFR   Waveform Recorder device.

Workbench   The Net Station equivalent 
of an electronics laboratory. On the 
Workbench, modular device are 
connected by data cables into 
Workbench configurations of differing 
functionality. See Acquisition Setup file.

Workbench Time   Synonym for Relative 
Time when using the Workbench.
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